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Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com/contact/.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products
covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor
devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the
level at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal
elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal
produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the
input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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Preface

The ROE521500MCUO00 is a full-spec emulator for MCUs of the R8C Family R8C/5x Series. This user's manual mainly
describes specifications of the ROE521500MCUO00 and how to setup it.

All components of the ROE521500MCUOQ0 are listed under ““1.1 Package Components” (page 17). If you have any questions
about the ROE521500MCUO00, contact your local distributor.

The manuals relevant to usage of the ROE521500MCUQO0 are listed below. You can download the latest manuals from the
Renesas Tools homepage (https://www.renesas.com/tools).

Related manuals

Item Manual
Accessory ROE53054ECFK60 User’s Manual
ROE53036ACFKA40 User’s Manual
Integrated development environment | High-performance Embedded Workshop User’s Manual

C compiler C/C++ Compiler Package for M16C Series, R8C Family
C Compiler User's Manual
Assembler C/C++ Compiler Package for M16C Series, R8C Family

Assembler User's Manual

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 4 of 231
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Important

Before using this product, be sure to read this user’s manual carefully.
Keep this user’s manual, and refer to it when you have questions about this product.

Emulator:

"Emulator" in this document collectively refers to the following products manufactured by Renesas Electronics Corporation.
(1) E100 emulator main unit
(2) MCU unit
(3) Pitch converter board for connecting the user system

"Emulator" herein encompasses neither the customer’s user system nor the host machine.

Purpose of use of the emulator:

This emulator is a device to support the development of systems that use the RBC Family R8C/5x Series of Renesas 16-bit
single-chip MCUs. It provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this emulator other than for its
intended purpose of use.

For those who use this emulator:
This emulator can only be used by those who have carefully read the user’s manual and know how to use it.
Use of this emulator requires basic knowledge of electric circuits, logical circuits, and MCUSs.

1.
When using the emulator:

This emulator is a development-support unit for use in your program development and evaluation stages. When a program you
have finished developing is to be incorporated in a mass-produced product, the judgment as to whether it can be put to
practical use is entirely your own responsibility, and should be based on evaluation of the device on which it is installed
and other experiments.

In no event shall Renesas Electronics Corporation be liable for any consequence arising from the use of this emulator.

Renesas Electronics Corporation strives to provide workarounds for and correct trouble with products malfunctions, with some
free and some incurring charges. However, this does not necessarily mean that Renesas Electronics Corporation
guarantees the provision of a workaround or correction under any circumstances.

The emulator covered by this document has been developed on the assumption that it will be used for program development
and evaluation in laboratories. Therefore, it does not fall within the scope of applicability of the Electrical Appliance and
Material Safety Law and protection against electromagnetic interference when used in Japan.

Renesas Electronics Corporation cannot predict all possible situations and possible cases of misuse that carry a potential for
danger. Therefore, the warnings in this user's manual and the warning labels attached to the emulator do not necessarily
cover all such possible situations and cases. The customer is responsible for correctly and safely using this emulator.

The emulator covered by this document has not been through the process of checking conformance with UL or other safety
standards and IEC or other industry standards. This fact must be taken into account when the emulator is taken from
Japan to some other country.

Renesas Electronics Corporation will not assume responsibility of direct or indirect damage caused by an accidental failure or
malfunction in this emulator.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 5 of 231
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When disposing of the emulator:
Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

Usage restrictions:
The emulator has been developed as a means of supporting system development by users. Therefore, do not use it as an
embedded device in other equipment. Also, do not use it to develop systems or equipment for use in the following fields.
(1) Transportation and vehicular
(2) Medical (equipment that has an involvement in human life)
(3) Aerospace
(4) Nuclear power control
(5) Undersea repeaters
If you are considering the use of the emulator for one of the above purposes, please be sure to consult your local distributor.

About product changes:
We are constantly making efforts to improve the design and performance of this emulator. Therefore, the specification or
design of this emulator, or this user's manual, may be changed without prior notice.

About rights:

(1) We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of
any information, products or circuits presented in this user’s manual.

(2) The information or data in this user’s manual does not implicitly or otherwise grant a license to patent rights or any other
rights belonging to Renesas or to a third party.

(3) This user’s manual and this emulator are copyrighted, with all rights reserved by Renesas. This user’s manual may not be
copied, duplicated or reproduced, in whole or part, without prior written consent from Renesas.

About diagrams:

Some diagrams in this user’s manual may differ from the objects they represent.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 6 of 231
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Precautions for Safety

This chapter, by showing the relevant diagrammatic symbols and their meanings, describes the precautions which should be
taken in order to use this product safely and properly. Be sure to read and understand this chapter before using this product.
Contact us if you have any questions about the precautions described here.

WARNING indicates a potentially dangerous situation that will cause death or heavy

A WARNING wound unless it is avoided.

A CAUTION indicates a potentially dangerous situation that will cause a slight injury or
CAUTION a medium-degree injury or property damage unless it is avoided.

In addition to the two above, the following are also used as appropriate.

/A means WARNING or CAUTION.

Example: c
CAUTION AGAINST AN ELECTRIC SHOCK

© means PROHIBITION.

Example: ®
DISASSEMBLY PROHIBITED

@ means A FORCIBLE ACTION.

Example: %
UNPLUG THE POWER CABLE FROM THE RECEPTACLE.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 7 of 231
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/\ WARNING
Warnings for AC Power Supply:

If the attached AC power cable does not fit the receptacle, do not alter the AC power cable and
do not plug it forcibly. Failure to comply may cause electric shock and/or fire.

Do not touch the plug of the AC power cable when your hands are wet. This may cause electric
shock.

This emulator is connected signal ground with frame ground. If your developing product is
transform-less (not having isolation transformer of AC power), this may cause electric shock.
Also, this may give an un-repairable damage to this emulator and your developing product.
While developing, connect AC power of the product to commercial power through isolation
transformer in order to avoid these dangers.

If other equipment is connected to the same branch circuit, care should be taken not to overload
the circuit.

If you smell a strange odor, hear an unusual sound, or see smoke coming from this product, then
disconnect power immediately by unplugging the AC power cable from the outlet.

Do not use this as it is because of the danger of electric shock and/or fire. In this case, contact
your local distributor.

9 When installing this equipment, insure that a reliable ground connection is maintained.
<

Before setting up this emulator and connecting it to other devices, turn off power or remove a
power cable to prevent injury or product damage.

Warnings to Be Taken for Handling this Emulator:
Do not disassemble or modify this emulator. Personal injury due to electric shock may occur if
this emulator is disassembled and modified. Disassembling and modifying the emulator will void
your warranty.

Make sure nothing falls into the cooling fan on the top panel, especially liquids, metal objects, or
anything combustible.

Warning for Installation:
m Do not set this product in water or areas of high humidity. Make sure that the product does not
&‘ get wet. Spilling water or some other liquid into the product may cause un-repairable damage.

Warning for Use Environment:
This equipment is to be used in an environment with a maximum ambient temperature of 35°C.
Care should be taken that this temperature is not exceeded.

Caution for AC Adapter:
The DC plug of the AC adapter has the polarity shown below.

@90

Use an AC adapter which complies with the safety standards of the country where it is to be
used.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 8 of 231
Sep.01.21



ROE521500MCUQ0 User’s Manual Important

ACAUTION

Cautions to Be Taken for Turning On the Power:
Turn ON/OFF the power of the emulator and the user system as simultaneously as possible.

When turning on the power again after shutting off the power, wait about 10 seconds.

Cautions to Be Taken for Handling This Product:
Use caution when handling the emulator. Be careful not to apply a mechanical shock.

Do not touch the connector pins of the emulator main unit and the target MCU connector pins
directly. Static electricity may damage the internal circuits.

When attaching and removing the cable, hold the plug of the cable and do not touch the cable.

Do not pull the emulator by the communications interface cable or the flexible cable. And,
excessive flexing or force may break conductors.

Do not flex the flexible cable excessively. The cable may cause a break.

Do not use inch-size screws for this equipment. The screws used in this equipment are all ISO
(meter-size) type screws. When replacing screws, use same type screws as equipped before.

Do not tape the flexible cable or apply adhesives to secure the cable. The shielding material on
the surface of the cable may come off.

Caution to Be Taken for System Malfunctions:

If the emulator malfunctions because of interference like external noise, do the following to

remedy the trouble.

(1) Exit the emulator debugger, and shut OFF the emulator and the user system.

(2) After a lapse of 10 seconds, turn ON the power of the emulator and the user system again,
then launch the emulator debugger.

-~

Note on Transporting the Product:

When sending your product for repair, use the packing box and cushioning material supplied with
the product when it was delivered to you and specify caution in handling (handling as precision
equipment). If packing of your product is not complete, it may be damaged during transportation.
When you pack your product in a bag, make sure to use the conductive plastic bag supplied with
the product (usually a blue bag). If you use a different bag, it may lead to further trouble with your
product due to static electricity.

-~

Caution to Be Taken for Disposal:

Penalties may be applicable for incorrect disposal of this waste, in accordance with your national
legislation.

)

European Union regulatory notices:

The WEEE (Waste Electrical and Electronic Equipment) regulations put responsibilities on
producers for the collection and recycling or disposal of electrical and electronic waste. Return of
WEEE under these regulations is applicable in the European Union only. This equipment
(including all accessories) is not intended for household use. After use the equipment cannot be
disposed of as household waste, and the WEEE must be treated, recycled and disposed of in an
environmentally sound manner.

Renesas Electronics Europe GmbH can take back end of life equipment, register for this service
at “http://www.renesas.eu/weee”.

=
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User Registration

When you install debugger software, a text file for user registration is created on your PC. Fill it in and email it to your local
distributor. If you have replaced an emulator main unit or emulation probe, rewrite an emulator name and serial number in the
text file you filled in earlier to register your new hardware products.

Your registered information is used for only after-sale services, and not for any other purposes. Without user registration, you
will not be able to receive maintenance services such as a notification of field changes or trouble information. So be sure to

carry out the user registration.

For more information about user registration, please contact your local distributor.
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Terminology

Some specific words used in this user's manual are defined below.

MCU unit (ROE521500MCU00)
This means the E100 emulator for the R8C Family R8C/5x Series.

Emulator system

This means an emulator system built around the MCU unit (ROE521500MCUO00). The emulator system is configured with an
emulator main unit (ROEO01000EMUOQ0), MCU unit (ROE521500MCUO00), emulator power supply, USB cable, emulator
debugger and host machine.

Integrated development environment: High-performance Embedded Workshop

This tool provides powerful support for the development of embedded applications for Renesas microcomputers. It has an
emulator debugger function allowing the emulator to be controlled from the host machine via an interface. Furthermore, it
permits a range of operations from editing a project to building and debugging it to be performed within the same application.
In addition, it supports version management.

Emulator debugger
This means a software tool that is started up from the High-performance Embedded Workshop, and controls the MCU unit and
enables debugging.

Firmware
This means a control program stored in the emulator. This analyzes the contents of communications with the emulator
debugger and controls the emulator hardware. To upgrade the firmware, download the program from the emulator debugger.

Host machine
This means a personal computer used to control the emulator.

Target MCU
This means the MCU to be debugged.

User system
This means a user's application system in which the MCU to be debugged is used.

User program
This means the program to be debugged.

Evaluation MCU
This means the MCU mounted on the emulator which is operated in a dedicated mode for use with tools.

#
This symbol indicates that a signal is active-low (e.g. RESET#).
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1. Outline

This chapter describes the package components, the system configuration, and the specifications of the emulator functions and
operating environment.

1.1 Package Components
The ROE521500MCUOQ0 package consists of the following items. After you have unpacked the box, check if your
ROE521500MCUO00 contains all of these items.

Table 1.1 Package components

Item Description Quantity
ROE521500MCU00 MCU board 1
Oscillator module (16MHZz) Mounted on the IC15 socket 1
ROE001000FLX10 Flexible cable 1
ROE521500MCUO00 Release Notes English 1
ROE521500MCUQ00 Release Notes Japanese 1
Repair Request Sheet English 1
Repair Request Sheet Japanese 1
CD-ROM - M16C R8C E100 Emulator Software 1

(M16C R8C E100 Emulator Debugger Included)
- User’s Manual

* Please keep the ROE521500MCUO00's packing box and cushioning materials at hand for later reuse in sending the product
for repairs or for other purposes. Always use the original packing box and cushioning material when transporting the MCU
unit.

* |f you have any questions or are in doubt about any point regarding the packaged product, contact your local distributor.

1.2 Other Tool Products Required for Development
To proceed with the development of a program for R8BC Family R8C/5x Series MCUs, the products listed below are necessary

in addition to those contained in the package and listed above. Procure them separately.

Table 1.2 Other tool products required for development

Product Part No.
Emulator main unit E100 ROEO001000EMUQO
Converter board for a 48-pin 0.5mm pitch LQFP of the R8C/5x Series ROE53054ECFK60
Converter board for a 64-pin 0.5mm pitch LQFP of the R8C/5x Series ROE53036ACFK40
(Converter board for R8C/36A, 36C, 36E, 36F, 36G, 36H, 36M, 36W, 36X, 36Y and 36Z Groups)

* To purchase the product, contact your local distributor.

R20UTO0455EJ0103 Rev.1.03
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1.3 System Configuration

1.3.1 System Configuration
Figure 1.1 shows the configuration of the emulator system.

(4) USB interface cable (1) MCU unit
ROE521500MCU00

(2) Flexible cable

i

(7) Pitch converter board for
connecting to the user system

e 28

e e

/ / H’f.'&l'flll;Y']T’Kf'fl*‘lT;Tl']‘:“'
1 I !

(5) AC adapter power
supply for the emulator

(6) Host machine (3) E100 emulator (8) User system and
main unit user system power supply

Figure 1.1 System configuration

(1) MCU Unit ROE521500MCUOQO (this product)
This is an MCU board for the R8C Family R8C/5x Series MCUs and contains an evaluation MCU.
(2) Flexible cable ROEO01000FLX10 (included)
(3) E100 Emulator main unit ROE001000EMUOQO0
This is the E100 emulator main unit.
(4) USB interface cable
This is an interface cable for the host machine and emulator.
(5) AC adapter supply for the emulator
(6) Host machine
A personal computer to control the emulator.
(7) Pitch converter board for connecting the user system ROE53054ECFK60, etc.
(8) User system and user system power supply
User system is your application system. This emulator can be used without the user system.
The user system power supply is power supply for the user system. This emulator cannot supply power to the user system.
Get a power supply separately.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 18 of 231
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1.3.2 Names and Functions of Each Part of the Emulator
Figure 1.2 shows the names of each part of the emulator.

(5) System status LEDs (4) External trigger connector

' (1) Power switch

(2) USB cable connector

\ : 3 (3) Power connector

(6) Target status LEDs

Figure 1.2 Names of each part of the emulator
(1) Power switch
This is a switch to turn the emulator ON and OFF.

(2) USB cable connector
This is a connector for connecting the USB cable of the emulator.

(3) Power connector
This is a connector for connecting the DC cable of the AC power adapter of the emulator.

(4) External trigger connector
This is a connector to connect the external trigger cable of the emulator.

R20UT0455EJ0103 Rev.1.03 RENESAS Page 19 of 231
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(5) System Status LEDs

The system status LEDs indicate the emulator E100's power supply, operating state of firmware, etc. Table 1.3 lists the
definitions of each system status LED.

Table 1.3 Definitions of the system status LEDs

Name Status Meaning
POWER ON Emulator system power is turned ON.
OFF Emulator system power is turned OFF.
SAFE ON Emulator system is operating normally.
Flashing Emulator system cannot communicate with the host machine.
Flashing The self-checking is in progress.
(every 2 seconds)
OFF Emulator system is not operating normally (system status error).

(6) Target Status LEDs

The target status LEDs indicate operating state of the target MCU and power supply of the user system. Table 1.4 lists the
definition of each target status LED.

Table 1.4 Definitions of the target status LEDs

Name Status Meaning
POWER ON Power is being supplied to the user system.
OFF Power is not being supplied to the user system.
RESET ON Target MCU is being reset, or reset signal of the user system is held low.
OFF Target MCU is not being reset.
RUN ON User program is being executed.
OFF User program has been halted.

Note on the Target Status POWER LED:

If your MCU has two or more Vcc pins, the LED does not light up unless power is supplied to all the
pins.
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1.4 Specifications
1.4.1 Product Specifications

Table 1.5 lists the specifications of the ROE521500MCU00.

Table 1.5 Specifications of the ROE521500MCUQ0

Item

Description

Applicable MCU

R8C Family R8C/5x Series MCUs

Applicable MCU mode

Single-chip mode

Maximum ROM/RAM capacity

1. Internal flash ROM: 4KB+128KB

07000h --07FFFh, 08000h --27FFFh

2. Internal RAM: 20KB

00400h --053FFh

Maximum operating frequency

Power supply voltage: 2.7 to 5.5V, 32MHz

Software break

4096 points (realized by embedding the BRK instruction)

Hardware break

16 points (Execution address, bus detection, interrupt, external trigger signal)

Combination, pass count

- Cumulative AND/OR/ simultaneous AND/status transition
- 255 pass counts

Detection of exceptional events

Violation of access protection/Read from uninitialized memory/
Stack access violation/Performance overflow/Realtime profile overflow/
Trace memory overflow/Task stack access violation/OS dispatch

Real-time tracing

192hits x 4M cycles
(Address, data, status, CPU status, bus status, target status, task ID, timestamp, 32
external trigger inputs)

Trace modes

Fill until stop/fill until full/fill around TP/repeat fill until stop/repeat fill until full

Extraction/deletion of trace data

- Extracting or deleting data by specifying events or extracting the instruction that
accesses the specified data
- Extracting data before and after trace points

Real-time RAM monitor

- 16,384 bytes (512 bytes x 32 blocks)
- Data/last access

Time measurement

- Execution time between program start and stop

- Maximum/minimum/average execution time and number of passes through eight
specified sections

- Clock used to count times: 10ns to 1.6us

Coverage measurement

CO0: 2 Mbytes (256 Kbytes x 8 blocks)
C1: 1 Mbyte (128 Kbytes x 8 blocks)

Profile

1 MB (128 KB x 8 blocks)

Connection to user system

Converter board for a 48-pin 0.5mm pitch LQFP of the R8C/5x | ROE53054ECFK60

Series

Converter board for a 64-pin 0.5mm pitch LQFP of the R8C/5x
Series

(Converter board for R8C/36A, 36C, 36E, 36F, 36G, 36H, 36M,
36W, 36X, 36Y and 36Z Groups)

ROE53036ACFK40

Emulator power supply

Supplied from an AC adapter (power supply voltage: 100 to 240 V, 50/60 Hz)

EMC

EU: EN 55032 Class A, EN 55024
USA: FCC part 15 Class A

R20UTO0455EJ0103 Rev.1.03
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1.4.2 Regulatory Compliance Notices

® European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European Union.)
CE Certifications:
e Electromagnetic Compatibility (EMC) Directive 2014/30/EU
EN 55032 Class A

WARNING: This is a Class A product. This equipment can cause radio frequency noise when used
in the residential area. In such cases, the ser/operator of the equipment may be
required to take appropriate countermeasures under his responsibility.

EN 55024

e Information for traceability
e Authorised representative

Name: Renesas Electronics Corporation

Address: Toyosu Foresia, 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
e Person responsible for placing on the market

Name: Renesas Electronics Europe GmbH

Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
e Trademark and Type name

Trademark: Renesas )

Product name: E100 Emulator MCU Unit

Type name: ROE521500MCUOQ0

Environmental Compliance and Certifications:
-+ Waste Electrical and Electronic Equipment (WEEE) Directive 2012/19/EU

e United States Regulatory notices

This product complies with the following EMC regulation. (This is only valid in the United States.)

FCC Certifications:

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) this device may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.
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1.4.3 Operating Environment

Make sure to use this emulator in the operating environments listed in Tables 1.6 to 1.8.

Table 1.6 Operating environmental conditions

Item Description
Operating temperature 5 to 35°C (no condensation)
Storage temperature -10 to 60°C (no condensation)

2.
Table 1.7 Operating environment of the host machine (Windows® XP)

Item Description
Host machine IBM PC/AT compatible
0S Windows® XP 32-bit editions [*1] [*3]
CPU Pentium 4 running at 1.6 GHz or more recommended
Interface USB 2.0/USB 1.1 [*2]
Memory 1 Gbyte plus 10 times the file size of the load module or larger recommended

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be connected to
the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Table 1.8 Operating environment of the host machine (Windows Vista® or Windows® 7 )

Item Description
Host machine IBM PC/AT compatible
oS Windows Vista® 32-bit editions [*1] [*4]
Windows® 7 32-bit editions / 64-bit editions [*1]
CPU Pentium 4 running at 3 GHz or
Core 2 Duo running at 1 GHz or more recommended
Interface USB 2.0/ USB 1.1 [*2]
Memory 2 Gbytes plus 10 times the file size of the load module or larger recommended (32-bit

editions)
3 Gbytes plus 10 times the file size of the load module or larger recommended (64-bit
editions)

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be connected to
the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Notes:

*1: Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries. All other company or product names are the property of their respective owners.

*2: Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.

*3: The 64-bit editions of Windows® XP are not supported.

*4: The 64-bit editions of Windows Vista® are not supported.

R20UTO0455EJ0103 Rev.1.03
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1.4.4 Specifications of the AC Adapter

The user must prepare an AC adapter and a power cable. Use an AC adapter which complies with the safety standards of the

country where it is to be used. Table 1.9 lists the recommended specifications of the AC adapter.

Table 1.9 Recommended Specifications of the AC Adapter

Item

Description

AC input voltage range

AC 100 to 240 V, 50/60Hz single phase

Output power

36 W

DC output voltage, current

120V,3.0A

DC output polarity

EIAJ TYPE IV, inner-side positive/outer-side negative

R20UTO0455EJ0103 Rev.1.03
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2. Setup

This chapter describes the preparation for using the MCU unit, the procedure for starting up the emulator and how to change
settings.

2.1 Flowchart of Starting Up the Emulator
The procedure for starting up the emulator is shown in Figures 2.1 and 2.2. For details, refer to each section hereafter. If the
emulator does not start up normally, refer to “6. Troubleshooting (Action in Case of an Error)” (page 212).

Check the
1 package Refer to “1.1 Package Components” (page 17).
components.
v
2 | User registration | Refer to “User Registration” (page 15).
v
3 | Install the included software, etc. | Install them from the included CD-ROM.
v
4 Connect the MCU unit to the EL00 main Refer to “2.3 Connecting the MCU Unit to and Disconnecting it
unit. from the E100 Emulator Main Unit” (page 29).
v
. Connect the USB interface connector of the emulator and the USB
5 Connect the host machine. .
port of the host machine.
v
6 | Connect the emulator power supply. | Connect an emulator power supply to the power connector.
v
7 | Turn on the power supply. | Turn ON the power to the emulator.
v
Check that the system status LEDs are lighting. When the user
8 Check the LEDs on the emulator. system is not connyected, the POWER LED dges ngt light up.
v
When using the emulator debugger for the first time, try to use the
9 Try to use the emulator debugger according emulator functions, referring to “3. Tutorial” (page 40).
to the tutorial. If the emulator debugger does not start, follow steps 10 through 13
in this chart to perform a self-checking.
v
10 Create a project in the High-performance Start up the High-performance Embedded Workshop and create a
Embedded Workshop. project by following “4. Preparing to Debug” (page 71).
v
1 Start up the emulator debugger from the Start up the High-performance Embedded Workshop to launch the
High-performance Embedded Workshop. emulator debugger by following “4. Preparing to Debug” (page 71).
v
Make settings on the Device page in the Device Setting dialog box
12 Set up the operating environment of the of the emulator debugger and select the “Start booting up on
emulator debugger. successful completion of self-checking” checkbox by following “4.
Preparing to Debug” (page 71).
\
13 Self-checking |
R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 25 of 231

Sep.01.21



ROE521500MCUO00 User’s Manual 3. Tutorial

Figure 2.1 Flowchart of starting up the emulator (For the first time)
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1 Change the Change the settings of the power supply to MCUs or clock supply,
settings. according to the conditions on use.
v
15 Connect the user system. Connect the user system as occasion demands.
v
Turn ON the power to the emulator and the user system as
16 Turn on the power supply. . .
simultaneously as possible.
v
Check that system status LEDs, and POWER and RESET of the
17 | Check the LEDs on display of the emulator. target status LED are lighting. When the user system is not
connected, the POWER LED does not light up.
v
18 Start up the emulator debugger from the Start up the High-performance Embedded Workshop to launch the
High-performance Embedded Workshop. emulator debugger.
v
. . Check the contents set in the step 12 in Figure 2.1. Do not select the
Set up the operating environment of the “ . . .
19 Start booting up on successful completion of self checking
emulator debugger.
checkbox.
v
20 Debug a program with various functions of Refer to the High-performance Embedded Workshop and “b5.
the emulator debugger Debugging Functions” (page 82).

Figure 2.2 Flowchart of starting up the emulator (After the self-checking)
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2.2 Installing the Included Software
If you have Windows® 7, Windows Vista® or Windows® XP on the host machine, this installation must be executed by a
user with administrator rights. Note that users without administrator rights cannot complete the installation.

Place the CD-ROM in the CD-ROM drive and follow the instructions to install the software.
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2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit
Figure 2.3 shows the procedure for connecting the MCU Unit to the E100 Emulator Main Unit.

Connecting

MCU Unit
ROE521500MCUO0

T N

Insert the MCU unit
following the inside
rails of the main unit.

Push the MCU unit down
to check it is attached properly.

-

E100 emulator main unit
ROE001000EMUOO

O =

Disconnecting

Figure 2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit

Note on Connecting the MCU Unit to the E100 Emulator Main Unit:
Always shut OFF power when connecting the MCU unit to the E100 emulator main unit. Otherwise,
internal circuits may be damaged.
R20UT0455EJ0103 Rev.1.03 :{ENESAS Page 29 of 231

Sep.01.21



ROE521500MCUOQ0 User’s Manual 3. Tutorial

2.4 Connecting the Host Machine
USB interface is used for connecting the emulator to the host machine. The USB cable is connected to the USB cable

connector of the emulator and the USB port of the host machine.

Figure 2.4 Connecting the host machine
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2.5 Connecting the Emulator Power Supply
Power is supplied from an AC adapter to the emulator. The following shows how to connect the AC adapter.

(1) Turn OFF the power of the emulator.

(2) Connect the DC cable of the AC adapter to the emulator.
(3) Connect the AC power cable to the AC adapter.

(4) Connect the AC power cable to the outlet.

Figure 2.5 Connecting the emulator power supply

A CAUTION

Cautions for AC Power Cable:
If the AC power cable does not fit the receptacle, do not alter the AC power cable and do not
A plug it forcibly.
Failure to comply may cause electric shock and/or fire.
Do not touch the plug of the AC power cable when your hands are wet. This may cause
electric shock.

Cautions for AC Adapter:
0 The DC plug of the AC adapter has the polarity shown below.

Use an lies with the safety standards of the country where it is to be used.
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2.6 Turning ON the Power
2.6.1 Checking the Connections of the Emulator System
Before turning the power ON, check the connection of the interface cable with the host machine, emulator, and user system.

2.6.2 Turning the Power ON and OFF

- Turn ON/OFF the power of the emulator and user system as simultaneously as possible.

- When the SAFE LED of the system LEDs is flashing, check that the USB cable is connected to the host machine. When each
of the target status LEDs is flashing, check that the MCU unit is connected.

- When turning ON the power again after shutting OFF the power, wait for about 10 seconds.

Notes on Power Supply:
The emulator pin Vcc is connected to the user system in order to monitor user system voltage. For
this reason, the emulator cannot supply power to the user system. Supply power to the user system
separately.

The voltage of the user system should be as follows.
27V=<Vcc=sh5V

When you start the emulator without the user system, do not attach a converter board. When
starting with a converter board, the MCU will be in a reset status.

When you start the emulator without the user system, take care that metallic pieces are not
touched to the connector at the head of the flexible cable.

Do not leave either the emulator or user system powered on. The internal circuits may be damaged
due to leakage current.
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2.7 Self-checking
Self-checking is to check if the emulator functions operate properly. To run the self-check function of the emulator, follow the
procedure below. While the self-checking is in progress, the states of the LEDs will change as shown in Figure 2.6. In case of

ERROR, because the states of the target status LEDs will change depending on the types of errors, check the system status
LEDs.

(1) If the user system is connected, disconnect the converter board and the user system.
(2) Turn on the emulator.

(3) Launch the emulator debugger, and select the “Start booting up on successful completion of self-checking” check box in
the Device Setting dialog box.

(4) When you click OK, self-checking will start. If the normal result is displayed in about 60 seconds, self-checking has ended.
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Figure 2.6 LED displays during the self-checking
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2.8 Selecting the Clock Supply
2.8.1 Clock Source
You can choose the clock source supplied to the evaluation MCU in the Configuration properties dialog box of the emulator

debugger. Table 2.1 shows the clock sources and their default settings.

Table 2.1 Clock supply to the MCU
Clock selection in the

lock . .
Cloc emulator debugger Description Default setting
Emulator IC15 mounting oscillator module Yes
User Oscillator circuit on the user system -

Main (Xin-Xout ——
( ) Internal generator circuit

Generate (1.0 to 20.0 MHz) -
Emulator Internal oscillator circuit Yes
Sub (XcIN-XcouT) (32.768 kHz)
User Oscillator circuit on the user system -

Note on Changing the Clock Supply:
The clock supply can be set by the Configuration properties dialog box when starting up the
emulator debugger or by an input of the emulator_clock command on the Command Line window.
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2.8.2 Using an Internal Oscillator Circuit Board

Kinds of Oscillator Circuit Boards

An oscillator module (16MHz) is mounted on the 1C15 at factory setting. If you change the frequency, replace the oscillator
module.

(1) Replacing the Oscillator module
Remove the MCU unit from the E100 emulator main unit, and replace the oscillator module of the IC15 (see Figure 2.7).

EPSON TOYOCOM
SG-8002DC/DB Series
(power voltage 2.7 to 3.6V: PC/SC)

:)se-soozoc\

14 11

8
Q00

Q0O
7

-

-}

°Q

la CN1  40a la
i1 L

Ul

--------------------- e

Figure 2.7 Replacing the oscillator module

A CAUTION

Notes on Replacing the Oscillator Module and Oscillator Circuit Board:
0 Always shut OFF power when replacing the oscillator module. Otherwise, internal circuits may be

damaged.

When replacing the oscillator module, remove it with a tool such as an IC extractor so as not to
damage the board. If the board is damaged, the pattern on the board may be cut and the emulator may
not be able to operate.
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2.8.3 Using the Oscillator Circuit on the User System

To operate this product with an external clock, construct the oscillator circuit as shown in Figure 2.8 in the user system and
input the oscillator output at 50% duty (within the operating range of the evaluation MCU) into pin Xour. And pin Xn should
be open. Choose "User" in the emulator debugger to use this clock.

Evaluation MCU

Xout XN

‘ Open
Oscillator

Oscillator output | circuit

Figure 2.8 External oscillator circuit

Make note that in the oscillator circuit shown in Figure 2.9 where an oscillator is connected between pins Xy and Xour,
oscillation does not occur because a converter board and other devices are used between the evaluation MCU and the user
system. It is the same for sub-clock oscillator circuits (Xcin and Xcour).

Evaluation MCU

XIN XouT

1
I

Figure 2.9 Circuit in which oscillation does not occur

2.8.4 Using the Internal Generator Circuit

The dedicated circuit in the E100 can generate any arbitrary frequency specified by the emulator debugger, and it can be
supplied as a main clock. It does not depend on either the oscillator circuit board in the MCU unit or the oscillator circuit on
the user system. If you want to debug programs without the user system or change a frequency temporarily, you can check its
operation before purchasing an oscillator. If you want to use the internal generator circuit in the E100 as a main clock, choose
"Generate" in the emulator debugger and specify a frequency you like to use this clock.

Although you can change a frequency between 1.0 and 99.9 MHz by 0.1 MHz for the E100, do not specify a value exceeding
the maximum input frequency 20 MHz of the Xy of the MCU.

Notes on Using the Internal Generator Circuit:
The internal generator circuit is provided for temporary debugging purposes. Temperature
characteristics of frequencies are not guaranteed.

Be sure to evaluate your system with an oscillator whose frequency is the same as that of the
oscillator module or oscillator circuit (emulator) for final evaluation purposes.
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2.9 Connecting the User System
Figure 2.10 shows how to connect this product to your user system.

Flexible cable

48-pin 64-pin
0.5mm pitch 0.5mm pitch
LQFP LQFP
R8C/54E, 54F, 54G, 54H R8C/56E, 56F, 566G, 56H
Group Group

ROES53054ECFK60

ROE53036ACFK40

Figure 2.10 Connecting this product to the user system

AN CAUTION

Note on Connecting the User System:

Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the
emulator and user system.
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2.9.1 Connecting to a 48-pin 0.5mm Pitch Foot Pattern
The following is a procedure of connecting to a 48-pin 0.5mm pitch foot pattern on the user system using the
ROE53054ECFKG60 (not included). For details on the ROE53054ECFK60 (not included), refer to its user's manual.

(1) Attach the NQPACKO048SD included with the ROE53054ECFK60 to the user system.

(2) Attach the YQPACKO048SD included with the ROE53054ECFK60 to the NQPACKO048SD and secure it with the YQ-
GUIDEs.

(3) Attach the ROE53054ECFK60 to the YQPACKO048SD.

(4) Attach the CN1 side of the converter board to the CN1 side of the flexible cable.

% Evaluation with

ﬂ (4) actual MCU
B ROE53054ECFK60
N e
* U
HQPACK048SD
ﬂ (3) (Qnotincluded)
§ YQ-GUIDE (x4) ﬂ
JoH cons
=ﬁ> - FLASH version
These corners ﬂ (2) NQPACK048SD MCU, etc.
are not round. ~ ‘
L
ﬂ (1) 48-pin 0.5mm pitch
foot pattern

S -a-@‘
®“, &

No. 1 pin

User system
*: These four products are Y

available in one package.

Figure 2.11 Connecting to a 48-pin 0.5mm pitch foot pattern

A CAUTION

Notes on Connecting the User System:
0 Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the

emulator and user system.
The connectors of the ROE53054ECFK60 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACKO048SD, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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2.9.2 Connecting to a 64-pin 0.5mm Pitch Foot Pattern
The following is a procedure of connecting to a 64-pin 0.5mm pitch foot pattern on the user system using the
ROE53036ACFKA40 (not included). For details on the ROE53036 ACFK40 (not included), refer to its user's manual.

(1) Attach the NQPACKO064SD-ND included with the ROE53036 ACFKA40 to the user system.

(2) Attach the YQPACKO064SD included with the ROE53036 ACFK40 to the NQPACKO064SD-ND and secure it with the YQ-
GUIDEs.

(3) Attach the ROE53036 ACFK40 to the YQPACKO064SD.

(4) Attach the CN1 side of the converter board to the CN1 side of the flexible cable.

Evaluation with
— ﬂ (4) actual MCU
ROE53036ACFK40 -
&>

HQPACK064SD
(3) (not included)

YQ-GUIDE (x4
ﬂB YQPACK064SD ﬂ
/ ) ':%

ﬂ(Z) FLASH version
NQPACK064SD-ND JJ

MCU, etc.
\ <

g

* ¥
]

These corners
are not round. —_|

ﬂ (1) 64-pin 0.5mm pitch

foot pattern
P

ot
No. 1 pin
%  These four products are User system

available in one package.

Figure 2.12 Connecting to a 64-pin 0.5mm pitch foot pattern

A CAUTION

Notes on Connecting the User System:
Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the
emulator and user system.

The connectors of the ROE53036ACFK40 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACKQ064SD, contact the following:
Tokyo Eletech Corporation  http://www.tetc.co.jp/e_index.htm
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3. Tutorial

3.1 Introduction

The E100 emulator has a tutorial program available. This program is provided as a means for presenting to you the main
features of the emulator, as will be explained in this document.

This tutorial program is written in C language, and is created to sort 10 pieces of random data in ascending/descending orders.
The following outlines the processing performed by the tutorial program.

The main function calls the tutorial function repeatedly in order to execute a sort process repeatedly.

The tutorial function generates the random data to be sorted and calls the sort and the change functions in that order.

The sort function inputs an array that contains the random data generated by the tutorial function and sorts the input data in
ascending order.

The change function inputs an array that was sorted in ascending order by the sort function and sorts the input data in
descending order.

The tutorial program is a program designed to help user to understand how to use the functions of the emulator and the
emulator debugger. When developing user systems and user programs, refer to the user’s manuals of the target MCUs.

CAUTION
If the tutorial program is recompiled, the addresses in a recompiled program may not be the same as those described in this
chapter.
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Look in: Ia Tutarial j & £ 5~

l Tukorial
3.2 Starting the

Open a workspace fo e

For the directory, spe
OS installed drive\W:

File name: ITutu:uriaI.hws Select |
Files of type: | HEW Workspaces (% hws] | Cancel |

Figure 3.1 Open Workspace dialog box

For the file, specify tl

4

3.3 Connecting the Emulator

When the debugger is connected to the emulator, a dialog box for setting up the debugger is displayed. In this dialog box,
make initial settings of the debugger.

When you have finished setting up the debugger, you are ready to debug.
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3.4 Downloading the Tutorial Program

3.4.1 Downloading the Tutorial Program
Download the object program you want to debug. Note, however, that the program to be downloaded and the address to which
it is downloaded differ with each microcomputer used. Read the strings, etc. on the screen as suitable for the microcomputer

you are using.
Choose Download from Tutorial.x30 of Download modules.

x|
EI@ Tutarial
Ell@ Tutorial
-3 C source file
----- ] fvectorc
----- ] heap.c
----- &) initsct.c
----- %] intprg.c
----- E resetprg.c
----- %] sartc
----- ] Tutorial.c
=123 Download modules
[
B3 Dependencies Dowwnload
----- cztartdef. b Download (Debug Daka Cnly)
: initsct. b irload
resetprg.h —
sfrB2a.h Downlaad & Mew Madule, .
_ sorth Remove
- typedefine. b
Cebug Settings. ..
Configure Yiew. .
IT Al Docking
Hide
Properties. ..
e

Figure 3.2 Download display of the tutorial program
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- sort.h 27
e typedefine. h 28 |FBZEQ9 p_sam= mallocisizeaf (struct Sar
Z9 |FBZFD inicip =em):

30
ROE521500MCUOC 31 |F309 for( i=0:; i<i0; i++ )4
32 |FB314 i = randi);
33 |FB320 if(3 < O)¢
34 |FB3E5 1= -3:
35 i
3.4.2 Displaying the 36 |FE32E alil = 3:
37 E
38 |FB8344 sortia) !

In the High-performa
Double-click Tutoria 1|

) @Pmi...l@Te... I'@:INav... I [ Test I z Tutarial.c |

Figure 3.3 Editor window (displaying the source program)

If necessary, you can change the font and font size to make the text easier to read. For details on how to change, refer to the
High-performance Embedded Workshop User’s Manual.
The Editor window initially shows the beginning of a program. Using the scroll bar, you can look at another part of a program.
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4z
43
ROE521500MCUOC| %4
45
16
47
15
3.5 Setting Softv| 42

Software breakpoints ?i

The Editor window [ 52
where the sort functic 53
54

35
56

Double-click a row ir

1

Fa3ez
F837e
F838cC
F834z
F83ES
F83CE
F83E4
F83Fa
Fg410
Fg4Ze
Fg43z
F34385

F3434

p_sam-—~sU=alll -
p_sam-r=1=al[l]:
p_sam-rzz=alZ]:
p_sam-r=3=al[3]:
p_sam-rz4=al[4]
p_sam-r=5=a[5] :
p_sam-r=6=a[6] ;
p_sam-r=7=al[7]:
p_sam-r=8=a[8]:
p_sam-r=8=a[9]
free(p_sSam) ;
p_Sam = NULL:

h

wold abort (wvoid)

!

Tutorial

Figure 3.4 Editor window (setting a software breakpoint)

at a place

The source line that includes the sort function will be marked with a red circle, indicating that a software breakpoint has been

set there.
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=
30
31 |Fs309
ROE521500MCUOC| 32 |FB314
33 |Fs3z0
34 |Fg3z25
35
. 36 |FS3ZE
3.6 Executing th| 5+
The following descrit 38 |Fe344
39 |FS34E
40
3.6.1 Resetting the 41 |FE352
4z |FS362
43 |FS5376
44 |FS38C
45 |FS342
3.6.2 Executing the| 48 |FE3ES
47 |FS3CE

45 |FS3E4
To execute the progr: 49 |FE5FL

The program will be 50 |FE410

column to indicate th | 21 |[FE428
sz |Faasz

To reset the CPU, cht

1

init |p S&m) -

i=0; i<10;
J = randi):
if{3 < 014
i = -3:

for|

B

ali]l = 3:
B
Iorti(al:
change (a) :

p_sam-r=0=a[0] :
p_sam-r=1=al[l]:
p_sam-rzz=alZ]:
p_sam-r=3=al[3]:
p_sam-rz4=al[4]
p_sam-r=5=a[5] :
b _=sam->s6=al[6] ;
b_sam-=s7=al7];
b_=sam->s8=a[8] ;
b_sam->s9=a[2] ;
free(p_sSam) ;

P _Sam = NULL:

i++ ) 4§

Tutorial

Figure 3.5 Editor window (program at a break)

eakpoints
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The Status window p
Choose CPU —> Statt
open the Target sheet

Wiolation of access protection
Read from uninitialized wemory
Stack access wviolation
Ferformance overflow

Realtime profile overflow
Trace memory overflow

Task =tack acces= violation

08 dispatch

Fun time count

Cauze of last hreak

00:00:00.001.3%9&. 700
Foftware hrealk

3. Tutorial

_4_I_.Illll. Mermery }". Platfarm ;‘i, Ewvants }I‘T-Ilgll l.l'l

Figure 3.6 Status window

CAUTION

tus window is displayed,

The contents displayed in this window differ with each product. For details about the displayed contents of each product, refer
to Chapter 5, “Debugging Functions,” or online help.

3.7 Checking Breakpoints

Use the Breakpoints dialog box to check all software breakpoints set.

3.7.1 Checking Breakpoints

Press the keys Ctrl + B on the keyboard of your PC. The Breakpoints dialog box shown below will be displayed.

Breakpoints

X,

il

k.
Cance
Edit Cade

Remove

LR

R emowve Al

Figure 3.7 Breakpoints dialog box

Use this dialog box to remove a breakpoint or enable or disable a breakpoint.
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|21 0000 Hex
FE o717 Hex
ROE521500McuUoC | F¢  F834%  Hex
INTE FFDOO Hex
se O&ES Hex
I3F OAlF Hex
. 3B 0400 Hex
3.8 Altering Reg
Choose CPU —> Regist
displayed. 1en|u| 10| 8] 5| z|p|c| |
0 10000101

Figure 3.8 Register window

The content of any register can be altered.

risters toolbar button . The Register window shown below will be

Double-click the line for the register you want to alter. The dialog box shown below will be displayed, so enter a new value

with which you want to alter the register.

PC - Set value

21

Fadix : IHE:-:

Set Az IWhDIe Reqister

x|

Cancel

Figure 3.9 Set Value dialog box (PC)
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000416  mmext -~
Qoo41a _ msize
ROES21500McuUoc| ~ DOC041E —g_CharBuf 3. Tutorial
oao7?1ir _ stack top
oogalr __istack top
oooazZo _heap area
. OF30l4 _ durmy int
3.9 Referencing OFg801a __brk
The Label window pe OF&020 __int3 d in a module.
OF2026 __timer b5
Choose Symbols — Ors0Zc _ timer b4 ar button . The Label window shown below will
OF8032 __timer b3
be displayed. Use thi: OF2038 int5s + || in amodule.
N — _*I_I
Figure 3.10 Label window
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3.10 Checking Memory Contents

Specifying a label name, you can check in the Memory window the content of memory where the label is registered. For
example, you can check the content of memory corresponding to _main in byte units, as shown below.
Choose CPU —> Memory from the View menu or click the Memory toolbar button [s#] to display the Display Address dialog

box.

Enter “ main” in the

Memory [_main]

Display Address IT I e ’1__5 =08 £ | abe 48 45 db du | £ .4 16 32 | &)
Address 40 +1 42 +3 +4 +5 +6 +7 43 49 +& +B + +I +E +F | BESCTT
. FEZDC p0 10 €4 06 F5 05 00 FE F8 F3 7¢ F2 32 70 EZ OO e .3
Display Address: FRZEC 00 70 E2Z 28 00 FD 94 84 OF 7D E4 73 OB FA 73 ZB  .}.f..... .=
Serall Start Address: FAZFC Fz 75 48 FC 75 4B FA FD 2 80 OF 70 E4 D9 (0OB FE uk.uk..... i
FEIOC 77 BE FE 0D& OO0 70 ¢& 31 FD 44 89 OF 7¢ F3 73 2B w 1.1.D. . |
Scroll End Address: | FB31c FB8 73 OB F& 7E BE CF BA 0OA 75 7B FB 75 5B F6 77 .s..~..j.uf.v
FRAZC EE F9 73 BO FE EJ 10 EE 4FE ¢E A1 D4 73 EE FE 73 Seu... K...z
0k Fa33c ES8 F3 0z c9 1E FE FE <9 EE 1E CE FD EBO B81 0OF EE vuveevvrennns
|: FE2AC 1E CE FD 80 82 OF 72 B4 Fa 73 B5 FC 75 2B CE CO  ...... S..3..1
- - FA3SC 24 77 ES5 75 2B DO 73 B4 FA 73 EBS FC ©9 44 77 ES5 Sw.ut.s..s
Figure 3.11  Disple| ppq e 75 2B DZ €9 24 77 E5 75 2B D4 73 B4 FA 73 BS FC  ut..gw.ut.s
FEATC 77 44 08 00 77 E5 75 ZE DE 0 24 77 ES5 75 2B DB wD..w.ut..dw
FRAEC 73 B4 FA 73 BE5 FC 77 44 0c¢ 00 77 ES 75 3B DA €0 s..5..wD. .01
Click the OK button. | pz3a: 324 77 E5 75 2B DC 73 B4 FA 73 ES FC 77 44 10 00 S$w.ut.s..sS..0
FAIAC 77 E5 75 2B DE €9 24 77 E5 75 2ZE EO 73 B4 FA 73 w.ut..Sm.ut.:
Figure 3.12 Memory window
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watch H

3.11 Referencin & B (xR / #y x |8 | @ & 5

When single-steppin L [as you step

through source lines e long-type

array ‘a’ that is decla

Click the left-hand si Watch with

the right mouse butto

Figure 3.13 Instant W

Click the Add button

[T warcha & weachz J weatchs J wistcha J

Figure 3.14 Watch window (array display)

Add Wakch il EI

Or you can specify a
and choose Add Watt

Warable or expreszion: k.

Ii Cancel

w will be displayed.

Figure 3.15 Add Watch dialog box

. Click the right mouse button in the Watch window
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M
A

FAAaa23ddXDAA0 AL

ROE521500MCUOC

Enter a variable ‘i’ in th
An int-type variable

Figure 3.16 Watch w

Clicking the “+” mar,

Ox000EeS
Ox0006e5
Dx0006=9
Dx0006=d
Dx0006f1
0=0006£5
O=0006£0
O=0006fd
0=000701
0=0007035
Q=000709
0=000715

R e T T e e e . ——
L e e e R e S . —

[=igned
[=igned
[=zigned
[=igned
[=igned
[=signed
[zigned
[=igned
[=2igned
[=igned
(zigned

long[10])
long)

[Current Scope]

Llong)
Long)
Long)
Long)
Long)
Long)
Long)
Long)
Lonig)
int) [Current Scope]

(AT weateha fwnakcha | wiakcha ) widatcha [

Figure 3.17 Watch window (showing array elements)
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| ¥l B8 e

Namne

Walue Type

3.12 Showing L«

Using the Locals wi
variables of the tutori
Choose Symbols —> Lo
The Locals window s
If no variables exist i

{ Ox0006e5 }
H'OO0OO0ffe { O=x000704 1}

[signed long[10])
[=igned long)

H'OODa { Ox000715 } [signed int)
O0x000=aZ28 { Ox000711 @

[struct Sarmple*)

3. Tutorial

Figure 3.18 Locals window

ck the local

er (PC).

Click the “+” mark shown to the left of the array ‘a’ in the Locals window to display the elements comprising the array ‘a’.
Look at the elements of the array ‘a’ before and after the sort function is executed to confirm that random data is sorted in

descending order.

3.13 Single-Stepping a Program
The High-performance Embedded Workshop provides various step commands that will prove useful in debugging a program.

Table 3.1 Step Options

Item No. |[Command Description
1 Step In Executes a program one statement at a time (including statements in a function).
2 Step Over Executes a program one statement at a time by ‘stepping over’ a function call if any.
3 Step Out After exiting a function, stops at the next statement of a program that called the function.
4 Step... Single-step a program a specified number of times at a specified speed.
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33
34 |FB1C2
35 |FB1CF
36 |FS1DF
ROE521500MCUOC| 37 |FB1EE
38 |FB1F3
39 |F8214
40 |FB223
41 |FB23C
42
3.13.1 Executing S| a3

44
The Step In command| 4g

To enter the sort func i:

45 |FezZol

49 |Fg8ZeD

50 |FBz270

51 |FBz27D
4]

Figure 3.19 Step In b

while | gap > O |{
for (| k=0:; k<gap; k++){

+

+

gap

for | i=k+gap:; i<10; i=i+gap |1
for (j=i-gap: J>=k: J=j-gap)i
g_IntBuf = j:

3. Tutorial

ifi{alil=ali+tgap] ) {
t = al3j]l:
al3] = alj+gapl:
ali+gap] = t;

i

else

hreak;
3 on.

' Jlbar.

= gap/Z;

g_CharBuf = (char)g IntBuf & Ox00FF;

< Tutonalc

Figure 3.20 Editor window (Step In)

The highlighting in the Editor window moves to the first statement of the sort function.
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3.13.2 Executing th

The Step Out comma
the function was calle
To exit the sort functi

Figure 3.21 Step Out

FE2ES
FE2FD

F3308
F33l4
Fa&3z0
Faizs

FE3:iE

FEi4a
FE34B

FE352
FE36z
FE376
Falac
FE3IAZ
FE3Ed
FE3CE
FEIE2
FEIFA
Fg410
FG426
Faeiz
Faz3g

s

p_=am= mallocsizeof (struct Sample)|:

initl:p_suml x

Lor[ 1=0r 1<10; i+ ] {

3 = pand()
if{y <« 0Op{
b e |
1
ali] = 3@
H
sorklal);
change |a] ;

EI_S-EM—}SU=B.[|:|] H
p_sam-rai=all];
P =am-r=i=al[Z];
p:su.m—b-sﬂ--u.[‘_'-l] I
P_anm=r3d=alq]
EI_S-EM—}35=B.[5] H
P Eam->=d=al 6] ;
szum—}s'?-n['?] i
p_sam-rsB=a[8]
P_gnb=>3@=a[9] !
Lree(p Sam] k
p_sam = NULL;

watch
RR OB X e

[1]
[2]
[3]
[4]
[5]
[&]
[l
[8]
[91

a
"

[ Ox0006eS
[ Ox000Ee9
[ Ox0006ed
[ Ox0006f1
[ O=O006BES
{ Ox000EED
{ Ox0006fd
{ Ox000701
{ Ox000705
[ O=O00709
{ Ox000715

et el el I, -~

d long[10]]

Lomg)
Lomig)
Lomg)
Lomg)
Lorg)
Lomg)
Lomg)
Long)
Lomg)
Lorg)
intl

[Cure

[Curcent

[ TR ettt fiakch | bbb | iaicket |

Figure 3.22 Editor window (Step Out)

The data of the variable ‘a’ displayed in the Watch window will be sorted in ascending order.
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£ int 17
Z6 atruct Sawple far *p_sam:
27
2B FG8ZES p_=am= mallos [sizenf(steuct Sample))
20 |FEZFD init(p_=am) ;
ROE521500MCUOC| =0
31 Fg308 for[ 1=0r 1i<10: d44 |1
32 F&3ila 3 = pandil)
33 FE320 i£(3 < O){ parch
3z F2I25 = =3I
s y, 277 RR O X B
36 FE3ZE alil = 3:
3.13.3 Executing th 3; - . ' " [0 } d long[1011  [Cure
sork(a);
’ R [ Ox0006e5 }  (z2igned Long)
The Step Over comn f’]z RAXEE Lot O R [ Ox0006ed } {signed long)
program. 41 [Fg3s2 =4 p_sam->a20=a[0] ; R [ Ox000Eed }  (2igned Llomg)
To excaute allsaten| 5 hese = " Py
0 execute all staten p_sam-w=i=al2];
) 29 |reamc p_sem->s3=a[3] : : [ Ox0006E5 }  (sigrned long)
button in the toolbar. | a5 Fszaz p_som-rad=a[d] { OxDODGED } (signed long)
45 FS3E8 p_saw->25=a[5] R { OxD006Ed }  (signed long)
i; ig:gz !J_Sﬂﬂ'*S::aEg}a' R { 0x000701 } (sighed Llomg)
F_SHEI—‘?S =-a Fi
. a5 |reara p_sam->s8-a[8] ; : { 0=000703 }  (z2igned Long)
Flgure 3.23 Step Ove| =0 Fedlo p_sem—>a3d=a[F] { 0x000708 1 {signed long)
51 F8426 Iree(p_saw] R i { 0=0007153 }  (z2igned int) [Current =
5z FB432 p_=am = NULL;
T Bernc " = A TR weatcht fnbchs | Wiakch | Wikt [
| |

Figure 3.24 Editor window (Step Over)

The data of the variable ‘a’ displayed in the Watch window will be sorted in descending order.
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3.14 Forcibly Breaking a Program

The High-performance Embedded Workshop permits you to forcibly break a program.
Clear all breakpoints.
To execute the rest of the tutorial function, choose Go from the Debug menu or click the Go button in the toolbar.

Ell
Figure 3.25 Go button

Since the program is executing an infinite loop process, choose Stop Program from the Debug menu or click the Stop button in

the toolbar.

Figure 3.26 Stop button
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3.15 Hardware Break Facility

Hardware breaks cause the program to stop when it executes a specified address (instruction fetch) or reads or writes to a
specified memory location (data access).

3.15.1 Stopping a Program when It Executes a Specified Address

The Editor window permits you to set an instruction fetch event easily. For example, you can set an instruction fetch event at a
place where the sort function is called.

Double-click a row in the Event column corresponding to the source line that includes a sort function call.

-0l x]
Bl
Line Sour.. | E.| C.| 5. Souce |
Zza |FBZE9 p_Zam= malloc(sizecf (struct Sample)]: j
29 |FEZFD initip_sam):
30
31 [FE309 for( i=0; i<10; i+4+ )4
32 |FE314 i = rand():
33 [FE320 if()] < O{
34 [FE325 i = -3:
35 h
36 |FE3ZE ali]l] = j:
37 h
38 |Fg344|HY sartial !
39 |FE34E change (a) !
40
41 |Fa3kz b _sam->=0=a[0] ;
42 |F@saz b_sam->=1=al[l]:
43 |F8376 b_sam->si=alz]:
44 |F338C b_sam->=3=al[3]: -
4| | AW

Figure 3.27 Editor window (setting a hardware breakpoint)

The source line that includes the sort function will be marked with H?, indicating that a hardware breakpoint that will cause a
program to stop when it fetches an instruction has been set there.
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3.16 Stopping a Program when It Accesses Memory
To stop a program when it reads or writes a value to a global variable, set up a hardware break as described below.

Choose Event -> Hardware Break from the View menu to display the Hardware Break dialog box.

Open the OR page of the Hardware Break dialog box. In the Editor window, select a global variable that you want to be the
object of a hardware break so that a program is made to stop when it reads or writes a value to the variable, and drag-and-drop
the selected variable into the OR page.

Then click the Apply button.

When you run a program, it will stop running when a value is read or written to the global variable you have set.

i Hardware Break * ;IE'EI

Hardware Break <R |

—Event:

Ewent | T.I Descriptions | L a P | Ta... | Carment |
[+1i=2ME [Address] g IntEu... - -

add. .. | [elete | Enable | Disal:ulel
Event used 1 Free 15 Detail...l Registered events...l
Save... | Load... | Help | apply I Close I

y

Figure 3.28 Hardware Break dialog box

Notes: (1) Only the global variables that are 1 byte or 2 bytes in size can be set.
(2) Local variables outside scope cannot be registered. Moreover, when the local variable is set, the break not

intended outside scope might be generated.
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nmVE varz ki Fdr Raaa
ROE521500MCUOC|Rm:, Fila: Cycle: |Adoress: [Tme: |

Cycle Lab=l | Addcess Datd BUS BHE BEIO BAW RWE CFU QN BUSACE Debug EV | BEL¢ ELEOVLAR TimeStamp [(him:s.m

3.17 Trace Facil

The trace facility of 1
up to 4M bus cycles
Trace window.

Choose Code —> Tra(
The Trace window st

Figure 3.29 Trace window

The following describes the trace facility and its setting.
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3.17.1 Showing the
The free trace facility

(1) Clear all break cc
pop-up menu tha
selected trace mo

Ewvertinuse: o  Deta | |

- Excephion:

Exceptional Dietai |
evenks

Tokal : 0 Ewvent
"Delay{cycle}:

IEIM TI

—Record condikion:
@ al  Capture ¢ Do nok capkure

[ Skep execution is recorded

Eventinuse: 0

=N

Eventused 0 Free 16 Detail...l

Registered events. .. I

Help | Gpply | Close

,

3. Tutorial

Il when it breaks.

Acquisition from the
heck to see that the

Figure 3.30 Trace conditions dialog box (free trace)

(2) Set a software break in a line of the tutorial function where p_sam ->s0=a[0]; is written.
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L IR ] UFFFEe —--02 161 DB R O = £ 1 1 dooogodoooooaon. == = ozod:zon. udl. sal,
-00000014 OFFFEE —-0Z 1k 1 - - 1 - & 1 1 0000000000000000 -- - 00:00:00,001, 650, 8
-00000013 OFFFES —-0Z 161 - - 1 - & 1 1 Qo0oQ0o000o000000 -- - 00:00:00.00L, 650, 8
Trace U I
ROES2IS0MCVN [wvp saxz (i Fd ) & aaa
[Rars: -00007515, 00000000 [Fis: Cycke: -00000060 [Addrass: OFEZCC Time: 00:00:00.008,648.510 |
| Cyole Lab=l | Address Dats BUS BHE BIO B/W EWT CFU QN BUSACC Debug EV | BL¢ ELEOVLAP TimeSkamp [(himis.n
OFEZCC ADD.W:E  -ZH[FB],Al
~000000ED OFEICE —-FE 16k 1 - - 1 oM & 1 1 0000000000000000 - 00:00:00, 001, 648, &
(3) Choose Reset Go | -£eanonss OFE2ZD0 FIET 16k 0 TW R O RBE 3 1 1 000aNa00a0000a00 - 00:00:00.001. 648, 5
~00000054 OO06TE OGES 16 0 W B O - & 1 1 00000000a0000000 - 00:00:00,001, 648,
will be displayed OF82cE mov.Wie  [A0], [A1]
-00000057 OO0EDE —-ES 16 1 - - 1 oW 1 1 1 0000000a0000300 - 00:00:00,001, 648, §
-00000036 OFE2D2 0289 16 0 W R O - 3 1 1 0000C000a0000300 - 00:00:00,001, 648, 7
~000000s5 000eE4 Oree 16b 0 e R0 - 3 1 1 0onoonoooEno0000 = D0:00:00.001. 648, 7
OPEZD1 B, OZH[AD],OEH[AL]
Figure 3.31 Trace wil| -o0acnos4 OOO709 PE-- 16 O DW W D W 1 1 1 0000000000000000 - 00:00:00,001, 648 .8
~O0000051 000704 ==0F 16 1 W W O RE 0O 1 1 000ana00a0000a0n - 00:00:00.001. 646 A
~00000052 OO0GEE 0000 166 O W B O - 0O 1 1 0000000000000000 -- 00:00:00,001, 648 .6
-00000051 OFEZDE €00 160 IM B O - 2 1 1 0Q00R00000000000 - 00:00:00,001, 648 .5
(4) A mixed display ~000000SD OFEZDE PClE 166 0 IM R O BB 3 1 1 0000R000a0000000 - 00:00:00,001, 49,0
OF82D5 ADD.W:Q  W1H, -4H[FE]
menu, you can dis| -00000049 O0070E O0-- 16h 0 oW W O o8 1 1 1 O0NaNa00a0000a00 - 00:00:00. 001, 649, 0
~00000043 ooo70c --00 16b 1 MW W O EBE O 1 1 00000000a0000000 - 00:00:00,001, 649, 1
Figure 3.32 Trace window (bus and disassemble mixed display)
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B e L T - = =t o - - - i WL e A e I e I L XD e
ok, 64 }
OFE2DA HXITD
-00000032 _wain  OFEIDC 1009 16b O Im B 0 c<w 2 1 1 000000o000000000 00:00:00,001, 649, 9
-000onoz1 OFBZpE 0Ok6a 160 0 m B0 = 4 1 1 0o0oono0oo000000 O0:00=00.001, 649,53
ROE521500MCUOQC| -onannozn OODGED 0717 16b 0 W R O - 4 1 1 0000000000000000 00:00:00, 001, &50,0
000000 ooDERD —-1F 6B 1 - - 1 - 4 1 1 DO0OD0O0a0NNN000 00:00:00.001. 6500
=000000z3 0oosEd  ==17 l1Eb 1 - = 1 = 4 1 1 DO00o0oO000000000 00:00:00.00%.650.1
O0oooozT DoOEEZ  835% 16b O W R o 9 1 1 Doooonooooooooon 00:00:00.00L.650.1
000000z & Oo0GE: OF 1eb 1 bE R a 4 1 1 Doooo0o0oo0000o00 00:00:00.001.&50.2
=000000z5 0005E4  --0F leb 1 = = 1 o8 001 1 oooocoooooooooon 00:00:00.001.650.2
00000024 OFE3S52 B473 16b 0 Im B 0 = 201 1 0o0oo0o0oo000000 00:00:00.001.650.3
(5) Furthermore’ che 0000003 OFE354 7T3Fa 16b 0 W B 0O o8 2 1 1 000oe00000000000 00:00:00.001.,850.3
disassemble and so | -oooooozz OFB354 ——FR 1B 1 - - 1 - 2z 1 1 0000000000000000 00:00:00.00L., 650, 4
-0000002 1 OFE354 ——Fn 161 - - 1 - % 1 1 OO0OD00000000000 00200200, 001, 650, 4
Figure 3.33 Trace window (bus, disassemble and source mixed display)
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IAND{.ﬁ.ccumuIatinn} j

Ewvertinuse: o  Deta |

ROE521500MCUOC
- Exceplion:
Exceptional e ]
events De_talll

Total 1 O Event

|4M -|

"Delay{cycle}:

3.17.2 Showing the

The point & delay fe ©al

—Record condikion:

i Capture " Do not capkture

[ Skep execution is recorded

This facility allows y

Eventinuse: 0

=N

(1) If any break cond

(2) Choose Fill aroun

Eventused 0 Free 16 Detail...l

Registered events. .. I

(Up to 4M cycles

3. Tutorial

boint is encountered.
Liser program.

column, specify 4M.

Save. .. I Load... | Help | Apply | Close |
e
Figure 3.34 Trace conditions dialog box (Fill around TP)
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mVE vsaxzniEEd4dr @ aaaa
(3) Next, set @ trace [|rangs: -nonoonny, p419azz e (Cpcke: -co000001 |.¢.-:Idra95 Q0071E (Time: D0:00:00,001. 305,520 |

dlalog box. Selec| tze=i= Lab=l @ Address Dnl—.a BUS BHE BIU B/W RWE CF r_‘m BUSACE Debud E's." EL¢ ELOOVLAE TimeStamp o
=00000001 0007 1E il 1  O00O00C0o0000o00ocd -- = 0
and then the Clos| oooooono O00F1E —-0F 16k 1 - - 1 oW 2 1 i 0000000000000001 -— - 00:00:00,001, 305, &
Q0000001 OFEZE0 OSF5 166 0 Tw B O <B 3 1 i 0O0O000000000000 -- - 00:00:00,001, 305, 5
Thus, the debugg| ooooooo: OF§2ZE0 —-F5 16k 1 - - 1 BB Z 1 1 000a0000a0000000 -- - 00:00:00,001,305,5
QT OFEZE! FEOD 166 0 W B O <B 2 1 i OO0AN00a0000a00 ~—— - 000000, 001,308, 0
0000004 OF§ZEZ —-00 16k 1 - - 1 ®BW 1 1 1 0000000000000000 -- - 00:00:00,001,308,0
ON00n00S OFEZEZ —-00 16 1 - - 1 o¢ 0O 1 1 OO0ON00a0000a00 -—— - 000000, 001,308, 1
. O0O00O0E _tucori OFEZEE FETC 1600 W R OO - & i 1 OONOCNO0a0000a00 -— - 00:00:00,001. 308, 1
Figure 3.35 Trace col| apoonoo7 OFEZER 7032 16b 0 I oo- 4 1 1 O00O0000a0000000 - - 00:00:00,001, 308, 2
a0oooood 000719 E2== 1eb O [iIET ] o = 4 1 1 0000000000000000 == = 00:00:00.00L.30& .2
ooooooog O0071la ==BZ 16b 1 1T ] o - 4 1 1 0000000000000000 == = 00:00:00.00L.306.3
aooooo1a OooY1leE OF== 1eb O DE W u] - 4 1 1 0O00000000000000 == = 00:00:00.001.30&.3
oooooo11 0o0vY1le OF-- 1eb O - - 1 - 4 1 1 0ooodoodoooogoog -- - 00:00:00.001.30&.4
anannn1z 000716 OF-— 166 0 - - 1 N 2 1 1 0000000000000000 -— - 00:00:00,001, 308, 4
(4) Choose Reset Go Q000001 OFEZEA OOEZ 16h 0 I oo- 4 1 i 0O0O000000000000 -- - 00:00:00,001, 308, 5
in the Trace wind/| oooooo1s OF§ZEA —-EXZ 1661 - - 1 - 4 1 i OO0Q000000000000 -- - 00:00:00,001, 308, 5
a000n01s 00717 O0-- 16h 0 MW W O EBE 3 1 1 000a0a00a0000a00 -- - 00:00:00,001, 308, ¢
Figure 3.36 Trace window (Fill around TP)
R20UT0455EJ0103 Rev.1.03 '-zENESAS Page 64 of 231

Sep.01.21



ROE521500MCUOQ0 User’s Manual 3. Tutorial

3.17.3 Showing a Function Execution History
A function execution _
wVE vARXI RE G4 R IGAG

(1) Clear all break cc
pop-up menu that
and click the App

(2) Set a software bre

(3) Choose Reset Go [Rarwpe: -00007515, Co00DCC. [Fle: [Cyck: -00000006 [addrass: OFFFES. (Time: 00:00:00,001, 654,770 |

Cyole Lab=l | Addres< Datd BUS BHE BIO B/ RWT CPU QN BUSACE Debug EV | BLE FLEOVLAE TimeStamp (Bim:s.m
will be displayed -00000006 OFFFEE --02 1661 - - 1 =- & 1 1 0onoooo0a00o0aon -- - 00:00:00.001, 854, 7
-00000005 OFFFES --0Z 161 - - 1 - & 1 1 0o00000002000000 -- - 00:00:00.00L, 654, 8
=-00000004 OrFFPES —-02 1egb 1 = S 1 S 201 i} Qo00d0o00o000000 -- - 00:00:00.001, 854, 8
(4) Click the right m¢| -ouooooos OOpd46 OF85S 160 0 W w1 - 2 1 i OO0Q0O00a0000a00 -- - 0020000, 001, 654, 5
A =00a00o0:2 O0oD4s  OFES 16h 0 W oW o S 1 0 Qo0od0o0acoo0oon -- - 00:00=00.001.654.5
HlStOfy from the | -onaoooo: Qop044 9353 16h 0 T W 1 = 1 0 Qo0oono0aoooooon -—— - 00:00:00.001,655.0
Qooonong oopod4 3353 160 MW W O - & 1 0 ooooooooooooooon -- - 00:00:00,001,655,0
Figure 3.37 Trace window (function execution history—before analysis)
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_rand (OFE944) <= OF3314
_rand [OFE949%) <~ OFE314
_zand (OFE944) <= OFA314

rand (OFE244) <= OFA314

ROES2:1500M C U O C 2S00
mvElsazznE B4 Plaaa

El main [OFEZDC) <= OFARBS
- _tuterial (OF8ZEE) <- OFEZED
¥ malloc (OPE49A) <= OF8IF1
(5) Click the right m¢ init (OFEOCZ) <- OFE303

H w- i (OFES94) <
HIStOI‘y from th6| Bl rand (OFE944) <- OFE314
*

[+

H-#H-H-H

_zand (OFES44) <= OFE314
_zand (DFE944) <= OFA314

Figure 3.38 Trace wil

|Fiange: -0000715, DoNO0EO0 e Ko 00006193 Addrass: DO0EEY. (Tima: 000000001 345,430 |

Cycle Lsbe=l . . . .
. - <Display form of function execution history>

_cli -00005162 . . : r
(6) Doub!e C"‘fk any  “oeneee Function name (start address of function) <— function caller address {0500 oo 2as s
function will be (| -ooas1so Example: _main (OF82DC) <- OF8AB5 :00:00.001.345. 5
-0000&5189 - :00:00.001.345.6
-00oos1e8 :00:00.001, 345, 6
-0000s187 Do0&pE  dEER 16h O e w0 BN 0O 1 1 oooooooooonoooon -- - 00:00:00.001.345.7

Figure 3.39 Trace window (function execution history)
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3.17.4 Filter Facility
Use the filter facility to extract only the necessary cycles from the acquired trace information.
The filter facility does this by filtering the trace information in software that was acquired by hardware.
Unlike the “Capture/Do not Capture conditions” where you set acquisition conditions before getting trace information, this
facility allows you to change filter settings for the acquired trace information any number of times without having to reexecute.
Therefore, the necessary information can be extracted easily.
Troce
(1) Clearallbreak ¢ ¥ 2 a2 = x k@ Fd b F QGG

pop-up menu tha |R""39 -00007515, (0000000 hﬂ Cycle: 00000016 [nddress: OFFFES. [Tne: 00:00:00,001.653.600 |

eycle =] Dabel | Addcelr] Du'l_lﬂ;l-_ﬂ;l_ﬂj_ﬁﬂ_?;l_ﬁ;t__]’ vsa ] p=b =] BV =] E=} Encovi= Tm-Sbmnp [him:a.m

mode is Fill until | -coooooie OFFFEE --00 16b B 1 0000000000000000 - - 0.00L. 653, 6
=00000015 OFFFEe —-0Z leb 1 1"3 R L = 2 1 1 DO0Od0o0oe000oon -- - ULI:'_IU:LIL‘.LIU_.&_F.—-".

00000014 OFFFEE —-0% 161 - - 1 - & 1 i 0O00000000000000 -— - 00:00:00, 001, 653, 7

(2) Set a software bre| -onoooois OFFFEE —-02 161 - - 1 - 2 1 1 0000000000000000 -- - 00:00:00.001, 652, 7
-00000012 OFFPES —-0% 16b 1 - - 1 - & 1 1 0O0O000000000000 -— - 0020000, 001, 653, 8

00000011 OFFFEE —-02 1661 - - 1 - % 1 1 0000000000000000 -- - 00:00:00,001, 652, 8

(3) Choose Reset Go | -anaonoia OFFFEE —-02 1661 - - 1 - % 1 1 0O0O000000000000 -— - D0:00:00, 001, 653,
. . -N0o000S OFEFEE —-0Z 16b 1 - - 1 - & 1 1 0ONOD000O0000a00 -- - 00:00:00, 001, 653, 5

will be displayed | -onoooons OFEPEE --0Z 16b 1 - - 1 - & 1 1 OONOOO00O0000ann -- - 00:00:00.001. 654 0
=00000007 OFFPREE ==0X 1Eh 1 - = 1 = z 1 1 DO00O00000000000 == = 00:00:00.00%. 654 .0

=0000000& OFFFEG ==0Z 1E6b 1 = = 1 = 2 1 1 DOO00o0oO000000000 == = 00:00:00.00L.654.1

o.| ~o0oo0o0s OFFPEE =-0Z 16b 1 = = 1 = 2 1 1 0000000000000000 == - 00:00:00.001. 654, 1

(4) Choose AUtO Flh =00000004 OFFFEe --02 lbb 1 C = 1 = 2 1 o pogocooooooogoon == = 00:00:00.00L.054.2
¥] | -ooooooos O0DO4E OFBS 165 0 MW W 1 - Z 1 0 0000000000000000 -- - 00:00:00, 001, 654, 2

marked by a =l ~00000002 O0p04s OFSS 165 0 W oW 0O - & 1 0 0O00000000000000 -— - 00:00:00, 001, 654, 3
00000001 OOpo4d 8353 16b 0 W oW 1 - & 1 0 0000000000000000 -— - 00:00: 00,001, 654, 3

00000000 Oopo44 8353 16b 0 W w0 - E 1 0 0000000000000000 -- - 00:00:00.001, 654,

Figure 3.40 Trace window (Auto Filter)

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 67 of 231
Sep.01.21



- AL T R R S S WE bt 4 o - - - e e o M A e I e I L B e Y
| _Annnnma ey crassny PR i AANACAOAARIANANN —— - AN = 010 = A0 0 . G55 7D
Ve saxzi-@lFdr Raaa
ROE521500MCUOC |Ran;|a 00007515, (000000 ha *oyche: 00000042 Wddress: OFEZEL (Time: DOM00V00,001.652,300 |
| fycle =] Lah=l | Addce=] Du*l_ﬂ;f_ﬂ;l_ﬂ:l’_ﬂd_?;l_ﬁ;t__!’ vea x| b=l EV _!;[ | T.unl:Shamp [him:a.m
-00000042 OFEZE1 77-- 1Gb 1 1 0000000000000000 0.001.652.3
-00oona41 OFE2E2 PCRE 16b I:I rw R D = 3 1 1 Qo0oc000000a0ana = DU:DU:UU 001,852 .3
-000onozsa Org2r4 0O00R 16b O IH R a EE 2 1 1 QOOOC0000o000000 = 00:00:00.00L, 852 .4
=-000000Ea oooemc  O00& 1eb O W B0 S 201 1 QO0QC00000000000 S 00:00:00.001,852.5
(5) Click the = but| -o0ooooz7 OFE2E6 ¢ATD 16k 0 W B O BN 2 1 1 0000000000000000 - — 00:00:00.001. 652, &
=-0000003 & OFEZER 7522 16h O W R i oW 201 1 QoQoo000000000a00 = 0D:00:00,001, 852 .6
-000on0zs OFg2EA 09cO 16h 0 W R v FE 3 1 1 Qo0oo0o000000000 S 00:00:00.001.6852.F
=-00000033 Org2pa F27D 16h O W R o = z 1 1 DoOoono00ono0a00 - 00:00:00.00%1,65% .7
-00000022 _main OFE2nC 10029 16h O w R o W z 1 1 0000C000a0000000 L 00:00:00.00%. 652 .8
. .| ~opoonozy OFEZDE OG6A 166 0 W B O - 4 1 1 0000T000a0000a00 - 00:00:00. 008 . 552 .
Figure 3.41 Trace Wil| _cpacooza OO0GED OF17 166 0 ©W B O 3 1 1 0000000000000000 - 00:00:00.00L. 552 . 5
-00000027 000GE2 @352 1660 MW B O = 4 1 1 0000000000000000 - 00:00:00.001. 553 .0
-0000002 § OO0EEE —--OF 166 1 BB B O - 4 1 1 0000000006000000 - 00:00:00.001. 553, 1
-000000z 4 OFE352 E473 16b 0 IW R a = 21 1 QoOoC00000000a00 = 00:00:00.001.653.2
-000000z3 OFE354 72FA 16b O W R a ¢E 2 1 1 QOOOC0000o000000 S 00:00:00.00L.85%.2
(6) That way, the trac| -coocoois OFFFEé —-00 16b 1 8 R 1 - 2 1 1 0000000000000000 -- - 00:00:00, 001, §53 ., ¢
-00000015 OFFFPES —-02 16h 1 g B 0O S 21 1 QO0QC0o00a0000000 S 00:00:00.001,.653.6

Figure 3.42 Trace window (Auto Filter)

Notes:

(1) The filter function does not affect the trace memory, so that its content remains intact.

(2) The filter can be used when the selected trace mode is Fill until stop, Fill until full or Fill around TP.
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3.18 Stack Trac:

Using stack informati
Set a software break|
column.

1

53
54
55
S
57
5
59
al
gl
a2
63
a4

F3zZao

Fgz86
Fgz291

F3ZAE
F3ZE9

F3ZDA

change [ long *a)

{

long tmp[10] ;
int i:

for(i=0; i«<10; i+4){
twp[i] = alil:

b

for(i=0; i«<10; i+4){

a[i] = tmp[2 - 1]:

'

3. Tutorial

;ts.
Breakpoints

i Tutaral.c

Figure 3.43 Editor window (setting a software breakpoint)

Choose Reset Go from the Debug menu.
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ROE521500MCUOC 3. Tutorial

After a break, choose > window.

Figure 3.44 Stack Trace window

You will see that the current PC exists within the sort() function, and that the sort() function is called from the tutorial()
function.

Clear the software breakpoint that you have set in a line of the sort function by double-clicking at its corresponding row in the
S/W Breakpoints column again.

3.19 What Next?

In this tutorial, we have introduced to you several features of the E100 emulator and how to use the High-performance
Embedded Workshop.

The emulation facility that the E100 emulator provides allows you to perform advanced debugging. Once the conditions that
cause hardware or software problems to occur are exactly separated and identified by that debugging, you can examine those
problems effectively.
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4. Preparing to Debug

4.1 Starting the High-performance Embedded Workshop
Follow the procedure described below to start the High-performance Embedded Workshop.

(1) Connect the host machine and the E100 Emulator and user system. Then turn on the power to the E100 Emulator and user
system.

(2) From Programs on the Start menu, choose Renesas -> High-performance Embedded Workshop -> High-performance
Embedded Workshop.
The Welcome! dialog box shown below will appear.

Welcome! 1' EI

| {+ ‘Create a new project workspace ok
Cancel

" Open arecent project workspace:
I j Adrminiztration. .

cJ

—' " Browse to another project workspace

i

Figure 4.1 Welcome! dialog box

Select a startup method from the following.

- Create a new project workspace

- Open a recently used project workspace
Select this option when you use an existing workspace.
A history of the workspace you open will be displayed.

- Browse another project workspace
Select this option when you use an existing workspace.
This is the option available to choose when the workspace you opened has no history recorded.
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4.2 Creating a New Workspace (Toolchain Unused)

The procedure for creating a new project workspace differs depending on whether you use a toolchain or not.

The E100 Emulator has no toolchains included in it. You can use a toolchain in an environment in which the C/C++ compiler
package is installed.

Follow the procedure described below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click the OK button.

J ' Lreate a new project workspace ok
Cancel

" Open a recent project workspace:
I j Ldministration...

- |
j " Browse to another project workspace

\ Ix

Figure 4.2 Welcome! dialog box

(2) Project Generator will start.

Mew Project Workspace ilil

Projects |

- work space Mane:
Project Types P

Debugger anly - M16C E100 E I
Froject Mame:

Directory:

IC:\W’nrkSpace\Test Browsze... I

LCPU family;
{M16C =]

Tool chain:

INDne j

| i
Properties. .. |

(1] I Cancel

Figure 4.3 New Project Workspace dialog box

Workspace Name: Enter a workspace name here.
Project Name: Enter a project name here. If the same name as a workspace name is good, you do not
need to enter it.
Directory: Enter a directory in which you want a workspace to be created. Or you can click the
Browse button and select a workspace directory from the ensuing list.
CPU family: Select the CPU family of the MCU you are using.
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The other list boxes are used for setting up a toolchain. If no toolchains are installed, the information specific to the CPU
family is displayed here. Click the OK button.

(3) Select the debugger target.

Setting the Target System for Debugging ﬂﬂ

— Targets :

Target type : IA" Targets j

¢ Back I Mext > I Finizh | Cancel |

Figure 4.4 Setting the Target System for Debugging dialog box

Select the target platform you use by placing a check mark in its check box and click the Next button.

(4) Set a configuration name. Configuration refers to the file in which the High-performance Embedded Workshop status
other than the emulator is saved.

Setting the Debugger Dptions 2l

Target name :

M1EC E100 Ermulato

Configuration name :
|Debug M1EC_ET00_E mulator

— Detail options ;

Item | Walue

I odify |

< Back I ezt » | Finizh | Cancel |

Figure 4.5 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click the Next button and then set a configuration name for each target
platform selected.
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When you have finished setting configuration names, emulator-related settings are completed.
Click the Finish button, and the Summary dialog box will be displayed. Clicking the OK button in it starts the High-
performance Embedded Workshop.

(5) After starting the High-performance Embedded Workshop, connect the E100 Emulator.

4.3 Creating a New Workspace (Toolchain Used)
Follow the procedure described below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click the OK button.

‘Welcome! ll _I

| % Create a new project workspace o

Cancel

X

" Dpen a recent project workspace:

I j Adrministation. .

J
j " Browse to another project warkspace

i

Figure 4.6 Welcome! dialog box

(2) Project Generator will start.

Ilews Project Workspace i

Fiojects |

o M anme;
R — wiotkspace Mame

ﬂ Applcation I
I3 € zource statup Apphealion Proiect Name:
I Empry Application

5 Impart Makelile I
@ Libiany Direchon:
A Diebuger only - M1EC E100E I

F+ Debugger only - 160 Simulat

LPU Family:
[NEE =l
Tonl chan:
|Henegas M1ELC Standard :I

1] | 1|
Propertiss... |

| 0k | Cancel

Figure 4.7 New Project Workspace dialog box
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Workspace Name: Enter a workspace name here.

Project Name: Enter a project name here. If the same name as a workspace name is good, you do not
need to enter it.

Directory: Enter a directory in which you want a workspace to be created. Or you can click the
Browse button and select a workspace directory from the ensuing list.

CPU family: Select the CPU family of the MCU you are using.

Toolchain; To use a toolchain, select the appropriate toolchain here. If you do not use, select None.

The other list boxes are used for setting up a toolchain. If no toolchains are installed, the information specific to the CPU
family is displayed here. Click the OK button.

(3) Set the CPU and options for the toolchain and make other necessary settings.

(4) Select the debugger target.

Setting the Target System for Debugging 2 x|

— Targets

Target type : I-"-\” Targets j

< Back I Mewut » I Finish | Cancel |

Figure 4.8 Setting the Target System for Debugging dialog box

Select the target platform you use by placing a check mark in its check box and click the Next button.
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(5) Set a configuration name.

Setting the Debugger Options 2x|

Target name :

r416C E100 Emulatol

Canfiguration narme :
|Debug_M16C_E100_Emulatar

— Detail optiong

Item | Walue

T ndifyy |

< Back I Hewt > | Finizh | Cancel |

Figure 4.9 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click the Next button and then set a configuration name for each target
platform selected. When you have finished setting configuration names, emulator-related settings are completed. Click the
Finish button, and the Summary dialog box will be displayed. Clicking the OK button in it starts the High-performance
Embedded Workshop.

(6) After starting the High-performance Embedded Workshop, connect the E100 Emulator.
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4.4 Opening an Existing Workspace
Follow the procedure described below to open an existing workspace.

(1) In the Welcome! dialog box, select the radio button titled “Browse to another project workspace” and click the OK button.

Welcome! ll EI

: | " Create a new project workspace i

Cancel
i~ Open arecent project workspace:;
I j Adrinistration...

CJ
T

s Browse to another project workspace

A

Figure 4.10 Welcome! dialog box

(2) The Open Workspace dialog box shown below will appear.

2

Look in: | 3 E100 ~| & B o B

l E100

File name: IE'IEIEI_hws Select I
Files of tpe: IHEWWarkspaces [* b j Cancel |

Figure 4.11 Open Workspace dialog box

i

Specify the directory in which workspaces are created, select a workspace file (extension “.hws”) and click the Select button.

(3) The High-performance Embedded Workshop will start, and the state of the selected workspace in which it was saved will
be restored. If the saved state of the selected workspace is one in which it was connected to the emulator, the workspace is
automatically connected to the emulator. If the saved state of the selected workspace is one in which it was not connected
to the emulator and you want to connect it, refer to “4.5.1 Connecting the Emulator”.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 77 of 231
Sep.01.21



ROE521500MCUQ0 User’s Manual 4. Preparing to Debug

4.5 Connecting the Emulator

4.5.1 Connecting the Emulator
There are following methods for connecting the emulator.
(1) Setting up the emulator at startup before connecting

Choose Debug Settings from the Debug menu to open the Debug Settings dialog box. In this dialog box, you can register
download modules and the command chain to be automatically executed. When you are finished filling in the Debug Settings
dialog box, the emulator will be connected.

(2) Loading a session file

Switching to the session file that has emulator usage settings preregistered in it helps you connect the emulator easily.

4.5.2 Reconnecting the Emulator
While the emulator is disconnected, you can reconnect it following one of the procedures described below.

(1) Choose Connect from the Debug menu.

P
(2) Click the Connect tool button [L=2_1].

(3) Enter the connect command in the Command Line window.
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4.6 Disconnecting the Emulator

4.6.1 Disconnecting the Emulator
To disconnect the emulator while it is active, follow one of the procedures described below.

(1) Choose Disconnect from the Debug menu.

(2) Click the Disconnect tool button [F ].

(3) Enter the disconnect command in the Command Line window.

4.7 Quitting the High-performance Embedded Workshop

Choosing Exit from the File menu lets you close the High-performance Embedded Workshop itself.
Before it closes, a message box will be displayed asking you whether you want to save the session. To save the session, click
the Yes button.
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4.8 Setting Up the Debug
Register download modules, set up automatic execution of command line batch files and set download options, etc.

4.8.1 Specifying a Download Module
Choose Debug Settings from the Debug menu to open the Debug Settings dialog box.

Debug Settings 7| x|
IDefauItSessinn x| Target |Elptinns|
------ & E100
Default debug format:
[[EEEE35_RENESAS =l
Download modules:
Filename | Offzet Address | Faormat | Add...
FCONFIGDIR$PROJ... 0O000000 IEEEE9S_REMES...
e mlifiy... |
Bemoye |

] I Cancel

Figure 4.12 Debug Settings dialog box

In the Target drop-down list box, select the product name you want to connect.
In the Default debug format drop-down list box, select the format of the load module you want to download. Then register the
load module corresponding to the selected format in the Download modules list box.

CAUTION
At this point in time, no programs are downloaded yet.
For details on how to download, refer to “5.2.1 Downloading a Program”.
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4.8.2 Setting Up Automatic Execution of Command Line Batch Files
Click the Options tab of the dialog box.

Debug Settings [ fied |
|5 essionM16C_E100_Emulator *|  Taget Options |
iz E100

oy,

Hemave

L1

[+ Downlosd modues sfter build

[¥ Remave breakpoints oo dowrload

[ Disable memony access until aiter tangst connaction command file execution
[~ Limit dizazzembly memon accezs

[~ Do nat perfarm automatic taiget connection

[+ Riezat CPU aiter dowrdoad module

[T Dizable memony sccess by GUI when target is executing

| 0F, | Cancel

Figure 4.13 Debug Settings dialog box

Here, register a command chain that is automatically executed with specified timing.
Select your desired timing from the following four choices:

- When the emulator is connected
- Immediately before download

- Immediately after download

- Immediately after reset

In the Command batch file load timing drop-down list box, select the timing with which you want a command chain to be
executed.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 81 of 231
Sep.01.21



ROE521500MCUO00 User’s Manual

5. Debugging Functions

5. Debugging Functions

The E100 emulator supports the functions listed in the table below.

Table 5.1 List of Debug Functions

Item P
NoO. Item Specification
1 Software break 4,096 points
Number of event points Maximum number of effective points:; 16
Executed address detection
Content of event Data access dete(_:tion _ _
2 Event Interrupt generation/exit detection
External trigger detection
Task ID Can be set separately for each event
Number of times an event occurred Maximum 255 times
Violation of access protection
Stack access violation
Read from uninitialized memory
3 Exception detection Perfor mance gverfl ow
Realtime profile overflow
Trace memory overflow
Task stack access violation
OS dispatch
Hardware Event combination OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and
4 Hardware breakpoints state transition
break Exception detection See item No. 3
Delay Maximum 65,535 bus cycles
Trace size Maximum 4M cycles
Fill until stop Continues collecting until program stops running
Fill until full Stops collecting traces when trace memory is full
Trace mode Fill around TP Stops collecting traces after retarded for delay cycles from when trace point
is reached
Repeat fill until stop Collects a total of 512 cycles before and after trace point
Repeat fill until full Collects a total of 512 cycles before and after trace point
5 Trace ) Event combination OR, AND (Accumulation), AND (Simultaneous), subroutine, sequential and
Trace point state transition
Exception detection See item No. 3
Delay Maximum 4M bus cycles
Capture/Do not Capture by event
- Between two events
Trace Capture/Do not Capture - Duration of an event
- Duration of an event occurring in a subroutine
Data access instruction extraction
Measures maximum, minimum and average execution time in up to 8
Content of measurement sections and pass counts
6 Performance _ Timeout detection
Resolution 10 ns to 1.6ps
A Between two events, Event period and Interrupt-disabled range between two
Measurement mode Event combination events
512 bytes x 32 blocks
7 RAM monitor - Shows last read/write accesses performed
- Comes with initialization-omitted detect function
] 128 Kbytes x 8 blocks (1-Mbyte space)
8 Profile — -
Cumulative time and pass count overflow detection
CO level code coverage
256 Kbytes x 8 blocks (2-Mbyte space)
CO+C1 level code coverage
9 Coverage 128 Kbytes x 8 blocks (1-Mbyte spfa.ce).
Address range and source file specification
Data coverage
64 Kbytes x 8 blocks (512-Kbyte space)
Address range, section specification and task stack
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5.1 Setting Up the Emulation Environment
When the emulator is connected, the Device setting and the Configuration properties dialog boxes are displayed. Here, select
the general options associated with the emulator. Note that the target MCU to be debugged, etc. can be set only once at startup.

5.1.1 Setting Up the Emulator at Startup
When the emulator starts, the following three dialog boxes are displayed.

(1) Device setting dialog box

Use this dialog box to select the target MCU and establish communication.

This dialog box can be redisplayed by selecting Emulator -> Device setting from the Setup menu after starting the emulator. In
this case, however, be aware that changes of the settings after starting the emulator are not reflected immediately and will be
set as the initial value when reconnecting the emulator.

(2) Configuration properties dialog box

This dialog box is displayed after the Device setting dialog box. Use this dialog box to make settings related to the emulator
and debug functions.

This dialog box can be re-opened by selecting Emulator -> System from the Setup menu after the emulator has been booted up.
Some options in this dialog box can have their settings changed after startup. The changeable options are displayed as in active
use, while the unchangeable options are inactive (grayed out), with their set contents only displayed.

(3) Connecting dialog box

This dialog box shows the progress of boot-up processing.
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5.1.2 Setting Up the Target MCU
(1) Selecting the target MCU

On the Device page of the Device setting dialog box, specify the target MCU to be emulated.

For details, refer to the hardware manual supplied with each product.

Device sctting_____ IR |

Dlevice I

Group
Devisa [ReFz15:5E_EG_3ar |
Mode [Single Chip |

Poit mapging Comirol Ih'ﬂﬂﬂ =

~ Comenrecation 5 efling

Sevaig, 1100 rooone =] _refieh |
[ Start becting up on successhd completion of sef-checking,

[ ot | cacd |  Hep |

[ Do ok show this diskog bax again

Figure 5.1 Device setting dialog box (Device page)

The target MCU you have set here cannot be changed after the emulator is connected.

To change the target MCU, you need to disconnect the emulator and connect it again.

(2) Selecting an operation mode
The operation mode is fixed to the following option:
Single-Chip mode

CAUTION
Options are different depending on the target MCU that you select.

(3)Selecting the port mapping control
Specify the number of pins of the target MCU to be emulated.

CAUTION
Options other than ‘48pin’ and ‘64pin’ are reserved and the pin counts are not provided for your target MCUSs.

(4) Setting up communication

You can select another target emulator connected via USB.
The ‘USB Serial No.” list box shows unique identity information on the emulator connected via USB. Clicking on the Refresh
button updates the information.

(5) Performing self-checking
If you click on the OK button with the ‘Start booting up on successful completion of self-checking.” checkbox selected,
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hardware self-checking proceeds after connection to the emulator has been made according to the communication condition

you have set.
The results are shown on completion of self-checking.
If the results are normal, boot-up processing continues. If an error is found, boot-up processing stops.
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5.1.3 Setting Up the System

On the System page of the Configuration Properties dialog box, set up the entire emulator system.

This dialog box is displayed following the Device setting dialog box at startup.

Although this dialog box can be redisplayed after startup, you cannot change some settings in it. These settings can only be
changed at startup.

Configuration properties |

Sustem | Intamal flagh mamony ovenvsrke I E xephion \Waming [

— Clock
Man * Emulator  © Llzes I Generate

I 10 WiHz

Sub  Ermulabor T Uses

~ Trigger
External ligges cable % EXT 031 IMFUT  © Eﬂ,@:ﬁ 'gfﬁ';m
. EXT 015 TTL
Inpust biigger level & EMT 031 CMOS Sl o
Swalching hunction
= Code covetage 0 Diata cowerane " Reakime prafile
Code coverage mode
* C0 coverages " 0+ C1 coverage
— Dlebug Funchon

I Dietusg the program uzng the CPLU Rewrite Mode.
I Mack the tesmins AESET.

r— Timer Function
™" Stops all timer counts, whie the wzer pragram haz halted.

ok | cancel | Hep |

[~ Do nat show this dialeg box 20ain

Figure 5.2 Configuration properties dialog box (System page)

(1) Selecting the operating clock

In the Clock section on the System page, select the clocking sources supplied to the main clock and sub-clock.

The main clock can be selected from three choices: Emulator, User and Generate. (By default, Emulator is selected.)

Select Emulator when the main clock is supplied from an internal source or User when the main clock is supplied from an
external source. To use a user-defined clock, select Generate and set the clock frequency to be used in the frequency input text
box.

The clock frequency can be set in the range 1.0 to 99.9 MHz in 0.1 MHz increments. The clock frequency for Generate can be
set only once at startup.

Selection of the sub-clock is displayed only when sub-clocks are supported. It can be selected from Emulator or User. (By
default, Emulator is selected.)

CAUTION
The frequency accuracy for Generate is +5%. Please make sure that final evaluation is performed using a resonator or
oscillator module of the frequency used for the actual target board that is mounted on-board.
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(2) Selecting the direction of external trigger cable

For External trigger cable, select whether EXT pins 16—31 are directed for input or output. EXT pins 015 are fixed for input.
Select this option from the following:

- EXT 0-31 INPUT (default)
- EXT 0-15 INPUT, EXT 16-31 directed for OUTPUT

(3) Selecting a trigger input level

For Trigger input level, select CMOS level or TTL level. Select this option from the following:

- EXT 0-31 chosen to be CMOS (default)
- EXT 0-15 chosen to be TTL, EXT 16-31 chosen to be CMOS

(4) Selecting a switching function

The Code coverage, Data coverage and Realtime profile functions cannot be used at the same time. Select one function from
them.

Initially, Code coverage is selected.

The setting of this option can be changed even after startup.

When the Code coverage function is selected, measurements are performed at the coverage level selected in Code coverage
mode.

(5) Selecting a code coverage mode

Select a code coverage mode.

CO: Instruction coverage rate

CO0 + C1: Instruction coverage rate + Branch coverage rate

You can measure up to 2 Mbytes when using the CO level coverage, and up to 1 Mbytes when using the CO + C1 level
coverage

The initial value is CO coverage.

The setting of this option is reflected at only startup.

This option is available only when the Code coverage is selected in Switching function.

If you use the code coverage function, select the mode in this option at startup.

(6) Debugging the program using the CPU Rewrite Mode

Select whether you want to debug the program using the CPU Rewrite Mode.

(7) Masking the terminal RESET

Select whether you want the input signal to the RESET pin of the user system to be masked.

(8) Stopping all timer counts while the user program is halted
Select whether you want to stop all timer counts while the user program is halted.

CAUTION
The option “Stops all timer counts, while the user program has halted.” is inactive (grayed out) with M16C/64 Group,
M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x Series MCUs.
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5.1.4 Setting Up Flash ROM Overwrite

On the Internal flash memory overwrite page of the Configuration properties dialog box, set up the overwriting of flash ROM

blocks, block by block.

Configuration properties 5'

Systemn  Internal flash memony avenarite | E xception 'Waming |

Mo | Address |
Om 0032000 - DO33FF
(e 003400 - 0037FF
[ ] 003800 - DO3EFF
O o 003C00 - D03FFF
Oos 004000 - DOBFFF
O o 00C000 - DODFFF

L Getal

Clear al |

Selected blocks will be ovensritten rather than deleted when the user
progran iz downloaded.
Unzelected blocks will be ovenaritien after deleted.

(] | Cahcel | Help

[ Do not show this dislog box again.

Figure 5.3 Configuration properties dialog box (Internal flash memory overwrite page)

Block-by-block settings matched to the selected target MCU are automatically displayed in the list.
The blocks selected by placing a check mark in the respective check boxes are overwritten (merged), without being erased,

when a program is downloaded.
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5.1.5 Setting the Warning of Exceptional Events
On the Exception Warning page of the Configuration properties dialog box, set whether or not to display warnings of
exceptional events in the Status window and status bar balloon.

Configuration properties 5'

System I Internal flash memomy ovenwite  Exception \Warning

[v Aiolation of access protection

¥ Read from uninitislized memany

[T Stack access violation

[ Performance overflow
™| Eealtime prafile averflow

[ Trace memary averflovw

¥ Task stack access vinlation

[T 05 dizpatch

Checked tems will dizplay warning in a dialog balloon,

(] I Cahcel | Help |

[ Do not show this dislog box again.

Figure 5.4 Configuration properties dialog box (Exception Warning page)

The “Violation of access protection’, ‘Read from uninitialized memory” and ‘Stack access violation’ checkboxes are selected
by default.

When a load module including OS has been downloaded, the ‘Task stack access violation” checkbox is also selected by default.
Other items are not selected.

If you deselect a checkbox, this item will be shown as -’ in the Status window.
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5.1.6 Showing Progress in Boot-up Processing

You can confirm the progress of boot-up processing by checking the Connecting dialog box.

The Connecting dialog box continues displaying progress information from when boot-up processing starts till when it ends.
While the Device setting and the Configuration properties dialog boxes are displayed, you cannot manipulate this dialog box.

Connecting. ..

Base |/F Black Rev. =REV.E a| [~ Status
EV Comb Block Rev.  =REVE USER SYSTEM  DISCONMECT
EV Detect Fev. =REW.B )
Series Mame = REC/Tiny [Dizconnect: CHMO, CHM1, CHHZ)
G M =RAC/3x G
et Sen o POWER SOURCE  DISCONNECT
Esternal Trigger Cable Info. (0.5 ]
Cable Connect Status =MOT C .
Poveer O Test. RESETH High
12 Bug Access Check =0 -
Mon CPLU-GSRAM Check =0F | NMI# High
Mon CPU-USE Check.  =0K ChWss
J-TAG chain initialization.
Setting of MCU supply clock. HOLDH
tainClack Emulator
SubClock Emulator FILi
Setting of informatian oh individual b BYTE
Setting of debugging option.
Setting of MCL signal latch timing in tODE a
Setting of register data only for tool,  Clack
Setting of monitar CPU space data. oc
Setting of target MCL space data. CPU Clock 16.0 MHz
Setting of debugging information. :
Setting of emulator generation clock Main Clack=IM] 20.0MHz
.| | Sub Clock [<CIN] 33.0kHz

Setting of emulator generation clock, frequency.

¥ Close the dislog box when the connection is completed.

Cancel |

Figure 5.5 Connecting dialog box

(1) Showing the history of processing

The history display area on the left-hand side of the dialog box shows the history of completed processing.
The contents shown here are recorded in a trouble report. To check the content of a trouble report, select Technical Support ->
Create Bug Report from the Help menu.

(2) Showing the pin states

The pin states are displayed after the completion of the emulator’s startup process.
If the contents set in the Device setting dialog box and the pin states shown here do not match, a warning message is displayed
in the history display area.

(3) Showing the clocks

The clocks are displayed after the completion of the emulator’s startup process.
Only the actually operating clocks are displayed here.
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(4) Showing progress with progress bars

The upper progress bar shows the progress of the entire boot-up processing.

The lower progress bar shows the progress of each individual processing.

The content of the currently executed processing is displayed below the bar.

(5) Aborting a connection

Clicking the Cancel button aborts boot-up processing.
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5.2 Downloading a Program

5.2.1 Downloading a Program

Download the load module to be debugged.

To download a program, choose Download from the Debug menu and select your desired load module from the ensuing list, or
right-click a load module in Download modules of the Workspace window and then choose Download from the pop-up or pop-
up menu.

CAUTION
Before a program can be downloaded, you must have it registered as a load module in the High-performance Embedded
Workshop. For details on how to register, refer to “4.8 Setting Up the Debug”.

5.2.2  Showing the Source Code
Follow the procedure described below to show the source code.

- Double-click a source file in the Workspace window.
- Right-click in the source file and choose Open from the pop-up menu.

[@Tutoriale =lol x|
EfEl=
Line | Seur. [ E.] C.] 5.] Source I

21 void tutorial (void) Zl

22 |FE224 {

23 long a[10] 2

=4 long 3:

25 ine 1;

26 struct Sample far *p_sam:

27

28 |FE2z27 p_sam= malloc(sizect (struct Sample]]

29 |FEZ3E » init (p_sam) ;

3o

31 |FE247 (=3 for( i=0; i<10:; i++ )¢

32 |FE252 4 = randi]:

33 |FEZ25E|HY i£(3 <« O0){

34 |FEZA3 3= =3

35 H

36 |FEZ6C|7m — a[i] = j:

37 3

38 |FE28:2 sart(a) ! bt
<| | M

Figure 5.6 Editor window

Shown at left edge of this window are the line information consisting of the following:
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(1) Line column

Shows the line numbers corresponding to lines in the source file.

(2) Source Address column

When a program is downloaded, this column shows the addresses corresponding to lines in the current source file. This
function will prove convenient when you determine where you want the PC value or breakpoint to be set.

(3) Event column

This column shows the following:

Table 5.2 Event column list

H! | Hardware breakpoint is set
= | Trace point (fetch condition) is set

A hardware breakpoint can be inserted by double-clicking in the event column.

Trace points are displayed when fetch conditions are set.

[*] after the title on the title bar of the dialog boxes of Hardware break, Trace conditions or Performance Analysis Conditions
shows that some setting is under editing. If you are doing some editing work, you cannot set change the settings from the event
column of the Editor window.

(4) Code Coverage column

Shows CO code coverage information graphically.

(5) S/W Breakpoints column

This column shows the following:

Table 5.3 Software breakpoint column list

= | Bookmark is set
@ | Software break is set

= | PC position
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5.2.3 Turning columns in all source files off
(1) From the Editor window

1. Right-click in the Editor window and choose Define Column Format from the pop-up menu.

2. The Global Editor Column States dialog box will be displayed.

Global Editor Column States
[w]Code Coverage =
Dizazzembly Address - -
Ewvent Carnicel |
Label
Line
0bj code
S0 Breakpoints —

[w] 5.5 Breakpoints - A5 -
Fr— I LIJ

Figure 5.7 Global Editor Column States dialog box

3. Deselect the check box of the column you want to turn off. Click the OK button, and the new column settings you have set
will take effect.

5.2.4  Turning columns in one source file off
(1) From the Editor window

1. Right-click in the Editor window and choose Columns from the pop-up menu.

2. Cascaded menu items will be displayed. The currently enabled columns have a check mark attached to the left of the
respective names.

Columns v Code Coverage

v Disassembly Address
Turn Header OnjCFf — U

+ Event
Imstant wWakch v Label

v L
Go To Cursor e ";E d

el
Set PC Here S| s

v S E ink
Displaw PC — o Bt el s

» S Breakpoints - A5
Wigw Disassembly ¥ Source Address

Figure 5.8 Pop-up menu window

3. Clicking a column name lets you enable or disable the column alternately.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 94 of 231
Sep.01.21



ROE521500MCUOQO0 User’s Manual 5. Debugging Functions

5.2.5 Showing Assembly Language Code

While a source file is open, click the right mouse button in the Editor window and choose View Disassembly from the pop-up
menu. The Disassembly window will be displayed.

The display start address in the Disassembly window is the one that corresponds to the cursor position in the Editor window.
You also can use the Disassembly View button in the Editor window to display disassembled codes.

If no source files exist, one of the following methods may be used to display disassembled codes.

&)

— Choose Disassembly from the View menu.
— Use the “Ctrl + D” accelerator.

— Click the Disassembly toolbar button |l

In this case, the Disassembly window opens at the current PC position.

Mixed mode display where all source lines are displayed beginning with that address is also supported as an option. To display
disassembled codes in mixed mode, click the Show in Mixed Mode button.

[ oicassemiry SN —ioixi
E.l 5. Disass. | Dbjcode Label Disassembly I
FEZZ4 |7CF23z _tutorial  [ENTER §32H Zl
FEz27 |7DEZO000 PUSH.U:G #ODO0H
FEZZE |7DEZZ800 PUSH.W:G #O0Z8H
FEZZF |FDDSE3OF ISR & _malloc
FEZ33 |7DB4 ADD.B:Q  #4H,SP
FEZ35 |730BF4 WOW.¥:G RO, -GH[FE)
FEZ38 |73ZBFC HOWV . W: G RZ,=4H[FE]
@ FEZ3B |754BFC PUSH.W:G -4H[FB]
FEZ3E |754EFA PUSH.U:G -GH[FE]
WY |FE241 |FD14EQOF JSE. A _init
FEZ45 |7DB4 ADD.B:Q  #4H, SP
o FEZ47 |DOOEFE NOWV.W:Q  #O0H, -ZH[FEB]
FEZ4A |778BFE0AOC CMP.W:G  #000AH,-ZH[FE)
FEZ4F |7DCA31 JGE FEZ8ZH
=| |FEz5z |FDSZESOF JSE. A _rand iy
FEZ56 |7CF3 EXTS.U RO =
4| 2P

Figure 5.9 Disassembly window

Shown at left edge of this window are the line information consisting of the following:

(1) Event column

This column shows the following:

Table 5.4 Event column list

HY Hardware breakpoint is set.
] Trace point (fetch condition) is set.

A hardware breakpoint can be inserted by double-clicking in the event column.
Trace points are displayed when fetch conditions are set.
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(2) S/W Breakpoints - ASM column

This column shows the following:

Table 5.5 Software breakpoint — ASM column list
@ | Software break is set.
= PC position

(3) Disassembly Address column

Shows disassembly addresses. Double-clicking here brings up an Address Specification dialog box. In this dialog box, enter
the address from which you want a disassembly display to start.

(4) Obj code column

Shows object codes.

(5) Label

Shows a label. This column is unusable unless any module is downloaded.

5.2.6  Correcting Assembly Language Codes
Double-click an instruction you want to correct in the Disassembly window or choose Edit from the pop-up menu, and a dialog
box labeled “Assemble” will be displayed. Use this dialog box to correct assembly language.

Assembler ilil

Addrezz Code

FB2F5 DI0OBFE

Mriemonic; Canicel |

MOV 0 #OH-2H[FE

Figure 5.10 Assembler dialog box

The dialog box shows the address, instruction code and mnemonic of a selected instruction.

Enter a new instruction (or edit the old instruction) in the Mnemonic edit box. When done, hit the Enter key. The memory
content will be overwritten with the new instruction code, and the pointer is moved to the next instruction.

Clicking the OK button overwrites the memory content with the new instruction code and closes the dialog box.

CAUTION

Assembly language codes are displayed from the current memory content. When you correct memory contents, new assembly
language codes are displayed in the Disassembly window and the Assembler dialog box. However, the source file being
displayed in the Editor window remains unchanged. The same applies when the source file includes assembler language.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 96 of 231
Sep.01.21



ROE521500MCUOQO0 User’s Manual 5. Debugging Functions

5.3 Displaying Memory Contents in Real Time

5.3.1 Displaying Memory Contents in Real Time

To monitor memory contents while the user program is running, use the RAM Monitor window.

The RAM monitor function permits the memory content and access status in an allocated monitor area to be recorded and
inspected in real time without obstructing execution of the user program.

The RAM Monitor window shows access statuses (read, write, non-initialized or uninspected) in different colors.

(1) Allocating a RAM monitor area

A 16-Kbyte RAM monitor area is provided.

This RAM monitor area can be allocated to selected contiguous addresses or divided 32 blocks in 512-byte units.

With initial settings, a maximum 16 Kbytes of area from the beginning address of the internal RAM is allocated as a RAM
monitor area.

(2) Monitor display

The access statuses are displayed in different background colors depending on access attributes, as listed below. (The
background colors are customizable.)

The read and write accesses show the last accesses made.

Error detection can be displayed by choosing Show Error Detection from the pop-up menu. In this case, the read and write
accesses are not displayed.

Table 5.6 Access attribute and background color

Access attribute Background color
1 | Read access Green
2 | Write access Red
3 | When Non-initialized memory (an area not written | Yellow
errors to has been read)
4 detected Uninspected memory (an initialized area has | Sky blue
not been read)
5 | No access White
CAUTION

The contents shown in the RAM Monitor window are the data acquired from bus accesses. Therefore, changes made by
accessing memory via other than the user program, as when memory is rewritten directly from external 1/O, are not reflected in
the displayed memory content.
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(3) Detecting reading from non-initialized areas

If a memory area that has not been written to is read, the emulator detects “reading from a non-initialized area” and outputs an
error.

To view errors of this type, choose Error Detection Display from the pop-up menu.

Non-initialized memory areas are shown in yellow.

This error detection can be an exceptional event used as a condition of a hardware breakpoint or trace point (also refer to

“Detecting exceptional events”).

(4) Detecting uninspected areas

If an initialized memory area has not been read, the emulator detects “an uninspected area” and outputs an error.
To view errors of this type, choose Error Detection Display from the pop-up menu.
Uninspected memory areas are shown in sky blue.

5.3.2 Setting RAM Monitor Update Intervals
Choose Update Interval Setting from the pop-up menu of the RAM Monitor window. The Update Interval Setting dialog box
shown below will appear.

Update Inkerval Setking d |

Interval (10 - 10000mzec : 10ms unit):

100 msec

ak. I Canzel

Figure 5.11 Update Interval Setting dialog box

The Update Interval can be specified separately for each window.
The initial value is 100 ms.

5.3.3 Clearing RAM Monitor Access History
Choose Access Data Clear from the pop-up menu of the RAM Monitor window. The history of all accesses made to the RAM
monitor area will be cleared.

CAUTION
If this function is executed while the user program is running, the user program’s realtime capability may be lost because a
memory dump occurs.

5.3.4 Clearing RAM Monitor Error Detection Data
Choose Error Detection Data Clear from the pop-up menu of the RAM Monitor window. The detected data of all uninitialized
memory and unrefered memory of the RAM monitor area will be cleared.
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5.4 Showing the Current Status

5.4.1 Showing the Emulator Status
To know the current status of the emulator, display the Status window.

To open the Status window, choose CPU -> Status from the View menu, or click the View Status toolbar button [ o 1.

This window does not update the displayed status during program execution.

Status =
Item |Status |
MZTU status Ready
PC:FOOOO
TazskID: -

Wiolstion of access protection -
Fead from uninitislized memory -
Stack access wioclation -
Ferformance owverflow -
Fealtime profile owverflow -
Trace memory overflow -
Task stack access wiolation -
05 dispatch -
Fun time count Qd:00:00.000.000.000
Cause of last break -

1 I PI'-. Memnaty }H. Platfarm h Events hTarget {r

Figure 5.12 Status window

The Status window has the following four sheets.

Table 5.7 sheet list of status window

Sheet name Description
Memory Shows information relating to memory resources.
Platform Shows information relating to the emulator and debugging.
Events Shows information relating to events.
Target Shows information relating to the target MCU.
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5.4.2 Showing the Emulator Status in the Status Bar
The status of the emulator can be displayed in the status bar.
By right clicking on the status bar, the items are shown. Check the items you want to show in the status bar.

[ Cebugger
+ Application

e
| ¥ TaskID

[ v BreakCondition
[« ExecutionTime

L ¥ Exreption —
Hormal |- |Software break OO, 001,306,220 |4

Figure 5.13 Status bar

Table 5.8 Items list of the emulator status shown in the status bar
Item Description
PC PC value
During execution: PC value
During Break: Normal

Task ID Task ID, task entry label
BreakCondition Break factors of the user program
ExecutionTime Result of time measurement
Exception Status of the exceptional event

(1) When more than one break factors occur.
When you click on the status bar area where the break factor is shown, a balloon is shown.
You can check the type of break factors in the balloon.

L7 %]
Break causze

- Soltveale break
- Hardware eeak (0R] EV=1

Florma F 50me Factors exist 4 Chck here 00:00:00,001,3%.200 |4,
Figure 5.14 Example of break factors display when break factors occur

(2) When an exceptional event occurs.
When an exceptional event occurs, a warning is displayed in a status bar balloon.
The exceptional event that is not checked on the Exception Warning page of the Configuration Properties dialog box is not
shown.

b x|
Waming: Exception event deteclion
- Bccess protection
|Addess 0071 C Attibute W RITE)
- Trace memany overflow
~ [

I b

Figure 5.15 Example of warning display when exceptional events occur
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5.5 Periodically Reading Out and Showing the Emulator Status

5.5.1 Periodically Reading Out and Showing the Emulator Information

To monitor the changes in emulator information while the program is running or stopped, use the Extended Monitor window.
The extended monitor function only monitors the signals output from the user system or MCU, and does not affect execution
of the user program.

To open the Extended Monitor window, choose CPU -> Extended Monitor from the View menu, or click the Extended

The displayed items are updated at an interval of about 1,000 ms during user program execution or about 5,000 ms during a
break.

Monitor toolbar button |

CAUTION
(1) “CPU Clock” can be measured only when a user program is being executed.
(2) The display contents of the status differ depending on products.

|
)
Item IValue I
UTzer System Connection DISCONNECT (Disconnect: CNNO, CHNN1, CHNZ)
ser System Power Source DISCONNECT (Vecl:0.7 v, VeocoZ:0.5 )
Taer Sysbtem RESETH High
Uzer System NMIf# High
Tzer System CHVss -
Tser System HOLDH High
Uzer System RDT#H High
Tzer System EBYTE -
CEPU Clock =
Main ©lock (EIN} Ewulator 20.0 MH=z
Sub Clock (ZCIN] Emulator 33.0 kHz
00000k Read Status =

Figure 5.16 Extended Monitor window
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5.5.2 Selecting the Items to Be Displayed

Choose Properties from the pop-up menu of the Extended Monitor window, and the Extended Monitor Configuration dialog
box will be displayed.

Extended Monitor Configuration | 2=
- Update millizcond E
Bunning: | 1000 Break: | B000
Cancel |

Seltings:

[tem | value E

[#] U z=r Spstem Cornection DISCOMMECT [Dizconnect CHNMO, CHMT, CF

[l User System Povesr Source DISCOMMECT [WecTl:0E v, VecZ0.4 v]

[ User System RESETH High

[l Uszr Spstem M4 High

User System CHY'ss - -
[ User Sysiem HOLD # High

[#] User Spstem RDYH High

User System BYTE - =
4] | 3

Figure 5.17 Extended Monitor Configuration dialog box

This dialog box permits you to set each item you want to be displayed in the Extended Monitor window.
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5.6 Using Software Breakpoints

5.6.1 Using Software Breakpoints

A software break causes the user program to stop running by rewriting the instruction code at a specified address with a BRK
instruction to generate a BRK interrupt. In that sense, this is a pre-execution break function.

4096 breakpoints can be set.

If multiple software breakpoints are set, the program breaks at any one of those breakpoints reached.

(1) When stopped at a software breakpoint

When the program you have created is run and the address you have set as a software breakpoint is reached, a message
“Software Break™ is displayed on the Debug sheet of the Output window, with the program made to stop there. At this time,
the Editor or the Disassembly window is updated, and the position at which the program has stopped is marked with an arrow

[ q] in the S/W Breakpoints column.

CAUTION

When a break occurs, the program stops immediately before executing the line or instruction at which a software breakpoint is
set. If Go or Step is selected after the program has stopped at that software breakpoint, the program restarts from the line
marked with an arrow.

5.6.2 Adding/Removing Software Breakpoints
Follow one of the following methods to add or remove software breakpoints.

- From the Editor or the Disassembly window
- From the Breakpoints dialog box (only removing)
- From the command line

(1) From the Editor or the Disassembly window
1. Check to see that the Editor or the Disassembly window that is currently open includes the position at which you want to set
a software breakpoint.

2. In the S/W Breakpoints column, double-click the line where you want the program to stop.
=0l
Elll=

Ling Sowr.. E. LS. Souce I
: =
g init (struct Sample *p_saw)
9 |Fa0cE [ J
10 |F8ocs p_sem-=s0 = 0
11 |F30D7 p_s&m-x>31 = 0
1z |FsoED Ié’ p_sam->3z = 0
13 |F3105 p_gsm->23 = 0:
14 |(FS11D p_ssm->34 = 0:
15 |F81358 p_ssm->35 = 0:
16 _TSHD [SMTakpnu-._ts];ﬂs = 0z -
I —— o 4

Figure 5.18 Editor window

Or you use the method described below to set a breakpoint. Select Toggle Breakpoint from the pop-up menu or press the F9
key on the keyboard.
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3. When a software breakpoint is set, a red circle [®] is displayed at the corresponding position in the S/W Breakpoints
column of the Editor or the Disassembly window.

Elill=
Ling Sour...

E.. C) 5.{ Souce I
? 7|
g init (struct Sample *p_sam)
9 |Fa0ocs [ J
10 [F80cs p_sem-rs0 = 0O;
11 |F80D7 p sam-x31 = 0:
1z |FSOED p SEm-»SE = 0
13 |Fa1as & p:sam—>s3 = 0O;
14 |F811D p_sem=x3d = 0;
15 |[F8135 p_sem-r3Z = 0;
16 |Fa14D Imb-:ﬂ = 0: -
| | H

Figure 5.19 Editor window

Double-clicking one more time removes the breakpoint.

5.6.3 Enabling/Disabling Software Breakpoints
Follow one of the following methods to enable or disable software breakpoints.

- From the Editor or the Disassembly window
- From the Breakpoints dialog box
- From the command line

(1) From the Editor or the Disassembly window

1. Place the cursor at the line where a software breakpoint exists and then select Enable/Disable Breakpoint from the pop-up
menu. Or press the Ctrl and F9 keys together.

=101 x|

Line Sour.. | E.| C. 5. Source |
’ =
=] init (struct 3Jsmple *p =Sam)
9 |F30C2 i J
10 |Fs0OC5 p sswm->=0 = 0O;
11 |FsOoD7Y p_ssm->=1 = 0O;
12 |FSOED p_ssm->z2 = 0;
13 |FB105 & p_sam->=3 = 0;
14 |F311D p_sam->5%4 = 0;
15 |FE135 p_sam->35 = 0O; Bookmatks b
16 |[F514D p_sam-:s6 = 0; Templates L4
1 |
|  Epable/Disable Breakpoint Chrl+F3
Figure 5.20 Editor window and pop-up menu
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2. The software breakpoint is enabled or disabled alternately.

=0l x|

Line Sour.. | E.| C.| 5. Source |
’ =
=] init (struct Jample *p sSam)

9 |FE0CZ { J
10 |F30OC5 p_sam-»s0 = 0;
11 |F30D7Y p_sam-»s1 = 0;
12 |FSOED p_sam-»s3Z = 0;
13 |FE105 O p_sam-rs3 = 0;
14 |F311D p_saw-»s54 = 0;
15 |[F3135 p_saw-»s5 = 0;
16 |F314D p_saw-»s56 = 0; =
o | Wy

Figure 5.21 Editor window

(2) From the Breakpoints dialog box

1. Select Source Breakpoints from the Edit menu to bring up the Breakpoints dialog box. In this dialog box, you can alternately
enable or disable a currently set breakpoint, as well as remove it.

E
Ix

Breakpoinks

=
-

LOREE

Cancel

Edit Code

Bemove

Remowve Al

Figure 5.22 Breakpoints dialog box
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5.7 Using Events

5.7.1 Using Events

An event refers to a combination of phenomena that occur during program execution.

The E100 emulator permits you to use the event you have set as a condition of the break, trace or performance function.
Events can be set at up to 16 points at the same time.

These 16 points can be located at any desired positions.

The events you have created can be registered for reuse at a later time.

(1) Types of events

There are following types of events.

Table 5.9 Event types list

Instruction fetch An event is detected when an instruction at the specified address is executed by CPU.
An event is detected not in the cycles prefetched by an instruction queue but in the cycles
executed by the CPU.

Data access An event is detected when a specified address or specified address range is accessed
under a specified condition.

Interrupt Detection is made of an interrupt generation and interrupt termination.

Trigger input An event is detected when the signal fed in from external trigger signal input cable is in a

specified state.

(2) Event combination

One of the following combinatorial conditions can be specified using two or more events in combination.

Table 5.10 Event combinations list

OR Condition is met when any one of the specified events occurs.
AND (Accumulation) | Condition is met when all of the specified events occur irrespective of the time axis.
AND (Simultaneous) | Condition is met when all of the specified events occur at the same time.

Subroutine Condition is met when a specified event occurs within a specified address range.
Sequential Condition is met when a specified event occurs in a specified order.
. Condition is met when an event occurs under the condition specified in a state transition
State transitions .
diagram.
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5.7.2 Adding Events
Follow one of the following methods to add events.

- Create a new event
- Add by dragging and dropping from another window
- Add from the command line

(1) Creating a new event

[When creating an event from any setup dialog box]

1. Click the Add button or choose a line where you want to input and double-click.

Hardware Break

—Event:

Ewvent | T.I Descriptions | Co... | Ta... | Comment |

Add... Delete | Enatile | Disatle |

Figure 5.23 Hardware Break dialog box

2. The Event dialog box shown below will be displayed. In this dialog box, set detail event conditions and then click the OK
button.

x| x|
Condition |Count and Task ID | Comment | Conditian | Comment |
Event bype IInstruction Fetch ﬂ T Count(1-255)
—Condition settings l—
Address condition ISpeciFied walue (=) j
Tiask [0
start:[ o000+ G| End: [oooon 7] [ [ Tas
10 number: I Select,,, |
™ sSpecify a Function name I Othar valus
File: nare: I ﬂ BrOwse, .. |
Function name:; I j
Help | OK pe— Help ”TI pm—

Figure 5.24 Event dialog box

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 107 of 231
Sep.01.21



ROE521500MCUO00 User’s Manual

5. Debugging Functions

3. An event will be added at the specified position.

Hardware Break. OR |

Event:

E'vent T.I Descriptions Count | TaskID | Comment

F  [Address] _main

Figure 5.25 Hardware Break dialog box

4. If events exceed 16 points when you created an event, an error is displayed. If you created an event exceeding 16 points, the

event you have added has no effect.

[When adding an event from the Registered Events dialog box]

1. Click the Add button in the Registered Events dialog box.

M registeredbvents lojx]

Ervents

Tvpe I Descripticns I Courk ITaskID I Cammeank

1| | =

Cupdcate I Add... ] [relete | Celete &l |
| —
SAVE,,. I Load... | Help Cloze
g

Figure 5.26 Registered Events dialog box
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2. The Event dialog box shown below will be displayed. In this dialog box, set detail event conditions. Enter a comment if any
necessary. Then click the OK button.

eeent Elflecene e

Ctndtian | ount and Tak 10 | Comment | Eondkian | Count and Tack 1o Cement |
Evenkbype |Irstructicn fitch = Comment: | main function
—Condition settngs
Address condkan, |Speciied value (=) =]
F fdd | this et Ba e bt

T B | [ I | = |
™ Speciy a function name

Flhl'laml:l d |-'|"‘.'\-:"-"!...I

Function narne: | =

pep || e ] con pep [ e ] conca

Figure 5.27 Event dialog box

3. An event will be added to the list of registered events.

ioix
Events
Type | Descriptions | court | Taskip | comment
F [Address] _main - - main function
1] | =
Uupcat&l Add... I Ielete | Delete.ﬂlll
Save... | Load... | Help | Close |
E

Figure 5.28 Registered Events dialog box
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(2) Adding an event from the event column of the Editor window
[When adding a hardware breakpoint]

1. Select the HW Break Point from the pop-up menu displayed by double-clicking or right clicking anywhere in the event
column of the Editor window.
You can set a hardware breakpoint based on a fetch to that address as a condition. => Instruction fetch condition

Line Sour.. | E. C. 5. Source
14 wold main (wold)
15 |FBZDC {
16 F82DC u/ while (1)4
17 |FB2E0 cutorial (] ;

12 |FS2E: HW' Break Poink

19 |FE2ES Trace Fort

20

21 mold tutorial (void)

ZZ |FBZEG {

23 long a[10]

24 lorg 3:

25 int iz

ZE gtruct Sample far Tp o Sam:

| |

bt sorkLc w2 Tutorial.c l

Figure 5.29 Editor window

2. If there is room for event counts, the event you have added from the Editor window is added to the other events as an OR
condition. If there is no room, an error message is displayed.

CAUTION

If you are doing some editing work in the Hardware Break dialog box, you cannot set hardware breaks from the event column
of the Editor window.

Hardware Break QR l

—Ewent:
Event | Type | Descriptions | Counk | TasxID | Comment

FET - [addess]FezE0 - -

Figure 5.30 Hardware Break dialog box
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[When adding a trace point]

1. Select the Trace Point from the pop-up menu displayed by double-clicking or right clicking anywhere in the event column of
the Editor window.
You can set a trace point based on a fetch to that address as a condition. => Instruction fetch condition

Double-click the instruction fetch event in the Event column of the Editor window to delete it.

CAUTION
No trace points can be set from the event column of the Editor window in the following cases.

- While editing the contents in the Trace conditions dialog box

- When selecting the Fill until stop or Fill until full of the trace mode

(3) Adding events by dragging and dropping

[When dragging and dropping the variable and function names in the Editor window]

1. Dragging and dropping a variable name into the Event column, you can set an event based on an access to that variable as a
condition. => Data access condition
At this time, the size of the variable is automatically set to be a condition of a data access event.
Only global or static variables of 1 or 2 bytes in size can be registered as an event. Static variables in functions cannot be
registered as an event.

2. Dragging and dropping a function name into the Event column, you can set an event based on an instruction fetch to the start
address of that function as a condition.

Lne  Sou. | E] C] 5] Souce |
z e [ :
26 o
27 { Hardwere Bresk  OR |
£8 |Fa1BO
z3 long t: [ Ewenk:
30 int i, 4. k. [ Evert | 7..| Descriptions | Counk | Tastip | Camme
31 F [address] $sort - -
32 |F81E& o = [Address] Q0BDC [Size] WORD.., -
33 |F31ES while| gap > 0 ){
a4 Falcz for | k=0; kg
3k |Fa1icF for( di=k+g

Figure 5.31 Editor window and Hardware Break dialog box

[When dragging and dropping the address range in the Memory window]

Select memory content in the Memory window and drag and drop it into the Event column. That way, you can set a data access
event based on the address range of the selected memory content as a condition. => Data access condition

[When dragging and dropping the label in the Label window]

You can set an event based on a fetch to that label as a condition. => Instruction fetch condition
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5.7.3 Removing Events
Follow one of the following methods to remove events.

[When deleting an event from any setting dialog box]

1. To remove one point, select a line you want to remove in the event setting area and then click the Delete button (You can
use the keys Ctrl + Del instead of clicking the Delete button).
The selected event will be removed from the event setting area.

Hardware Break  ©R |

—Event:

Event | T.I Descripkions | Cu:uuntl TaskID | Carmnrmenkt I
[Address] _start

[Address] _initsck
F [Address] _exit - -

add. .. ' Delete | Enable | Disable |

Figure 5.32 Hardware Break dialog box

2. To remove multiple events, hold down the Shift or the Ctrl key while you select lines you want to remove in the event
setting area and then click the Delete button (You can use the keys Ctrl + Del instead of clicking the Delete button).
The selected events will be removed from the event setting area.

Hardware Break OR |

—Event:

Event T.J Descripkions Counk | TaskID | Comment

add. .. I Delete | Enable | Disable |

Figure 5.33 Hardware Break dialog box
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[When deleting an event from the Registered Events dialog box]

To remove one point, select a line you want to remove in the Registered Events dialog box and then click the Delete button
(You can use the keys Ctrl + Del instead of clicking the Delete button).

The selected event will be removed from the list of registered events.

To delete all events, click the Delete All button.

i Registered Events * =10 x|
Ewvents
Tvpe | Descripkions | _ount | TaskID | Carment |
Address] skark
F [Address] _ini... - -
F [Address] _exit - -
F [Address] _main - -
Duplicate | Add... r Delete | Delete Al |
Save, ., | Load... | Help Close
P
Figure 5.34 Registered Events dialog box
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5.7.4 Registering Events

“Registering an event” refers to placing an event into the list of registered events. A registered event can be reused at a later
time. Follow one of the following methods to register an event. Up to 256 events can be registered.

(1) Registering events

[When creating an event from the Event dialog box]

1. Display the Comments page of the Event dialog box and select the “Add this event to the list” check box. Then click the
OK button.

x

Canditianl Count and Task ID  Commenk |

Comment: | BreakPoint

[+ iadd this event ko the list;

Help | Ok I Zancel

Figure 5.35 Event dialog box

2. Aneventis added at the specified position while at the same time registered in the Registered Events.

Hardware Break ©OR | i Registered Events * =]
Event: Events
T ] ipki Count | TaskiD | © 18
Ewvent | T.I Descriptions | Counk | TaskID | Comrnenk 42 I BT Ione I CL I i I Dmmenl I
= - F [Address] 00000 - - BreakPoink
S F  [Address] 00000 - - EreakPoint

Figure 5.36 Hardware Break dialog box and Registered Events dialog box
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[When registering an event by dragging and dropping]

The event you have created can be registered in the Registered Events by dragging and dropping it into the list.

Hardware Break ©OR | i Registered Events * =10l x|
Event: Events
T [ i} Counk | TaskID | < 19
Event | T.I Cescriptions | Counk | TaskID | Cormrnenk 42 I BT Ione I CL I i I Dmmenl I
F [Address] 00000 - - BreakPoint
F  [Address] 00000 - - BreakPoint

Figure 5.37 Hardware Break dialog box and Registered Events dialog box

[When registering an event from the Registered Events dialog box]

Click the Add button to create an event. The events you create here are added to the Registered Events.

M regsteredbvents loix]
Events
Tvpe I Daescriptions I Counk ITEHD I Caommenk
1] | =
;Jupcat-':l add... ] [relete | L,-alr;l.'r;.f-ll|
H
Save,.. I Load... | Help Close
g

Figure 5.38 Registered Events dialog box

(2) Attaching comments

Attach a comment to the registered event as necessary. Check the Registered Events dialog box to know the registered contents
and comments.
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5.7.5 Entering Events Each Time or Reusing Events

There are following two methods to set events in any function concerned.

One method is to create events in the respective setting dialog boxes each time.

The other method is to choose one condition you want to use from the registered event list and drag and drop it into the
condition area in which you want to set the event.

The former method is referred to here as entering events each time, and the latter as reusing events.

[Entering events each time]

This is the condition used only once. The event you created is used “without ever being registered.”
After the event is used (i.e., changed or removed), its setting becomes nonexistent.
The events you create by only double-clicking in the Event column of the Editor window are the one that is entered each time.

[Reusing events]

Any event registered in the Registered Events dialog box can be reused by dragging and dropping it into the condition setting
area of any function concerned.

Hardware Break OR | i Reqgistered Events * =10 x|
Event: Events
T [ i} Counk | TaskID | © 19
Event | T.I Cescriptions | Counk | TaskID | Cammenk B2 I 2L I S I = I Dmmenl I
F [Address] 00000 - - BreakPoint
F  [Address] 00000 - - BreakPoint

Figure 5.39 Schematic of event reuse

(1) Dragging and dropping into multiple functions

One event in the Registered Events can be dragged and dropped into multiple functions.
If the content of an event is altered after being dragged and dropped, the alteration you made is not reflected on the registered
event list side.

(2) Registering duplicates in the registered event list

Even the events that have the same contents set can be registered in the list overlapping one another.
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5.7.6  Applying Events

To enable the setting of an event after you have created it, click the Apply button. The content of what you have set has no
effect until you click the Apply button.

[*] after the title on the title bar of the dialog boxes of Hardware break, Trace conditions or Performance Analysis Conditions
shows that some setting is under editing. If you are doing some editing work, you cannot change the settings from the event
column of the Editor window or the command line.

1ol

Hardware Break ©F I

rEvenk:
Evert | T..| Descrintions | count | Taskib | comment |
Ewdl F [Address] _main = rivain Function

Add... I Delets | Enabls ] Dissble |

Evert used 1 Free 15 Detail Re-g'rsbaradervmts...l
save... | Losd.. ‘ Hele rnpplg.r Close
= g

Figure 5.40 Applying the setting
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5.8 Setting Hardware Break Conditions

5.8.1 Setting Hardware Break Conditions
A hardware break causes the user program to stop running a specified number of cycles after a set event or phenomenon is
detected (i.e., a hardware breakpoint is encountered). Up to 16 events can be specified as hardware breakpoint conditions.

5.8.2  Setting Hardware Breakpoints
(1) Setting Hardware Breakpoints

For hardware breakpoints, you can set an OR condition, other condition (AND (Accumulation), AND (Simultaneous),
subroutine, sequential or state transition) and detection of exceptional events.
The OR condition, other condition and the detection of exceptional events can be set all at the same time, or only one at a time.

Program execution

\

OR condition | ->

Other conditions
AND (Accumulation)

AND (Simultaneous) | -> Hardware Breakpoint is met
Subroutine

Sequential
State transitions

| Exceptional events | ->
2 } Delay value
Break
Figure 5.41 Outline of the hardware break
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(2) Setting OR conditions

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

To disable the OR condition, deselect the check box to the left of “OR Condition.”

If you add an event by double-clicking in the Editor window while the OR condition is disabled, the OR condition is
automatically enabled.

If you reenable the OR condition when it is disabled, the previously set event is restored with its OR condition check box
selected.

However, if a maximum of 16 events is exceeded when you have reenabled for an event, the event is restored with its OR
condition check box unselected (disabled).

 Hardware Break  on |

condition and combination setking
v OF condition:

Evertinuse: 0  Detail |

I other conditions:

I.ﬁ.ND{.ﬁ.ccumulatiDn} j

Event inuse : 0 [retail |

o Exception:

Total ; O Ewent

: Celawicyele):
Exceptional P [ [ '
events De_talll ’7| ]
Figure 5.42 Hardware Break dialog box
Table 5.11 OR condition
Type Description

1 | OR condition Breakpoint is encountered when any one of the set events occurs.
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(3) Setting other conditions

You can select one of five choices available: AND (Accumulation), AND (Simultaneous), Subroutine, Sequential and State
Transition. To set any condition, select the check box to the left of “Other Conditions.” By default, other conditions are
disabled (the check box to the left of “Other Conditions” is unselected).

Hardware Bresk |OR I AND{Accumulation) I

condition and combination setking
—Iv OR condition:

Evertinuse: 0  Detai |

IAND(.ﬁ.ccumuIatinn} j

Event inuse : 0 Dretail |

o Exception:

Exceptional Detai | ___________ '
events

Toktal : O Event
"Delay{cycle}: —

)

Figure 5.43 Hardware Break dialog box

Table 5.12 Other conditions

Type Description

1 | AND (Accumulation) Breakpoint is encountered when all of the set events occur irrespective of the time axis.

AND (Simultaneous) Breakpoint is encountered when all of the set events occur at the same time.

3 | Subroutine Breakpoint is encountered when a specified event occurs within a specified address range
(Subroutine, function).

4 | Sequential 6 steps (forward direction) + reset point
Breakpoint is encountered when a set event occurs in a specified order.

5 | State transitions 3 steps, 9 paths + reset point

Breakpoint is encountered when a set event occurs in a specified order.

CAUTION

When a time-out condition is set in State transitions (Hardware break point) dialog box, the time to make transition from a set
state to another then back to the original set state must be 10 ps or more. Transition time of less than 10 ps will result in an
incorrect timeout detection.

The events shown in the list of each condition can be deleted by the keys Ctrl + Del.
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(4) Detection of exceptional events
Specify whether you want detection of following exceptional events to be used as a breakpoint.

- Violation of access protection

- Read from uninitialized memory
- Stack access violation

- Performance overflow

- Realtime profile overflow

- Trace memory overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

The program breaks a specified number of cycles after a breakpoint is encountered. A breakpoint delay value can be set in the
range from 0 to 65,535 bus cycles (default = 0).

5.8.3 Saving/Loading the Set Contents of Hardware Breaks

(1) Saving hardware break settings

Click the Save button of the Hardware Break dialog box. The Save dialog box will be displayed.
Specify a file name to which you want break settings to be saved. The file name extension is .hev. If omitted, the
extension .hev is automatically attached.

(2) Loading the set contents of hardware breaks

Click the Load button of the Hardware Break dialog box. The Load dialog box will be displayed. Specify the file name you
want to load.

When you load a file, the hardware break settings you had before you have loaded the file are discarded and the hardware
breaks are reset with the loaded settings.

Click the Apply button of the Hardware Break dialog box to confirm the hardware break settings you have loaded.
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5.9 Looking at Trace Information

5.9.1 Looking at Trace Information

A trace is the function to acquire bus information every cycle and store it in trace memory during user program execution.
Using a trace you can track the flow of application execution or examine the points at which problems occurred.

The E100 emulator allows you to acquire up to 4M bus cycles.

When program execution stops (for an exception break, forced halt or breakpoint), the contents stored in trace memory at the
time the program has stopped are displayed as the trace result even when no trace points are encountered yet.

5.9.2  Acquiring Trace Information

The E100 emulator operates in such a way that when no trace information acquisition conditions are set, it by default traces all
bus cycles to get trace information unconditionally. (Trace mode = Fill until stop)

In free mode, at the same time the user program starts running the emulator starts tracing bus cycles to get trace information,
and when the user program stops the emulator stops tracing.

The acquired trace information is displayed in the Trace window.

[Teace U E|
mVE vazrz (R F4dr Faaa

|Fargs: -canor15, coootoco e Koyck: 00000016 Addrass: DFFFES. [Tme: 00:00:00,001.650.710 |

Cyole Label | Addres=s Dats BUS BHE EI0 B/W BWD CPO 0N BUSACH Debug EV | BL FLOOVLAE TimsSt=mp [h:im:=.m=.us=.n=)|=|
-00000016 OFFPBE --00 166 1 B B 1 - 2 1 1 0O0ACO0000000000 -- - 00:00:00.001, 650,710
-00000015 OFFFEE --02 1661 DB R 0O - 2 1 1 000Q000000000000 - - 00:00:00.001. 650,760
-00000014 OFFFEE --02 1661 - - 1 - 2 1 1 0000000000000000 -- - 00:00:00.001. 650,810
-00000013 OpFFES —-02 1801 - - 1 - 2 1 i 0O00000000000000 —— - 00:00:00,001, 650,880
-0ooooo12 OFFFES --02 16b 1 = = 1 = 201 1 Qooooooooe0oQoon - - 00:00:00,001, 650,910
-000o0011 OFFFESE --02 16k 1 - - 1 - & 1 i 0O00000000000000 - - 0020000001, 650, 360
-00000010 OFFFE6 --02 160 1 - - 1 - % 1 1 0000000002000000 -—— - 00:00:00,001, 651,040
-000on0na OFFPEE --02 161 - - 1 - % 1 1 Do0onooooooonoon -- - 00:00:00.001. 651,060
-00000003 oFFPES --D2 161 - - 1 - % 1 1 0000000000000000 - - 00:00:00.001. 651, 110
=00000007 OFFFEE ==02 16b 1 = = 1 = % 1 1 000000000000000D == = DD:00:00.001. 651, 160
=00000006 OFFFESE ==02 16b 1 = = 1 = 2 1 1 0000000000000000 == = 00:00:00.001. 651,210
=00000005 OFFFEE ==0Z 16b 1 = = 1 = 2 1 1 0000000000000000 == = 00:00:00.001. 651,260
-00000004 OFFPEE ~--02 161 - =- 1 = 2 1 0 000a000000000000 -- - 00:00:00.001.651.310
-00000003 Oopo4s  OFES 16k 0 W oW1 - 2 1 i DO0Q00O000R000000 -- - 00:00:00.001, 651,280
-00000002 QOpo4s OF8S 166 0 W W 0O - 2 1 0 0000000000000000 - - 00:00:00,001, 651,410
-00000001 Oopo44 8353 16k 0 W oW 1 - 2 1 0 0000000000000000 -- - 00:00:00.001. 651,460

[ululauluIuTela] QOpo44 8353 1600 W oW 0O - 2 1 0 DOO00OO0000000000 —— - 00:00:00.001.651, 510 Ej

Figure 5.44 Trace window
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The following items of information are displayed. (This applies for bus display.)

Table 5.13 Display items

Column Description

Cycle Cycle numbers stored in trace memory. The last cycle acquired is numbered O, and the older cycles are assigned smaller
numbers -1, -2, etc. sequentially retracing the past. If a delay count is set, the cycle in which a trace stop condition is met is
numbered 0 and the cycles that were executed until the condition is met (cycles during a delay period) are assigned larger
numbers +1, +2, etc. sequentially toward the last cycle acquired.

Label Labels corresponding to addresses (displayed only when labels are set).
Address Addresses of the address bus.
Data Data of the data bus. Displayed in hexadecimal.
BUS Shows the data bus width, indicated as “8b” when the bus is 8 bits wide or “16b” when 16 bits wide.
BHE Shows the state (0 or 1) of BHE (Byte High Enable) signal. When this signal is ‘0,” it means that an odd address is being
accessed.
BIU Shows the state between the BIU (Bus Interface Unit) and the memory and 1/0.
- No change
DMA Data access such as DMA and DTC, etc. requested from other than the CPU
INT INTACK sequence start
IB Instruction code read (in bytes) requested from the CPU
DB Data access (in bytes) requested from the CPU
W Instruction code read (in words) requested from the CPU
DW Data access (in words) requested from the CPU
R/W Shows the data bus state, indicated as “R” when in a read state, “W” when in a write state or “— when no accesses made.
RWT The signal indicating the valid position of bus cycle. When valid, this signal is ‘0.” The Address, Data and BIU lines are
valid when this signal is ‘0.’
CPU Shows the state between the CPU and the BIU (Bus Interface Unit).
- No change
CB Op-code read (in bytes)
RB Operand read (in bytes)
QC Instruction queue buffer clear
CwW Op-code read (in words)
RW Operand read (in words)
QN Shows the number of bytes stored in the instruction queue buffer. Displayed in the range from 0 to 4.

[CAUTION] When stopping the user program by using software break, QN (the number of bytes stored in the instruction
queue buffer) from the next cycle after an occurrence of software break is not displayed correctly.

BUSACC When memory access is performed by a debugger operation during user program execution, shows “0” while the emulator is
occupying the MCU bus.
[CAUTION] Execution of the user program is temporarily stopped during such access to memory.

Debug When memory access is performed by a debugger operation during user program execution, shows “0” while the emulator is
occupying the MCU bus.
[CAUTION] Execution of the user program is temporarily stopped during such access to memory.

EV The event No. when a set event occurred.
To show EV column, you need to select the EV number on the Option page of the Trace conditions dialog box
displayed from the menu of the Trace window.

TID Task ID (when RTOS is used).

Example display: A task ID (task entry label) is displayed like 1 (_Task1).

To show Task ID column, you need to select the Task ID on the Option page of the Trace conditions dialog box
displayed from the menu of the Trace window.
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EXT Shows the signal fed in from the external trigger cable, indicated as “1” when the signal is high or “0” when the signal is low.
To show EXT column, you need to select the External trigger on the Option page of the Trace conditions dialog
box displayed from the menu of the Trace window.

ELC Shows the module number of the linked module destination in event link.
[CAUTION] “--” is displayed with M16C/64 Group, M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x
Series MCUs.

ELCOVLAP | Shows if there is an overlap in event link.
[CAUTION] “-” is displayed with M16C/64 Group, M16C/64A Group, M16C/65 Group, M16C/50 Series and R8C/3x
Series MCUs.

TimeStamp | Shows an elapsed time since the target program started.
Each time the user program starts running, the timestamp starts counting from 0.
[CAUTION] When the counter overflows, the time is not displayed correctly.

The unnecessary columns in the Trace window can be hidden. To hide a column, right-click in the header column and select
the column you want to hide from the pop-up menu.

5.9.3 Setting Trace Information Acquisition Conditions

The trace buffer is limited in size, so that when the buffer is filled, the old trace data is overwritten with new data sequentially
beginning with the oldest.

Setting trace information acquisition conditions, you can acquire only the useful trace information, making effective use of the
trace buffer.

To set trace information acquisition conditions, use the Trace conditions dialog box that is displayed when you choose
Acquisition from the pop-up menu of the Trace window.

(1) Setting trace modes
First, select a trace mode.

Trace | Opkion |

ek

Trace Maode: Y " Fill unkil skop j

condition an ill unkil skop

Y OR oMy B Fil until Ful
Event in s B
i m—"l calrr Fill around TP
- Gther o oo TR
T f r T Repeat fill until stop
AR Aoy T R
ot et bt Repeat fill urtil Ful
Eventinusg o ooan ||

Figure 5.45 Trace conditions dialog box

(2) Setting trace points

If you selected Fill around TP, Repeat fill until stop or Repeat fill until full for the trace mode, set a trace point.
For trace points, you can set event based on conditions and exceptional events.
For Fill around TP, furthermore, you can set a delay value.
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(3) Setting Capture/Do not Capture

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture/Do not Capture conditions
in the Record condition group box.

Record condikion:

oAl fgCapturej " Do nok capture ¥ | step executionis recorded

I WEVL_Ev]_ Bebween bwo events j Detai |

Eventinuse ; O

Figure 5.46 Record condition group box

You can choose to extract only the necessary portions of trace information specified by events or delete the unnecessary
portions.
(4) Recording step execution

If the selected trace mode is Fill until stop, you can record step execution. To record step execution, select the Step execution
is recorded check box in the Record condition group box.

~Record condition:
* @l  Capture { Donot capture ¥ Step execution is recorded

Evenktinusa: 0

Figure 5.47 Recording step execution

The recordable modes of step execution are Step In, Step Over and Step Out.

(5) Setting trace acquisition methods

Use the Options page of the Trace conditions dialog box to set the acquisition method associated with the entire trace. By
default, External Trigger is selected for trace acquisition.
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5.9.4 Setting Trace Modes
(1) Setting trace modes

Following five trace modes are available.

Table 5.14 Trace modes

Stop mode Description
1 | Fill until stop Trace acquisition continues until the program stops running.
Fill until full Trace acquisition stops when the trace memory is filled.
3 | Fillaround TP Trace acquisition stops a specified number of cycles after a

trace point is encountered. A delay value can be specified in
a range of up to the maximum value of trace capacity.

4 | Repeat fill until stop Each time a trace point is encountered, acquisition is made
for a total of 512 cycles* before and after that point, and
acquisition continues that way until the program stops
running.

5 | Repeat fill until full Each time a trace point is encountered, acquisition is made
for a total of 512 cycles” before and after that point, and
acquisition continues that way until the trace memory is
filled.

CAUTION
Recording is made in units of total 512 cycles, consisting of 1 cycle at the line where a trace point is met and 255 cycles before
that point and 256 cycles after that point.

Execution start

trace pointis
encountered

trace pointis
encountered

trace point is
encaountered

\/

Execution stop

Figure 5.48 Differences between the trace modes

Specifiable conditions vary depending on trace mode, as summarized in the table below.
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1. Fill until stop
The trace memory can hold up to 4M bus cycles. When the buffer is filled, the oldest data of the acquired trace information
is overwritten with new data. That way, the emulator continues acquiring trace information.

Table 5.15 Specifiable conditions: Fill until stop

Trace point setting

Delay specification

Capture/Do not Capture
condition setting

Step execution recording

Possible

Possible

2. Fill until full
When the trace memory of the emulator main unit overflows during trace acquisition, the emulator stops acquiring trace
information.

Table 5.16 Specifiable conditions: Fill until full

Trace point setting Delay specification | Capture/Do not Capture

condition setting

Step execution recording

Possible -

3. Fill around TP
Trace acquisition is halted a specified number of cycles delayed after a trace point is encountered. In this mode, the user
program continues running and only trace acquisition is halted. Sophisticated conditions can be set using a maximum of 16
event points. A delay value can be chosen to be 0, 1M, 2M, 3M or 4M cycles.

Table 5.17 Specifiable conditions: Fill around TP

Trace point setting Delay specification | Capture/Do not Capture

condition setting

Step execution recording

Possible Possible Possible -

4. Repeat fill until stop
Each time a trace point is encountered, a total of 512 cycles before and after that point are acquired, and acquisition
continues that way. Acquisition continues until it is halted by a break or forced stop. The positions where trace points are
encountered can be checked in the Trace window.

Table 5.18 Specifiable conditions: Repeat fill until stop

Trace point setting

Delay specification

Capture/Do not Capture
condition setting

Step execution recording

Possible
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5. Repeat fill until full
Each time a trace point is encountered, a total of 512 cycles before and after that point are acquired, and acquisition
continues that way. When the trace memory overflows, acquisition is halted. The positions where trace points are
encountered can be checked in the Trace window.

Table 5.19 Specifiable conditions: Repeat fill until full

Trace point setting Delay specification | Capture/Do not Capture | Step execution recording
condition setting

Possible - - -

CAUTION
If trace points are encountered in consecutive cycles in the repeat fill until stop or repeat fill until full mode, only one first
cycle is highlighted in yellow as a trace point.

5.9.5 Setting Trace Points
(1) Setting trace points

For trace points, you can set an OR condition, other condition (AND (Accumulation), AND (Simultaneous), subroutine,
sequential or state transition) and detection of exceptional events.
The OR condition, other condition and the detection of exceptional events can be set all at the same time, or only one at a time.

Trace acquisition

\

OR condition | ->

Other conditions
AND (Accumulation)

AND (Simultaneous) | -> Trace point encountered
Subroutine

Sequential
State transitions

Exceptional events ->

2 } Delay value
Trace acquisition halted
Figure 5.49 Outline of the trace point
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(2) OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

If you reenable the OR condition when it is disabled, the previously set event is restored with its OR condition check box
selected. However, if a maximum of 16 points is exceeded when you have reenabled for an event, the event is restored with its
OR condition check box unselected (disabled).

Trace |oR | Option |

i :le'ull dalry | Fill around TP j

condition and combination setking
v OR condition:

Evert imuse: 0  Detai |

1 Other conditions:

Trace Maode:

IAND{P.I:l:umulatiI:un} j

Eventinuse: 0 et | 0

Taokal : 0 Ewent
"Delay{cycle}: —

1 Exception:
Exceptional Dietal | ........... '
events

—FRecord condition:
@ al © Capture € Do nok capkure [ Step execution is recorded;

o] i

IEIM "I

Eventinuse : O

Figure 5.50 Trace conditions dialog box

Table 5.20 OR condition

Type Description
1 | OR condition Trace point is encountered when any one of the set events occurs.
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(3) Other conditions

You can select one of five choices available: AND (Accumulation), AND (Simultaneous), Subroutine, Sequential and State

Transition. To set any condition, select the check box to the left of “Other Conditions.”

By default, other conditions are disabled (the check box to the left of “Other Conditions” is unselected).

HOR I SO Accurnulakion) I Opti-:nnl

Trace Maode:

- .P
Ll de'-wll e |y

condition and combination setking

¥ OR condition:

| Fill around TP j

Evert imuse: 0  Detai |

¥ Other conditions:

IAND{P.I:l:umulatiI:un} j

Eventinuse: 0  Detai |

- Exception:
Exceptional

[etai |
evenks

Tokal : 0 Ewent
"Delay{cycle}: —

|4M -|

—Record conditian:

o all ¢ Capture © Do not capkure

[~ sStep execution is recarded

Eventinuse : 0

=N

Figure 5.51 Trace conditions dialog box

Table 5.21 Other conditions

Type

Description

1 | AND (Accumulation)

Trace point is encountered when all of the set events occur irrespective of the time axis.

AND (Simultaneous)

Trace point is encountered when all of the set events occur at the same time.

3 Subroutine

Trace point is encountered when a specified event occurs within a specified address range
(subroutine or function).

4 | Sequential

6 steps (forward direction) + reset point
Trace point is encountered when a set event occurs in a specified order.

5 | State transitions

3 steps, 9 paths + reset point
Trace point is encountered when a set event occurs in a specified order.

CAUTION

When a time-out condition is set in State transitions (Trace) dialog box, the time to make transition from a set state to another
then back to the original set state must be 10 ps or more. Transition time of less than 10 ps will result in an incorrect timeout

detection.
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(4) Detection of exceptional events
Specify whether you want detection of following exceptional events to be used as a trace point.

- Violation of access protection

- Read from uninitialized memory
- Stack access violation

- Performance overflow

- Realtime profile overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

The program breaks a specified number of cycles delayed after a trace point is encountered.

A trace-point delay value can be selected from 0 M, 1M, 2M, 3M or 4M bus cycles (default: 0OM).

Select your desired delay value in the delay value setting column.

Delayicycle):

Figure 5.52 Trace conditions dialog box
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5.9.6  Setting Capture/Do not Capture Conditions

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture/Do not Capture conditions.
You can choose to extract only the necessary portions of trace information specified by events or delete the unnecessary

portions.

(1) Capture/Do not Capture conditions

There are following types of conditions.

Table 5.22 Capture/Do not Capture conditions

Type Description
Extraction BB Ev]_ Between two events Cycles extracted begin when a start event occurs and end
with the next to last end event occurs (the cycle where an
end event occurs is not extracted).
N PR =Y I Duration of an event Only cycles where a specified event occurred are extracted.
S Duration of an event Only cycles where a specified event occurred in a specified
occurring in a subroutine | address range (subroutine or function) are extracted.
net Instruction accessing Instructions that accessed specified data are detected.
specific data
Deletion BV WEv]_ Between two events Cycles extracted begin when a start event occurs and end
with the next to last end event occurs (the cycle where an
end event occurs is not extracted).
N PR =T Duration of an event Only cycles where a specified event occurred are deleted.
A Duration of an event Only cycles where a specified event occurred in a specified
occurring in a subroutine | address range (subroutine or function) are deleted.

Select the conditions you want to set from the list box that is displayed when you select Extract or Delete in the Record

condition group box of the Trace conditions dialog box.

Record condikion:

¥ | step executionis recorded

I WEVL_Ev]_ Bebween bwo events

Eventinuse ; O

| et |

Figure 5.53 Record condition group box

Then click the Detail button. A page in which you can set events will be displayed.
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CAUTION
When you specify extraction or deletion conditions, you cannot select DIS (disassemble display) and SRC (source display)

from Display Modes in the Trace window.
When you use a data access event for extraction or deletion, be sure to specify the MCU bus for the access type.

x

Condition |Cn:n_|nt and Task ID I Cammenkt I

Event bype IData ACCESS j
— Condition settings

—Access bype
" Mremonic level  |WORD j
&+ MCU bus:
[¥] cru
[¢] o1
A Address condition ISpemﬁed value (=) =l
Skart: I I E End: I I E
1 Data condition ISpeuFled walue (=) J
Yaluel: I Yaluez: I
Mask,
(I' Enabled Masking walue: I FFFF

Read/write IRead,l'Write j

Help | O I Cancel

Figure 5.54 Event dialog box
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5.9.7 Selecting the Content of Trace Acquisition
Select the content of trace information you want to be captured into trace memory. Use the Options page of the Trace
conditions dialog box to make this selection.

i Trace conditions * ;IE'EI

Trace |

Selecting the byvpe of trace information

{* Event number
" TaskID

€ External trigger

Event used 0 Free 16 Detail...l Registered events...l
Save,.. | Load... | Help | apply I Close I

4

Figure 5.55 Trace conditions dialog box

Select the signal you wish to acquire from three choices available: Event Number, Task ID or External trigger. By default, the
Event number is selected.

CAUTION
If you want a history of trace execution to be displayed in trace acquisitions carried out by running a realtime OS program, be

sure to select Task ID.
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5.9.8 Showing Trace Results

To check trace results, look at the Trace window. Trace results can be shown in one of the following display modes.
These display modes can be switched using Display Modes on the pop-up menu of the Trace window.

There are five trace result display modes: Bus Display, Disassembled Display, Source Display and Mixed Display.

(1) Bus Display Mode
From the pop-up menu, select Display Modes -> BUS. Bus information on each cycle traced are displayed. (Default display
mode)

Teace L L E|

mVE vsazz @ Ed4dr o aaa

|Fiare: -00007515, conanoon s (Cyck: 00000016 |Address: OFFFES [Time: 00:00:00,001 650,710 |

Cyole Label | Address Dabd BUS BHE BEIO R/W BWE CPO QN BUSACE Debug EV | ELe ELCOVLAE Tim=Stamp (him:s.m=.us.nos)| =]
-00000016 OFFFEE ~--00 16b 1 DB R 1 ~- 2 1 1 0000000000000000 -- - 00:00:00.001.650.710
-00000015 OFFFEE --02 1681 DB R O - 2 1 1 0O00B0000B000000 -~ - 00:00:00.001. 650,760
00000014 OFFFES --02 16b 1 - - 1 - 21 1 Qoooooo0oe0o0oon -- - 00:00:00.001., 650,810
-00000013 OFFFEE --02 16b 1 - - 1 - & 1 1 Qooooooooooagoon - - 00:00:00.001., 650, 860
—-0ooooo12 OFFFES --02 16k 1 = = 1 = 201 1 Qooooooooe0oQoon - - 00: 0000001, 650,910
-00o0ono11 OFFFEE --02 16b 1 - - 1 - 201 1 QoooonoooooQoon -- - O0:00:00,001, 650, 960
-0ooonoin OrFeFES --02 1fb 1 = = 1 = 21 1 aoooonoooononoon -- - O0:00:00,.001, 651,010
-00oonoos OrerES  --02 16b 1 - - 1 - 21 1 noooonoooononoon -- - O0:00:00.001, 651, 060
~0nannona OrgreEs --02 I6b 1 - - 1 S S| 1 nonaononopnonoon -- - - O0:00:00.008. 651, 110
-00000007 OFFPEE =--0% %6b 1 = = 1 = % 1 1 DO0ODO0000000000 == - 00:00:00.00%. 651, 160
~00000006 OFFPEE =-0% 16b 1 = = 1 = z 1 1 DO00DO00000000000 == = DO0:00:00.001.651.210
~-00000005 OFFPEE ~--0% 16b 1 - =~ 1 = 2z 1 1 0000000000000000 == = 00:00:00.001.651.260
-00000004 OFFFEE --02 161 - - 1 - 2z 1 i} 0o00Booao0o00a0n -~ - 00:00:00.001.651.310
-00o00003 gooo4e  OFES Leb 0 o W 1 = 201 [ Qoogooooooooooog -- - 00:00:00.001. 651,360
—-00o00o002 00pO04s  OFES 1eb 0 oW 0 = 201 [ Qoooooo00e000o0n - - 00:00:00.001. 651,410
—-0ooooo01 O0pO44 3353 16k 0 oW W 1 - 201 0 Qooooooooe0ogoon -- - 00:00:00,.001, 651, 460
00o00no0o OOpO44 2353 160 W W O - I 1 0 Qoodoooooooagoon - - 00:00:00.001. 651, 510 j

Figure 5.56 Trace window

(2) Disassembled Display Mode
From the pop-up menu, choose Display Modes -> DIS. This display mode allows you to inspect the machine language
instructions executed.

race F
wvpg FARX @ Fdr E Qa6

[Fargs: -cano715, coootoco Fle: oyck: 00000038 Address: OFEEEL [Tme: 00:00:00,001.650,100 |

Cycle | Label | Addres== Cbiect Code | Im=truction | TimeStamp (hrimi=.m=.us=.n=) |=]
=0000008 e OFBZEL TPEBFCOROD CHP B 3 #OO0AH, -4H[FE] 00:00:00.001.e50.100
-00000082 OF82EE Thcazl JGE FEZDAH 00:00:00.001. 650,300
-00000080 0F8289 75c00900 Mo 00098, RO 00:00:00.001. 650. 400
-00000076 OFg2en ASBOFC FUB.WiG  —4H[FE],RD 00:00:00,001. 650,600
-00000073 OFgzco EZ10 SHL . W #IH. RO 00:00:00,001. 630,750
-00000070 orgzcl EEABD4 MOVA -ICH[FB], A0 00:00:00,001. £50.900
-00000063 OFgZcS A104 ADD.WEG  RO,AD 00:00:00,001.651.000
-00000066 orgzcT T3IBSFC MoV.W: G —4H[FE],Al 00:00:00,001.651. 100
-00000063 OFBZCA ESLS SHL.W HIH AL 00:00:00.001.651.250
=000000&0 OFBZCC ALBSFE ADD. W G =ZH[PE], Al 00:00:00.001.651.400
=00000057 OFRZCE TIET O B 5 [A0], [A1] O0:00:00.001.651.550
=00000054 OFEZDL TIE90Z0Z OV . Bz 5 CZH[AD],DZH[AL] 00:00:00.001.651.700
=00aooosag OF8ZDS CS1BFC EOD. W 0 #1H, -4H[FB] 00:00:00.001.651.950
-00000045 OF8208 FED4 JHE.E FEZE1H 00:00:00.001.652.150
-00000040 OFg2B1 TTEEFCORO0 CMP.Wi G FO00AH, -4H[FE] 00:00:00,001.652.400
-0000003 6 OF82B6 oAzl TIGE FEZDAH 00:00:00.001.652. 600
-00000032 OF82Da e EXITD 00:00:00,001.652.800 j

Figure 5.57 Trace window
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(3) Source Display Mode

From the pop-up menu, choose Display Modes -> SRC. This display mode allows you to inspect the source program’s
execution path.

The execution path can be verified by stepping through the source within trace data forward or backward from the current trace
cycle.

race A
mVep FAZZT E Edr F aca

|name: -00007S15, 00000000 Fie: sort.c |Cyde: 00000066 Address: OFBZED Tine: 00:00:00,001,650.100 |

Lin= Addres= | Mow Source |i|

oaoEs OFE1EE = g_IntBuf = §;

000038 OFE1F: = iffalj]l=aljtgapl)i

0a0o0za OFpg214 = t = alql:
|
|

Qooo4n ODEE2E3 = ali] = aljtgspl;

000041 OFg23c ] -

Qoooaz |

nooogz | elae

nooogs | | break;

nooo4s 1

000046 }

oo0o47 1

0ooo4s OFEZEL = gap = gapifi;

oooo4g OFE2ED = '

Da0os0n OEE270 | = g_(‘.‘:'m::BuE = [l:l:wu::lg_Inl:-luf & 0x00FF;

000051 OFE2TD =
I
|

000052 |
000053 change ( Long “al =l

Figure 5.58 Source Display screen

(4) Mixed Display Mode

This display mode provides a mixed display of bus, disassemble or source display.

After choosing Display Modes -> BUS from the pop-up menu, select Display Modes -> DIS. That way, you can produce a bus
and disassemble mixed display.

In the same way, you can produce a bus and source, a disassemble and source or a bus, disassemble and source mixed display.
To revert to a bus only display after viewing a bus and disassemble mixed display, choose Display Modes —> DIS from the
pop-up menu again.

|
mwveSazxzshEEd) a0
Range: -00007515, 00000000 [File: [Cycle: 00000105 [Address: OFSZD0 [Time: 00:00:00.001 643,150 |
cycle | zabel | Address Dpatd BUS BHE BIU R/W EWD cPU oN BUSACC Debug EV | ELC ELCOVLAE TimeStamp [him:s.ms.us.ns)| |
-00000105 OF82D0 7367 16b 0 1IN R O RE 3 1 1 0000000000000000 —— - 00:00:00.001.643. 150
-00000104 O0OD6DE D6ES 16b 0 DWW R O - 3 1 1 0000000000000000 —— - 00:00:00.001.649.200
OF8ZCF MOV.W:G  [A0], [&1]
-00000103 OO06DE --E5 16b 1 - - 1 cm 1 1 1 0000000000000000 —— - 00:00:00.001.649.250
-00000102 OF82zDpZ 0289 16b 0 1w R O - 3 1 1 0000000000000000 —— - 00:00:00.001. 649,300
-00ooo1o1 000eE®  15FE 16k O I R ] - 31 1 ooooooooooooooog -- - 00:00:00.001.649.350
OF82D1 MOV.W:¢  0ZH[AO],02ZH[&L]
-00000100 000705 FBE—— 16b 0 DWW W O cm 1 1 1 0000000000000000 —— - 00:00:00.001. 649,400
—-00oooos9 ooo70e  --15 16k 1 W W ] RE 0O 1 1 ooooooooooooooon -- - 00:00:00.001.649.450
-00000038 O0D6ER 0000 1660 DWW R O - 0 1 1 0000000000000000 —— - 00:00:00.001. 649,500
-00000037 OF82zD4 ©90Z 16b 0 M R O - 2 1 1 0000000000000000 —— - 00:00:00.001. 649,550
—-0000009e OF82pe FC1E lekb O In R u] RE 3 1 1 ooooooooooooooon - - 00:00:00.001. 649,600
OF82D5 ADD.W:Q  #1H,-4H[FE]
-00000035 000707 O0-- 1660 DWW W O cm 1 1 1 0000000000000000 —— - 00:00:00.001.649. 650
-00000094 000708 --00 1661 DW W O RE 0O 1 1 0000000000000000 —— - 00:00:00.001. 649,700
-00000093 0006DC 0008 1660 DWW R O - 0 1 1 0000000000000000 —— - 00:00:00.001.649.750 o
-00000092 OF82D8 DEFE 16b 0 1w R O - 2 1 1 0000000000000000 —— - 00:00:00.001. 649,800 =
Figure 5.59 Trace window
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5.9.9 Filtering Trace Information

Use the filter function to extract only the necessary records from the acquired trace information. The filter function filters the
trace information in software that was acquired by hardware.

Unlike the “Capture/Do not Capture conditions” where you set acquisition conditions before getting trace information, this
function permits you to change filter settings for the acquired trace information any number of times.

Therefore, the necessary information can be extracted easily, with data analysis significantly facilitated.

The filter function does not affect the trace memory, so that its content remains intact.

The filter can be used when the selected trace mode is Fill until stop, Fill until full or Fill around TP and the selected display
mode is Bus or Disassembled.

(1) Auto-filter function

To use the filter function, choose Auto Filter from the pop-up menu of the Trace window. When Auto Filter is turned on, each

column of the Trace window is marked with an auto-filter arrow [j].

Click any arrow [j] and select the necessary condition from the ensuing drop-down list. That way, you can easily filter the

records to get those that meet the condition. Selecting Option in the drop-down list brings up the Option dialog box. In this
dialog box, you can set detail conditions.

Some columns such as Address and Data have only Option provided in the drop-down list because they do not have other
inherent items. Selecting All returns you to a non-filter state.

Trace Tl U |
nVE vaAaRT @ EdrH aGa

|Rangs: 00715, ponanomn Fe: iy 0000 ddrass: DFEGEL [Tme: 00:00:00,001.650,000 |

Cycle x| Label | addrex| paxl B=] Bx] _=| eosa=} vekx] BV =] Bv[ FLeAVL Y| Time@tsmp (him:s.ms.us=.n*|=]
-00000084 OFE2B1 77-- 16b 0 11 1 0000000000000000 -- - 00:00:00.001. 650,000
00000087 OFE2EZ PCHE 16b 0 301 1 Qo0000o000000000 -- - 00:00:00.001. 650,050
-000o0oss OFE282 --8EF 16b 1 11 1 ao0acoooocao0aon -- - 00:00:00.002.550. 100
—-0000008s Opg2s4 Q00X 160 O 201 1 Qooooooooda00000 — - 00:00:00,002, 550, 150
—-000000e4 J00em 0009 1tk O 201 1 Qoooooooogoo0oon -- - 00:00:00,001, 550,200
00000083 OF82E6 CATD 16k 0 201 1 Qoooooooda00000 -- - 00:00=00.001. 650,250
-000onogz OFG2B8 7522 160 0 21 1 aooooooooooonoon -- - 00:00:00.001. 650,300
-0ooonog 1 OrFe2Ba 09cC0 16b 0 201 1 noooonoooononoon -- - O0:00:00.001, 650,250
~000onoen OFE2BA --C0 16h 1 C = 1 W 11 1 aoooonoooooonoon -- - 00:00:00.00%. 650 . 400
-00000073 OFEZBC ASDD 16B 0 I B O = 3 1 1 0000DO000D000ODD == - 00:00:00.001. 650, 450
-00000073 OFEIBE  ==00 16b 1 = = 1 BW 1 1 1 0000000000000000 == = 00:00:00.001. 650 . 500
-00000077 OFE2BE PCBO 16 0 I & O = 3 1 1 0000000000000000 == - 00:00:00.001. 650, 550
-00000076 OFEIBE --BO 16b 1 - - 1 ¢ 1 1 1 0000000000000000 -- - 00:00:00.001. 650, 600
-00000075 Opg2cO  L10ES 16b 0 M R u} BE 2 1 1 Qo0oooooocao0oon -- - 00:00:00.001. 550, 650
-00000074 QO0EDC 0002 Lk 0 W B OO - % 1 1 0000000000000000 -- - 00:00:00.002., 650, FO0
=-00000073 OFg2c2  4BEE 16b 0 ™ R i} oW1 1 Qo0aooooocao000n -- - 00:00:00.001. 650,750 =
00000072 Opg2cd  aAlpd 16b 0 M B u} = 4 1 1 Qoooooo0o2000000 — - 00:00:00,001, 50,800 Ll

Figure 5.60 Trace window

If after filtering records in bus display mode you switch to disassemble-only or source-only display, Auto Filter is deselected.
Similarly, when after filtering records in disassembled display mode you switch to bus-only or source-only display, Auto Filter
is deselected.
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If there are multiple items you can specify in the Option dialog box, these items can be used as an OR condition with which to
filter.

e

Figure 5.61 Option dialog box

5.9.10 Searching for Trace Records
You can search the acquired trace information for a specific trace record.
To search for trace records, use the Find dialog box. To open it, choose Find -> Find from the pop-up menu of the Trace

#4

window or click the Find button in the toolbar.

Fnd 21|
LCormbination Firnd e
I Cycle = Fird Prexious
1 Addiess 4'
» Data ke -
1 BHE

= ~| | I Eschsion of the specified conditicn
1| I L

N

_ Mea |
Delete |
Defate Al |
Hishar:
{01]: [CPUI FE & I

[02]: [BIU] 1B, [Rtoe] i d

f

Figure 5.62 Find dialog box
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Select the conditions you want to search for in the Combination column and select the check boxes.

In the Find Item column, you can select the items that correspond to the selected conditions.

If you checked more than one condition in the combination column, set items for each condition. The items you have set are
searched for as multiple AND conditions.

The conditions you have set are shown in the Find Setting Contents.

After setting search conditions, click the Find Previous or the Find Next button to start a search. Trace records are searched in
forward or searched in reverse from the line you have clicked in the Trace window (the line highlighted in blue).

When a matching trace record is found by a search, the relevant line in the Trace window is highlighted. If no matching trace
records are found, a message dialog box is displayed.

When an instance of the trace record was successfully found, choose Find Previous or Find Next from the pop-up menu. The
next instance of the trace record will be searched for.

(1) Search history

The conditions once searched are left as a history in the history column while the High-performance Embedded Workshop
remains active.

The next time you perform a search, choose the line you want to search from this history and click the Add button. That way,
you can search trace information with that condition again.

The search history contains a history of up to 10 last searches performed.

(2) OR search

You can perform a search using two or more search conditions as OR conditions.

To set OR conditions, begin by setting the first condition (shown on the first line in the search content setting column) and then
click the New button.

Then enter the second condition. At this time, the second condition is added to the second line in the search content setting
column.

In this case, the conditions on the first and second lines in the search content setting column can be used as OR conditions for a
search performed.

Up to 16 conditions (16 lines) can be set.

CAUTION
The conditions set on one and the same line in the search content setting column comprise AND conditions.

5.9.11 Saving Trace Information to Files

To save trace information to a file, choose File -> Save from the pop-up menu or click the Save button in the toolbar.

The trace information displayed in the Trace window is saved in binary or text format.
(1) Saving in binary format
To save trace information in binary format, choose “Trace Data File: Memory Image (*.rtt)” in the Save As Type list box of

the dialog box that is displayed when you choose File -> Save from the pop-up menu.
When saved in binary format, all cycles are saved. This type of file can be loaded into the Trace window.

(2) Saving in text format

To save trace information in text format, choose “Text Files: Save Only (*.txt)” in the Save As Type list box of the dialog box
that is displayed when you choose File -> Save from the pop-up menu.

When saved in text format, a range of cycles to be saved can be specified. This type of file can only be saved and cannot be
loaded into the Trace window.
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5.9.12 Loading Trace Information from Files

=

To load trace information from a file, choose File -> Load from the pop-up menu or click the Load button in the toolbar.

Specify a trace information file saved in binary format. The current trace result is overwritten.

Before loading a file saved in binary format, switch to the trace mode in which mode you saved trace information. Do this
switching in the Trace conditions dialog box that is displayed when you choose Acquisition from the pop-up menu of the Trace
window.

If the current trace mode differs from the one in which mode you saved trace information, an error results. Trace information
files saved in text format cannot be loaded into the Trace window.

5.9.13 Temporarily Stopping Trace Information Acquisition
To temporarily stop acquiring trace information during user program execution, choose Trace -> Stop from the pop-up menu

of the Trace window or click the Stop button in the toolbar.

Trace acquisition will be aborted, with the trace display updated. Use this function when you only want to stop acquiring trace
information and check the trace information without stopping program execution.

5.9.14 Restarting Trace Information Acquisition
If after temporarily stopping acquisition of trace information during user program execution you want to start acquiring trace

b

information again, choose Trace -> Restart from the pop-up menu of the Trace window or click the Restart button in the

toolbar.

5.9.15 Switching Timestamp Display
The timestamp displayed in the Trace window can be switched to absolute time, differential time or relative time. In the initial
state, the timestamp is displayed in absolute time.

(1) Absolute time

From the pop-up menu, choose Time -> Absolute Time or click the Absolute Time button in the toolbar. The timestamp

will be displayed by an absolute time since program execution started.

(2) Differential time

From the pop-up menu, choose Time -> Differences or click the Differences button 5 in the toolbar. The timestamp will
be displayed by a differential time from the preceding cycle.

(3) Relative time

From the pop-up menu, choose Time -> Relative Time or click the Relative Time button G in the toolbar. The timestamp

will be displayed by a relative time from a specified cycle.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 140 of 231
Sep.01.21



ROE521500MCUOQO0 User’s Manual 5. Debugging Functions

5.9.16 Showing the History of Function Execution
To show the history of function execution from the acquired trace information, choose Function Execution History -> Function

Fee

in the toolbar.

Execution History from the pop-up menu or click the Function Execution History button

An upper pane of the window will be displayed. (Initially, this window is blank.)

L5

the toolbar, the emulator starts analyzing the execution history from the end of the trace result and shows the result in a tree

When you choose Analyze Execution History from the pop-up menu or click the Analyze Execution History button in

structure.
Trace L E|
mVEp saxz @ 40 a0
E _main (OFE = ] =
E _tutorial [OF82EG) <- OFEZED
& _malloc [OFPE20A) <- OFBIFL
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F- rand (OFE944) <- OFE314
#- _rand (OFE944) <- OFE314
B rand (OFE944) <- OFE314
F- _rand [(OFE944) <- OPE314

[Fargs: -0anors15, coootoeo e yck: 00006962 Address: DOETLE. [Tmes D0/00:00,001.506, 960
[ Cyole Label | Address Daks BUS BHE EIO B/ RWT PO ON BOSACE Debug p [him:=.m=.us.n=i| ]
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Figure 5.63 Trace window

The lower pane of the window shows the trace result beginning with the cycle in which the function selected in the upper pane
was called.
The lower pane of the window can show trace results in disassemble, source or mixed mode.

CAUTION
If trace extraction or deletion conditions are specified, the function execution history cannot be displayed.
If repeat (free) or repeat (full) mode is specified, the function execution history cannot be displayed.
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5.9.17 Showing the History of Task Execution

The history of task execution can only be displayed when you are debugging a realtime OS program.

Furthermore, to show the history of task execution, you need to select Task ID on the Options page of the Trace conditions
dialog box that is displayed when you choose Acquisition from the pop-up menu of the Trace window.

To show the history of function execution from the acquired trace information, choose Show Function Execution History from

Fee

An upper pane of the window will be displayed. (Initially, this window is blank.)
When you choose Analyze Execution History from the pop-up menu that is displayed when you right-click in the upper pane

the pop-up menu click the Show Function Execution History button in the toolbar.

or click the Analyze Execution History button iz in the toolbar, the emulator shows the history of task execution.

When showing the history of task execution, note that the functions called from within tasks are not displayed in a tree
structure. Only the order in which the functions were executed is displayed.
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Figure 5.64 Trace window

The lower pane of the window shows the trace result beginning with the cycle in which the task selected in the upper pane was
called.
The lower pane of the window can show trace results in disassemble, source or mixed mode.

CAUTION
If trace extraction or deletion conditions are specified, the task execution history cannot be displayed.
If repeat (free) or repeat (full) mode is specified, the task execution history cannot be displayed.
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5.10 Measuring Performance

5.10.1 Measuring Performance

The performance function measures a maximum, minimum, average and total execution time and a pass count in each of up to
eight specified sections of the user program and then shows a time ratio relative to the total execution time (Go-Break)
numerically as percentage and graphically.

Since the performance function uses the emulator’s performance measurement circuit to measure the execution time, it does
not obstruct the execution of the user program.

Performance measurement conditions cannot be manipulated during program execution.

5.10.2 Showing the Result of Performance Measurement
Measurement results are displayed in the Performance Analysis window.
To open the Performance Analysis window, choose Performance —> Performance Analysis from the View menu or

click the Performance Analysis toolbar button [! = ].
Performance Analyeie e =
2% | = H S
Hnl_can.dltlnn__Run Cime (him:a.ma... C.. Staciabic  Max (him:a.m2.us. 0] |_mnih:m:s.m.ua.ns:l _avetageih:m:s.wa.ua.nsbl
1 Enable 00:00:01.254,556.150 5 acs N 00:00:00.268,311.700 00:00:00,227.113.400 00:00:00.250,911,230
? Enable 00:00:01.982.471.960 4 7oz O0:00:00.514.026.900 00:00:00.472.836.250 00:00:00.495.617.970
1 Enable 00:00:01.254.556.150 5 455 00:00:00.268,311,700 00:00:00,227.113.400 00:00:00.250,911,230
4 Disable oz I
5 Dissble os I
§ Dissble o I
7 bisable o: I
8 Dissble o5 I

Figure 5.65 Performance Analysis window

The Performance Analysis window shows a ratio of execution time conforming to the conditions you set in the immediately
preceding program execution numerically as percentage and graphically.

The unnecessary columns in this window can be hidden.

To hide any column, right-click in the header column and select the column you want to hide from the pop-up menu.

To redisplay any hidden column, select that column from the pop-up menu again.
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The contents displayed in this window are listed below.

Table 5.23 Columns and contents

Column Description

No Numbers assigned to 1-8 measurement sections set in the Performance Analysis Conditions
dialog box.
Click Settings on the pop-up menu to open the Performance Analysis Conditions dialog
box.

Condition Indicated as Enable when measurement conditions are set in the Performance Analysis
Conditions dialog box.
Otherwise, indicated as Disable.

Run time Cumulative execution time. It shows a cumulative time of measured execution time.

(h:m:s.ms.us.ns)

Count Shows the number of times measured.

Statistic Shows a ratio of cumulative execution time relative to Go—Break execution time.
[Ratio calculation formula]

(Cumulative execution time / Go—Break cumulative execution time) * 100

Max (h:m:s.ms.us.ns) Maximum execution time per measurement performed

Min (h:m:s.ms.us.ns) Minimum execution time per measurement performed

Average (h:m:s.ms.us.ns) Average execution time per measurement performed

5.10.3 Setting Performance Measurement Conditions

In the Performance window, sele

ct a line of the section No. in which you want to set conditions and choose Set from the pop-

up menu. The Performance Analysis Conditions dialog box will be displayed.

+ Performance analysis Conditions * =10l x|
t 2] sl 4l s 6] 7] 5|
Registered events, . |
Candition: | [EF] e Between bwo everts j
~ Details:

—Start event:[OR]

E'venkt | T.I Descriptions

| Count | TaskiD | Corr | Add. .

[l F [Address] ot 00000

l

1 - Deleke
Enable

LB

I i

Disable

End event:[OR]

Event | T.I Descriptions

| Caunt | TaskID | o | Add. ..

FEE F  [address] o000 - o,

1

. Delete

Enable

L

I i

Disate

Ewent used 2 Free 14 Detail...l

Tirme unit: I 10ns 'I

Save... | Load... |

Help | apphy I Close I

g

Figure 5.66 Performance Analysis Conditions dialog box
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(1) Setting measurement conditions

A measurement condition can be selected from the following four modes. Select one measurement condition for one section.
Use events to set a section. Event counts are fixed to 1. Even when an event count is set to other than 1, it is handled as 1.

Table 5.24 Measurement condition modes

IESN | [Disabled]

Not measured.
WEV] _Ev]_ | [Between two events]

-Details: -
 Skart event:[OR]
Event [TI Descripkions [ Co... [ Ta... [ Comm Add... |
m F  [Address] $sort 1 - DEleke
Enable
1| | _P! Diseale
~End event:[OR]
Evert | T.] Descriptions [co.. |Ta.. | Conm Add... |
FIETEN - (4doress] FE1BC - Delete
Enable
1] | _P! Disetle

Figure 5.67 Between two events

Measurement is taken of time from when a start event occurs to when an end
event occurs.

Specifically, measurement is taken of an execution time and execution count
in the range set by a start event and an end event. The measurement of time
starts when a start event occurs and is aborted when an end event occurs.
The execution count is incremented by one each time a start event and an
end event occur in pairs within the set range.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

LEw] __JEW] [Event cycle counting]

Diekails:

—Ewvent:
Evert | T.] Descriptions |co... | Ta.. | cComr  add..
FlENE - [Address] §change 1 - Delete
1| | |

Figure 5.68 Event cycle counting

Measurement is taken of periods in which an event occurs.

Namely, measurement is taken of an event occurrence period and execution
count. The time from when an event occurs to when the next event occurs is
measured as one instance of measurement. The execution count is
incremented by one each time an event occurs.

Event: Only one event point can be set.
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Table 5.25 Measurement condition modes (Continued)
[Evy [Interrupt-disabled range between two events]

Details: -
Start event:[OR]
Event | T.] Descriptions [ ca... [ 1a.. | comm add.. |
E F  [Address] $sort 1 E BIEIEEe
Enatile
4 | | L] Diiseh|e
~End event:[OR] .
Event | T.] Descriptions |co.. | Ta.. | comm add.. |
FIEEEN - (Address] FE1BC 1 - Delete
Erfable

1| | ¥ [Disl
Figure 5.69 Interrupt-disabled range between two events

Measurement is taken of an interrupt disabled section from when a start
event occurs to when an end event occurs.

Specifically, measurement is taken of an interrupt disabled time and an
interrupt disabled count within the range set by a start event and an end
event. The measurement of time starts at the same time an interrupt is
disabled and is aborted at the same time the interrupt is reenabled. The count
is incremented by one each time an interrupt is disabled.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

[CAUTION]

To measure an execution time of a function (maximum, minimum or average execution time of a function), use Between two
events.

Set a fetch to the beginning address of the function as a start event and a fetch to the exit of the function (where return
statement is written) as an end event. If there are more than one exit, set fetch conditions as an end event for each exit.

(2) Selecting the measurement interval

This setting is applied in common to all of 8 sections. The measurement interval can be selected from the following options:
10 ns (default), 20 ns, 40 ns, 80 ns, 160 ns, 1.6 us
The maximum measurement time varies with the measurement interval you set.

5.10.4 Starting Performance Measurement

When the user program is run, performance measurement is automatically started according to the performance measurement
conditions set.

When the user program is halted, the measurement result is displayed in the Performance Analysis window.

When the user program is rerun without changing measurement conditions after being halted, the measured time in this
instance is added to the previously measured value.

To perform a measurement over again, clear the measurement result before running the program.
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5.10.5 Clearing Performance Measurement Conditions

Select the measurement condition you want to clear in the Performance Analysis window and then choose Set from the pop-up
menu to display the Performance Analysis Conditions dialog box. In the Performance Analysis Conditions dialog box, disable
the condition you want to clear.

1 | 2 | = + | s | e | 7 | & |
Registered events. .. |

— g

|—Detalls: |

Condition: (disabled)

Figure 5.70 Performance Analysis Conditions dialog box

5.10.6 Clearing the Performance Measurement Result

Select the section you want to clear in the Performance Analysis window and then choose Clear Data from the pop-up menu.
The measurement result of the selected section will be cleared. To clear all measurement results, choose Clear All Data from
the pop-up menu.

5.10.7 About the Maximum Measurement Time of Performance
(1) Maximum measurement time

The timer used for performance measurement is comprised of a 40-bit counter.

The maximum measurement time varies with the measurement interval selected.

To select the measurement interval, use the Measurement Unit list box of the Performance Analysis Conditions dialog box.
The measurable maximum times are listed in the table below.

Table 5.26 Measurable maximum time

No. Resolution Measurable maximum time
1 10ns Approx. 3 hours, 03 minutes, 15 seconds
2 20ns Approx. 6 hours, 06 minutes, 30 seconds
3 40ns Approx. 12 hours, 13 minutes, 00 seconds
4 80ns Approx. 24 hours, 26 minutes, 00 seconds
5 160ns Approx. 48 hours, 52 minutes, 01 seconds
6 1.6us Approx. 488 hours, 40 minutes, 18 seconds

CAUTION

Note that performance measurement produces an error equal to +1 resolution (when resolution = 20 ns, +20 ns).

(2) Maximum measurement count

Execution counts are measured using a 32-bit counter. Measurement can be taken of up to a count of 4,294,967,295.
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5.11 Acquiring Code Coverage

5.11.1 Acquiring Code Coverage

Code coverage is the function to indicate the ‘digestion’ degree of test, i.e., “to what degree tests have been carried out on
software code (pass).”

Instruction execution information is displayed at C/C++ and assembly-language level.

This function allows the emulator to acquire instruction execution information from a program without causing it to break.
Therefore, the realtime operation of the user program will not be affected.

The coverage result is updated upon a break.

The E100 emulator supports CO (instruction) coverage and C1 (branch) coverage.

Table 5.27 Code coverage definition
CO0: Instruction coverage All statements within the code are executed at least once.
C1: Branch coverage All branches within the code are executed at least once.

The E100 emulator comes with up to a 2-Mbyte code coverage memory when using the CO + C1 level coverage, and up to a 1-
Mbyte code coverage memory when using the C1 level coverage.

With initial settings, the code coverage memory is allocated automatically to addresses in the ROM and RAM areas in this
order.

5.11.2 Opening the Code Coverage Window

Choose Code -> Code Coverage from the View menu or click the Code Coverage toolbar button |

The Code Coverage window initially appears is initially empty.

Code Coverage [ §|
% | W ET WK i
Addresz FRange |£‘.EI Coverage |C1 Coverage I

Executed |Pass ]J‘-u.ddress Assenmbler | Source

41 PI'\MI!":: Range / Source /

Figure 5.71 Code Coverage window
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(1) Measurement method

The Code Coverage window consists of two sheets.

Table 5.28 Sheets of the Code Coverage window

Sheet name Description
Address Range sheet Measurement is performed on any address range.
Source sheet Measurement is performed on a specified source file

The respective sheets permit multiple ranges to be registered.
Up to two instances of the Code Coverage window can be opened at the same time.

5.11.3 Allocating Code Coverage Memory (Hardware Resource)
(1) Memory allocation

Before code coverage can be measured, code coverage memory must be allocated to the addresses where it is measured.
Coverage data can be obtained from only the address range that has had memory allocated.

To allocate code coverage memory, use the Coverage Memory Allocation dialog box.

To open it, choose Hardware Settings from the pop-up menu of the Code Coverage window.

Allocation of Code Coverage Memory 5[
Allozation of Coverage kemaony:
Address | Block | Add...
Q0000 - 1FFFF 1
EOQO00 - FFFFF 2
Clear
Al Clear
Drefault
Help k. Cancel

Figure 5.72 Allocation of Code Coverage Memory dialog box

When using the CO level coverage and C1 level coverage, you can specify any of 1-8 blocks (maximum 2 Mbytes) each
beginning with the 256-Kbyte boundary and any of 1-8 blocks (maximum 1 Mbyte) each beginning with the 128-Kbyte
boundary as a code coverage measurement area respectively.

Either contiguous or non-contiguous blocks can be set.

With initial settings, the coverage memory is allocated to addresses in the ROM and RAM areas.
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Figure 5.73 Schematic of coverage memory allocation

(2) Changing memory allocation

If coverage memory allocation is changed, the coverage data acquired from the addresses before being changed is retrieved
from coverage memory into a coverage-only buffer.

Buffer for
coverafje

nooonn

040000

07FFFF

Area where coverage can
bhe measured

{2y Data acuisition

240000

—

Area where coverage can
be measured

27FFFF

Faonon

FConon

Area where coverage can
he measured

FFFFFF

Area where coverage can
be measured

Figure 5.74 Schematic of coverage memory allocation change

{1) Allocation change

The data accumulated in a coverage-only buffer is retained until the user clears it. However, data is not updated for the areas
that have no coverage memory allocated.
The coverage information shown in the Code Coverage window includes the content of the coverage-only buffer.
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5.11.4 Code Coverage in an Address Range

The Address Range sheet shows the code coverage information (CO coverage and C1 coverage) acquired by the emulator from
a user-specified address range.

Multiple address ranges can be registered.

An address range exceeding 2 Mbytes or even an area that has no coverage memory allocated can be specified. However, the
coverage information on areas that have no coverage memory allocated is not updated

Areas where coverage information is not updated are displayed in gray.

An example display is shown below.

CodeCoverage = |

% | |zt & H

Address Range ICEI Coverage ICl Coverage |
DFE1BE - OFEZ18  1c:[l | zs5: |
orFezz4 - 0rE376  zo: 75
Executed I Pass IAddress [ Azzsembler | Source I il
1 = OFE1EBE ENTER. ... 1

1 - OFEIC1  MOV.W:...

i - OFEicd MOV Wi ... for(i=0...

1 - OFELCT CHMP.W:...

1 F OFE1CC JE J00

1 - OFEICF  MOV.W:... ewp[i] ...
B OFEIDZ SHL.W ... |
m&ddmn Range l.l‘;isclurl:i ;

Figure 5.75 Code Coverage window (address specification)

The Code Coverage window is vertically divided into two by the splitter.
The upper pane shows the address ranges to be measured, CO coverage and C1 coverage.

Table 5.29 Contents shown in the upper pane of the Code Coverage window

[Address Range] Address range in which coverage is measured
[CO Coverage] CO coverage in percentage and graph
[C1 Coverage] C1 coverage in percentage and graph

The lower pane shows detailed information of the address range selected in the upper pane (assembly-language level).

Table 5.30 Contents shown in the lower pane of the Code Coverage window

[Executed] 1: The instruction was executed
0: The instruction was not executed
[Pass] Condition for execution of a conditional branch instruction

T: The condition was satisfied.

F: The condition was not satisfied.

T/F: The condition was satisfied in one case and not satisfied in another.
-: Instructions other than conditional branch instruction.

[Address] Instruction address
[Assembler] Disassembled program
[Source] C/C++ or assembler source program
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The acquired coverage information is accumulated in memory until the user clears it.

When you double click Assembler code shown in the Address Range sheet, the corresponding source code is shown in the
Editor window.

Be sure that source code is not displayed in the cases listed below.

- Assource file that corresponds the assembler line does not exist.

- Asource line that corresponds the assembler line does not exist.

- Where no debug information is included, such as where the assembler line is a library.

5.11.5 Adding Address Ranges
Follow the procedure described below to add address ranges.

(1) From the Address Range sheet of the Code Coverage window

1. Right-click in the upper pane of the Address Range sheet and choose Add Range from the pop-up menu.

El
o | x|

Address Range ICEI Coverage ICl Coverage I

Bercentage

[E0|E Ramme: .

Executed ] LPaszs I Address__ [DEFlERaE e I

Im.ﬁdl":: Range l,l'llSaol.rl:q ;

Figure 5.76 Code Coverage window

2. In the Add Address Range dialog box that is displayed, enter an address range.

Add Address Range .1].5]

Etart.-ﬁu.ddresmurpﬂm -I :I EI
End Address: @'ﬁ @ Cancel |

Figure 5.77 Add Address Range dialog box

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 152 of 231
Sep.01.21



ROE521500MCUOQO0 User’s Manual 5. Debugging Functions

3. The address range you have added will be displayed in the upper pane of the Code Coverage window.

CodeCoverage 0 |
o ||zt x| &
Addresz Range ¢ Coverage |C1 Coverage I

= - )

Executed ] Fass | Address I Aszenbler | Source El
OFELDZ ENTER ... {

OFELDS MOV.W:G...

OFELIODS  MOV.W:iQ... gap = 5;

OFELOE CMP LW 0. .. while gap... =
PI

’“M‘M!! Range li'l‘ Source ;

-

Figure 5.78 Code Coverage window

5.11.6 Changing Address Ranges
Follow the procedure described below to change address ranges.

(1) From the Address Range sheet of the Code Coverage window

1. Select an address range you want to change in the Address Range sheet and while holding it selected, choose Edit Range
from the pop-up menu.

CodeCoverage £
% |83t < | &
Address Range I c0 Coverage ICl Coverage I

OFE10Z - OFEIEC [EIRY oot
OFE1BE - OFEZ18 1oo:[ =5

Add Range. .

Executed l Pass | Address I A bz Range

1 - OFEL0Z ENTER ... {

1 = OFE1L105 MOW.W:iG. ..

1 - OFE1L08 MOV . 0. .. gap = 5;

1 - OFEIOE CMP.W:Q... while( gap... =
1 | >

4 | k |\ Address Range A Sourca J

Figure 5.79 Code Coverage window

2. In the Edit Address Range dialog box that is displayed, change the address range.

Edit Address Range ﬂﬁl

SO e —
End Addeess: [|FEITE - Cancel

Figure 5.80 Edit Address Range dialog box

= @
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3. The address range you have changed will be displayed in the upper pane of the Code Coverage window.

S
% || KA.
Address Range If.‘.l:l Coverage Il:‘.l Coverage |

OFEZZ4 — OFE3TE

OFe1BE - OFE218 100+ NG 100 I

Executed ] Pass I Addres= I Azsembler | Source EI
1 - OFE2Z4 ENTER ... {

1 - OFEZZT PUSH.W:... p_sam— rmal. ..

1 - OFEZZE PUSH.W: ...

1

- OFEZ2Z2F JSR.A ... .
| r|

q P“MIM:: Range l.I'I|.54'.|I.I"I:Jl ;I'.

Figure 5.81 Code Coverage window

5.11.7 Removing Address Ranges
Follow the procedure described below to remove address ranges.

(1) From the Address Range sheet of the Code Coverage window

1. Select an address range you want to remove in the Address Range sheet and while holding it selected, choose Delete Range
from the pop-up menu.

X
% |z X &

C0 Coverage ICl Coverage |

SD%__ —_
o0s [N~

Add Range, ..
dit: Range...

Executed [ Fass | Address= |

1 = OFEZZ4 ENTER ... {

1 = OFEZZT PUSH.W:... p_sew= mal...
1 = OFEZZE PUSH.W: ...

1

- DE‘EEEF JSR. A E] =
| LlJ

. 4 PT\MIHH Range /A Sourca /

Figure 5.82 Code Coverage window
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2. A dialog box asking for your confirmation will be displayed.

Choose to save or not save coverage data. To save, specify a file name and then click the OK button. If you do not save, simply
click the OK button.

Delete Address Range | - ﬂﬁl

The range it to be daleted. Coverage data has not beer
saved

% Do not save the coverane dats

{~ Sawve coverage data to file

| Ll Erc*.*.ls.c_..l
oo |

Figure 5.83 Delete Address Range dialog box

3. The address range you have selected will be removed.

Code Coverage l £ |

% |8 x % X &/

Address Range ICI:I Coverags It‘.l Coverages |

OFE1EE - OFEZ18 100+ NG 100+ I

Executed ] Bass I Address | Assembler | Source H
1 - OFELEBE ENTER ... {

1 - OFELCL MOV, Tz, ..

1 - OFELC4 MOV.W:Q... for(i=0; i...

1

- OFELCT CMP.:G... .
| ]

4 P“MIM:: Range l,l'lliql.rl:ﬂ ;

Figure 5.84 Code Coverage window
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5.11.8 Code Coverage in a Source File

The Source sheet shows the code coverage information (CO coverage and C1 coverage) acquired by the emulator from a user-
specified source file.

Multiple source files can be registered.

A source file exceeding 2 Mbytes in size or even a file that includes an area that has no coverage memory allocated can be
specified.

However, the coverage information on areas that have no coverage memory allocated is not updated.

Address lines where coverage information is not updated are displayed in gray.

An example display is shown below.

|
% |4 ot WX 7 |
File | Function CO Coverage | ¢l Coverage |
100 conditional Br
sert.e  sort a7+ T -1
sort.c change 0% 0%
Executed |Pass |Address Assenbler | Source | ﬂ
- OFEO14 ENTER ... 1
- OFEODLY MOV Wz ... p_sam—>...

OFEO19 MOV T ...
- OFEO1E MOV . WL L.
- OFEOQLE MOV . ... ;I

4 I }I'\ Address Range )\Source jr

[ =
|

Figure 5.85 Code Coverage window (source file specification):

The Code Coverage window is horizontally divided into two by the splitter.
The upper pane shows the address ranges to be measured (file and function names), CO coverage and C1 coverage.

Table 5.31 Contents shown in the upper pane of the Code Coverage window

[File] File name

[Function] Function name

[CO Coverage] CO0 coverage in percentage and graph
[C1 Coverage] C1 coverage in percentage and graph

The lower pane shows detailed information of the address range selected in the upper pane (assembly-language level).

Table 5.32 Contents shown in the lower pane of the Code Coverage window

[Executed] 1: Instructions was executed.
0: Instructions was not executed.
[Pass] Condition for execution of a conditional branch instruction

T: The condition was satisfied.
F: The condition was not satisfied.
T/F: The condition was satisfied in one case and not satisfied in

another.
[Address] Instruction address
[Assembler] Disassembled program
[Source] C/C++ or assembler source program

The acquired coverage information is accumulated in memory until the user clears it.
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5.11.9 Adding Source Files
Follow the procedure described below to add source files.

(1) From the Source sheet of the Code Coverage window

1. Right-click in the upper pane of the Source sheet and choose Add Range from the pop-up menu.

CodeCoversge £
o | s wt W o< iy
File | Function | C0 Coverage | ¢l Coverage |
Bercenftage

fdd Range...
EdiERange:..

BElete Range —_—
Executed | Pass IAddress Assenbler prerwrmE—

il b|', Address Range ,",s-u-u F"

Figure 5.86 Code Coverage window

2. In the Add Source Files dialog box that is displayed, enter a file name.

2]
Flerane o |
[ \ LI Browse... | Cancel |

Figure 5.87 Add Source File dialog box

3. The source file you have added and the function names included in it will be displayed in the upper pane of the Code
Coverage window.

Code Coverage [ x|
% | MY K # g
File I Function I CO Coverage | Cl Coverage I
Fork.c init == ==
sort.c sort - -
sort.c change == ==
Executed | Pass IAddress Aszembler I Source ﬂ
OFED14 ENTER ... {
OFEDLY MOV.:. .. p_sam->20 ...
OFEDLS MOV.W:...
OFED1B MOV W ...
OFED1E MOV WL ..
OFEDZ1 3TE.W ... _I
4 [ # [\ Address Range ) Sowrce
Figure 5.88 Code Coverage window
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5.11.10 Removing Source Files
Delete source files by the following methods.

(1) From the Source sheet of the Code Coverage window

1. Select a function you want to remove in the upper pane of the Source sheet and while holding it selected, choose Delete
Range from the pop-up menu.

CodeCoverage F
% | 4[5t WO # i
File I Function I CO Coverage | Cl Coverage |
sort.c init 100 ii__pamm‘hage - -
sort.c sort s
sort.c change s addRange...

dk Range...

Executed I Pas= IAddress |Assemhler I 3
= OrFe014 ENTER ... {

= OFrEOLY MOV.W. .. p_sam->20 ...
= OFED19 MOV.HW:. ..

- OFEOD1E MOV.W:. ..

= OFEOD1E MOV.W:. ..

- OFEODZ1 STE.W ...

4 | k[ Addres Range A Source

e e

Figure 5.89 Code Coverage window

2. A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, specify
a file name and then click the OK button. If you do not save, simply click the OK button.

21

All functions in the same zource e will be daleted.
Cowerage data has not been zaved.

' Lo not save the coverage dats

{~ Sawve coverage data to file

| L’ Err_'.*.'ir_-_..l
oo |

Figure 5.90 Delete Source File dialog box
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3. All functions included in the selected source file will be removed.

4
% |3 st X o &
File I Function I CO Coverage | Cl Coverage I

Executed |Pass IAddress Aszembler | Source

42T\ Address Range ), Source /

Figure 5.91 Code Coverage window

5.11.11 Showing Percentages and Graphs
After the program has stopped, right-click in the upper pane of the Code Coverage window and choose Percentage from the

pop-up menu. The emulator will start calculating CO (instruction) coverage and C1 (branch) coverage for each address range.
When the calculation is completed, coverage information is displayed in the upper pane as percentages and graphs.

S|
% |G| =? WX i

Addresas Range ICD Coverage Icl Coverage

I = OFE1EBC
OFEZZd4 — OFE3T6 -

Percentage

Add Range...
Edit Farge...
Delete Rangs

J

£l
AR ar e

Address Eange C0 Coverage Icl Coverage

OFE102Z - OFEIRC JlE] DOEEGE] B
orEzz4 - OFE376 254 NN s+ I

Figure 5.92 Code Coverage window
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5.11.12 Using the Sort Function
Clicking on a header column in the upper pane of the Code Coverage window allows the coverage data to be sorted.
(1) Clicking on the File column

The data can be sorted by the file name. Lines in the same file are sorted by function name.
Example:

File Function  CO Coverage

filel.cpp funcl  40% mmmm
filel.cpp func2 10% m

filel.cpp func3  80% mwmmEmmmm
filel.cpp funcd  70% memmmmm
file2.cpp funcl  20% mm

file2.cpp func2 60% umEmEE
file2.cpp func3  90% EEEEEEEE
file3.cpp funcl 0%

file3.cpp func2  30% mmm
file3.cpp func3 10% m

(2) Clicking on the CO Coverage column

The data can be sorted by coverage rate.

First clicking on the column sorts the values in decreasing order. Clicking on the column again sorts the values in ascending
order.

Example:

File Function  CO Coverage

file2.cpp func3  90% wemEEEEEm
filel.cpp func3  80% mmmEmmEm
filel.cpp funcd  70% memmmmm
file2.cpp func2  60% mEmmmEmm
filel.cpp funcl  40% mmmm
file3.cpp func2  30% mmm
file2.cpp funcl  20% mm

filel.cpp func2 10% m

file3.cpp func3 10% m

file3.cpp funcl 0%
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(3) Clicking on the CO Coverage and the File columns in this order

The data for each file is sorted by the coverage rate in descending order.

Example:

File Function  CO Coverage

filel.cpp func3  80% mmmmmmmm
filel.cpp func4  70% mmmmmmm
filel.cpp funcl  40% mmmm

filel.cpp func2 10% m

file2.cppfunc3  90% emeEmEEmm
file2.cpp func2  60% mEmEmEmEm
file2.cpp funcl  20% mm

file3.cpp func2  30% mmm

file3.cpp func3 10% m
file3.cpp funcl 0%

5.11.13 Searching for Unexecuted Lines

Search for unexecuted lines in a selected address range or function.

Find dialog box shown below appears.

21

Find What: |Unexecuted Line

Brarch [T]
Branch [F] Lancel

= Find

Figure 5.93 Find dialog box

Following three search options are available.

Table 5.33 Search options

When you click the Find button

i

T

Unexecuted Line

Instructions not executed yet

Branch (T)

Branch instructions only tested as TRUE.

Branch (F)

Branch instructions only tested as FALSE.

Clicking the Find Next button () starts a search.

When a matching instruction is found, the line of that instruction is highlighted.

When no matching instructions are found, a message is displayed.

in the toolbar, the
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5.11.14 Clearing Code Coverage Information
(1) Clearing the code coverage information of the specified range

Selecting Clear Coverage Range from the pop-up menu opens the Clear Address Range dialog box.

Clear Address Range 7] x|

Start Address: IEIEIEEI?E j
End Address: [DDCTTE =] Cancel |

Figure 5.94 Clear Address Range dialog box

Enter the start and end addresses of the range to be cleared. Clicking the OK button clears the coverage information of the
selected range.

(2) Clearing all the code coverage information

Selecting Clear the Entire Coverage from the pop-up menu clears all the code coverage information.

5.11.15 Updating Coverage Information

Selecting Refresh from the pop-up menu updates the content of the Code Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when the program breaks. To view the latest
information, therefore, you need to update manually.

5.11.16 Preventing Update of Coverage Information
Selecting Lock Refresh from the pop-up menu prevents update of the Code Coverage window while the user program
execution is stopped.
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5.11.17 Saving the Code Coverage Information to a File

You can save the code coverage information of the currently selected sheet to a file.
Selecting Save Data from the pop-up menu opens the Save Coverage Data dialog box.

X

Coverage Data - Address Ranges

File name:

I LI Browse,.. | Cancel |

¥ Always zave to thiz file when saving the session

2]

Figure 5.95 Save Coverage Data dialog box

Enter a file name in which you want the information to be saved.

If the file extension is omitted, “.cov” will automatically be added as the file extension.

If you specify an existing file name, the file is overwritten.

5.11.18 Loading Code Coverage Information from a File
You can load a code coverage information file.
Selecting Load Data from the pop-up menu opens the Load Coverage Data di

| Load Mode | File Mame | Difset |
Over-wite ezt cov O 0000000
Over-wite  testl2 coy (00000000
Merge testl 3. cav Cre 0000000

Move Up

it

Mowve Down

[ Clear coverage RaM befiore kadng

0K I Cancel

alog box.

x|

Figure 5.96 Load Coverage Data dialog box
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Clicking on the Add button opens the Add Coverage Files dialog box shown below.

Add Coverage Files e e
File Mame:
I | 3 | Browse... |
Offzet:
| 0x000000
Coverage Data Load Mode
’7(7 Dsenvrite " Menge

oK LCancel |

Figure 5.97 Add Coverage Files dialog box

Use this dialog box to specify a coverage information file you want to load. You can also specify a load mode and offset for
each file you load.

The only file extension available is “.cov”. An error message will appear if any other file extension is entered.
The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are
listed. If necessary, use the Up or Down button to change the order.

CAUTION
If the coverage information file you are loading is of a source file type, you cannot specify an offset.

5.11.19 Coverage Information File Load Modes
Coverage information file load modes are schematically shown below.

(1) When “Overwrite” has been selected

COvVErage Memory
[Before loading]  [After loading)

Coverage file

O 2000 O 2000 O 2000
[~ | The coverage memaory is overnritten with
1] the data ofthe loaded coverage file.
Ox2FFF Ox2FFF Ox2FFF

Figure 5.98 Schematic of the overwrite mode
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(2) When “Merge” has been selected

Coverage memary
[Before loading]  [After loading]

Coverage file
- axa000— ax2000— (1) Existing data is read.
(1) """"" {2) The data ofthe coverage file is

P merged with the existing data.

Ox2FFF Ox2FFF 0x2FFF

i i (3 The merged data is written to
the coverage memary.
oy R

Figure 5.99 Schematic of the merge mode

(3) Application example of merge mode

Coverage memory

Test A Test B Test C [after loading in the merge mode)
COVErage COVErage  COvVErage
file: file file:
gresesne [Example]
HE A Az the result of test
P A B, and C the CO
coverage iz 79%.

Figure 5.100 Schematic of merge-mode application

[Procedure]

(1) Open the Load Coverage Data dialog box.
To begin with, select the “Clear coverage RAM before loading” check box.
(2) Add a coverage file for test A in the merge mode.
(3) Add a coverage file for test B in the merge mode.
(4) Add a coverage file for test C in the merge mode.
(5) Click the OK button.

You have now finished merging three files.
By calculating percentages in the Code Coverage window, you can view the coverage (in percentage) of those tests as a whole.
Furthermore, the merged data can be saved to a file, so that you can manage those data as a single file.
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5.11.20 Displaying Code Coverage Information in the Editor Window

When the Editor window is open in the source mode, the results of coverage are displayed in its Code Coverage column.

Part of the Code Coverage column that corresponds to a source line where an instruction has been executed is highlighted.

If the user changes any setting regarding the coverage information in the Code Coverage window, the content of the
corresponding Code Coverage column will also be updated.

[#Tutoriale =10l ]
|5 &|&

Line | Sour. | E.] C.] S.] Souce |
21 void tucorial (void) Zl
<2 |FE2Z24 {

23 long af10];

24 lowng j:

25 int i;

26 struct Jample Ifar *p sem;

27

28 |FE227 p sam= mwalloe(sizeof (scruce Sample)) ,:J

29 |FE23E initp_sam)

30

31 |FEz4a7 for{ i=0; i<10; i++ ){

2 |FE232 J = wand();

33 |FE25E if(3 < 0O)4

34 |FEZE3 i = =3z

35 H ¥ -
1| | v

Figure 5.101 Example of code coverage results
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5.12 Acquiring Data Coverage

5.12.1 Acquiring Data Coverage

The E100 emulator has code coverage, data coverage and realtime profile functions usable exclusively to each other.

To use the data coverage function, choose Data Coverage in the Exclusive Functions section on the System page of the
Configuration Properties dialog box.

Data coverage is the function to indicate “what kinds of accesses have been made” to the data area.

This function allows the emulator to acquire access information per byte without causing a program to break. Therefore, the
realtime operation of the user program will not be affected.

The coverage result is updated upon a break.

The E100 emulator comes with 512 Kbytes of data coverage memory.
With initial settings, the data coverage memory is automatically assigned at addresses in the ROM and RAM areas in this order.

5.12.2 Opening the Data Coverage Window

Choose Code -> Data Coverage from the View menu or click the Data Coverage toolbar button [ 5 1.
The Data Coverage window initially is initially empty.
Data Coverage ]
% | B @ |5 Y X \
Range Aocess Rate |
Address= | Lahel | Area | Data
m.nddress Range l.-{. Section h Tazh Stack f
Figure 5.102 Data Coverage window
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(1) Measurement method

The Data Coverage window consists of three sheets.

Table 5.34 Sheets of the Data Coverage window

Sheet Description
Address Range Measurement is performed on any address range.
Section Measurement is performed on a specified section.
Task Stack Measurement is made of all task stack areas.

The respective sheets permit multiple ranges to be registered.
The Task Stack sheet supports only automatic registration.
Up to three instances of the Data Coverage window can be opened at the same time.

5.12.3 Allocating Data Coverage Memory (Hardware Resource)
(1) Memory allocation

Before data coverage can be measured, data coverage memory must be assigned to the target address range. Coverage data can
be obtained from only the address range that has had memory allocated.

To allocate data coverage memory, use the Allocation of Data Coverage Memory dialog box. To open this dialog box, select
[Hardware Settings...] from the pop-up menu of the Data Coverage window.

Allocation of Data Coverage Memory =|

Allocation of Coverage Memone

Addrezs | Block | Add,. |
00000 - OFFFF 1
10000 - 1FFFF 2
EQODO - EFFFF 3 Clear |
FO000 - FFFFF 4
Al Clear |
Defaudt |

Hep  |[ ok | cancel |

Figure 5.103 Allocation of Data Coverage Memory dialog box

You can specify any of blocks 1 to 8 (up to 512 Khbytes) each beginning with a 64-Kbyte boundary as data coverage
measurement areas.

Either contiguous blocks or non-contiguous blocks can be assigned.

With initial settings, the coverage memory is automatically assigned at addresses in the ROM and RAM areas.
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noooon

010000

01FFFF

240000

Z4FFFF

FEOOOD

FFOOO0

Area where coverage can
he measured

Area where coverage can
he measured

Area where coverage can
be measured

FFFFFF

Area where coverage can
be measured

Figure 5.104 Schematic of data coverage memory allocation

(2) Changing memory allocation

If coverage memory allocation is changed, the coverage data acquired from the addresses before being changed is retrieved
from coverage memory into a coverage-only buffer.

Buffer for
coverage

noooon

010000

01FFFF

Area where coverage can
be measured

(2) Data acquisition

240000

_

Area where coverage can
bhe measured

24FFFF

FEOOOO

Area where coverage can
bhe measured

FFOOO0

FFFFFF

Area where coverage can
be measured

Figure 5.105 Schematic of data coverage memory allocation change

(1) Allocation change

The acquired coverage information is accumulated in the coverage buffer until the user clears it. However, the coverage
information on areas that have no coverage memory allocated is not updated.
The coverage information shown in the Data Coverage window includes the content of the coverage-only buffer.
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5.12.4 Data Coverage in an Address Range

The E100 emulator shows the access information it acquired from a user-specified address range.

E
% | %[ | =t wt X |
Range |Access Rate I
0o003co - 0006AZ 0%

Address I Label | Area | Lata il

ooasco FAM e? £8 1k 03
ooosc4 FAM dee 6f ac 24
ooosca BAM 23 df hd ge
oooscc BAM c? b3 dl 02
ooasoo FAM 99 k7 do 30 ;I
mﬁddress Range .f{. Sectian }-.. Tazk Stack j‘

Figure 5.106 Data Coverage window (address specification)

The Data Coverage window is vertically divided into two by the splitter.
The upper pane shows the address ranges to be measured and access rates.

Table 5.35 Contents in the upper pane of the Data Coverage window
[Range] Address range in which coverage is measured
[Access Rate] Access rate in percentage and graph

The lower pane shows detailed information of the address range selected in the upper pane.

Table 5.36 Contents shown in the lower pane of the Data Coverage window

[Address] Address value
[Label] Label name
[Area] Memory area (FlashROM, RAM, SFR)
This column is blank when the area is unused.
[Data] Memory data
The accessed data has its background displayed in purple.

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage
information of those addresses is retained, the coverage information will not be updated by program execution.

The acquired coverage information is accumulated in memory until the user clears it.
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5.12.5 Adding Address Ranges
Follow the procedure described below to add address ranges.

(1) From the Address Range sheet of the Data Coverage window

1. Right-click in the upper pane of the Address Range sheet and choose Add Range from the pop-up menu.

£
o | B8 [ | =t ek X
Range | Acceszs Rate |
Percentage
Edit Range. ..

Address | TLiabhel | Area | Date [elete Range

Mnddress Range f{ Section )\ Task Stack j‘

Figure 5.107 Data Coverage window

2. In the Add Address Ranges dialog box that is displayed, enter an address range.

Add Address Range

2%
Stat Acdress: ([512 T =

End Address: UE3E J j Cancel

Figure 5.108 Add Address Range dialog box

3. The address range you have added will be displayed in the upper pane of the Data Coverage window.

E
% | M| % K
Range | Access Rate |

000512 - 00063E -—

Address | Lahel | Area | Data ﬂ
ooos1z RAT 40 52 e3 fco
aoos1a RAM al a9 18 =7
ooos1a RAM ad 71 7f 02
Oo0051E RAM dd 0Oz 1a fa
ooos5zz RATM 10 19 £7 35 ;I

ﬂ]\nddress Range j{ Section )\ Tash, Stack j‘

Figure 5.109 Data Coverage window
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5.12.6 Changing Address Ranges
Follow the procedure described below to change address ranges.

(1) From the Address Range sheet of the Data Coverage window

1. Select an address range you want to change in the Address Range sheet and while holding it selected, choose Edit Range
from the pop-up menu.

E
% | W@ |z w X
Range |Ac:c:ess Rate |

o051z

— D0O0G3E
Percentage

Edit Rangs...

Delete Range |

Address | Label | Area | Data i’
oonslz FAM 40 52 ed fo
oaosle FAM al a9 18 =7
oaos1a FAM ad 71 7f 02
Oa0s1E RAM dd 0Oa la f=
onnszz A 10 19 £7 35 LI

mnddress Range f'r\ Section }\ Tash Stack f
Figure 5.110 Data Coverage window

2. In the Edit Address Range dialog box that is displayed, change the address range.
Edit Address Range ilﬂ

Start Address: | [000700 | =]
End Address: “DDDSEE I j Cancel |

Figure 5.111 Edit Address Range dialog box

3. The address range you have changed will be displayed in the upper pane of the Data Coverage window.

Data Coverage |

Access Rate I

Address I Label I Area I Data 3
oooyoo FAM
ooovo4d FAM
oooyog FAM
ooovoc FAM
ooov7 10 FaM ﬂ
Mhddress Range j Section ) Task Stack
Figure 5.112 Data Coverage window
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5.12.7 Removing Address Ranges
Follow the procedure described below to remove address ranges.

(1) From the Address Range sheet of the Data Coverage window

1. Select an address range you want to remove in the Address Range sheet and while holding it selected, choose Delete Range
from the pop-up menu.

£
% | @ | =%
Fange IAccess Rate |
(000700 - OOOBEE i 53]
O012EE - 00133a 0%
Percentage
Add Range...

Edit Range. ..

Address | Label | Area | Data

ooovoo RAM
ooo7o4 RAM
ooo7os RAM
ooo7oc RAM
ooov?io RAM

mﬁddress Range f; Section }\ Task Stack ',r
Figure 5.113 Data Coverage window

2. A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, click
the Yes button. If you do not save, click the No button.

ecxdata _hlIl WEerage

Mo | Cancel |

Figure 5.114 Confirmation of Edit Address Range dialog box

3. The address range you have selected will be removed.

Data Coverage |
% | 12 [ | =t X

Fange |Access Fate I
O001ZEB - 001332 0%

Address I Label | Area I Data ﬂ
O01ZEEB RAM 90 73 d7 17

O01ZEF RAM 45 6h 6e kO

O012F3 RAM 0d 4c 00 88

001ZF7 RAM 13 99 5e a6

O01ZFEB RAM 14 fh ce kS |
ﬂ]\hddress Range f{\ Section }\ Task Stack f

Figure 5.115 Data Coverage window
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5.12.8 Data Coverage in a Section

The E100 emulator shows the access information it acquired from a user-specified section.

=
% | 52 [ | =f % X

SJection IAccess Rate |
00041c - 00OY1E (stack) 13%.
0o071c - O00A1E (istack) 0%

oz
Address | Label I Area I Data ;I
0o0eAR RAM d9 ff 4e 9k
OO0BAC RAM 0 b7 95 Oe
000&ED RAM a’
OO06BE4 RAM —
ODO0eEBR RAM ;I

4| }I'-. addresz Range }\'Settinn ;’{\ Task Stack [

Figure 5. 116 Data Coverage window (section name specification)

The Data Coverage window is vertically divided into two by the splitter.

The upper pane shows the address ranges (section names) to be measured and access rates.

Table 5.37 Contents in the upper pane of the Data Coverage window

[Section]

Address range (section) in which coverage is measured

[Access Rate]

Access rate in percentage and graph

The lower pane shows detailed information of the address range selected in the upper pane.

Table 5.38 Contents shown in the lower pane of the Data Coverage window

[Address] Address value
[Label] Label name
[Area] Memory area (FlashROM, RAM, SFR)
This column is blank when the area is unused.
[Data] Memory data

The accessed data has its background displayed in purple.

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage
information of those addresses is retained, the coverage information will not be updated by program execution.
The acquired coverage information is accumulated in memory until the user clears it.
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5.12.9 Adding Sections
Follow the procedure described below to add sections.

(1) From the Section sheet of the Data Coverage window

1. Right-click in the upper pane of the Section sheet and choose Add Range from the pop-up menu.

K|
o |80 [ | = % X
Secktion |Access Rate |
Percentage

Delete Range
Address | Lakel | Area | Data |

4 l PI\ Addresz Range ,}\Section .& Tazk Stack ,"

Figure 5.117 Data Coverage window

2. In the Add A Section dialog box that is displayed, enter a section name.

add & Section 1' EI
Sectiorn: S L S
stack j LCancel

Figure 5.118 Add A Section dialog box

3. The address range (section name) you have added will be displayed in the upper pane of the Data Coverage window.

|
% | 3 [ | = % X
SJection |Access Rate |

00041c - 0DO0O071E (stack) -

Address | Label |Area | Data ﬂ
ooo41c RAM oo oo 0o oo
ooo4z0 RAM oo oo 0o oo
ooo04z4 RAM oo oo 0o oo
[

1' }I'\ Address Range }\Seclion {; Task Stack ,"

Figure 5.119 Data Coverage window
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5.12.10 Removing Sections
Follow the procedure described below to remove sections.

(1) From the Section sheet of the Data Coverage window

1. Select a section name you want to remove in the Section sheet and while holding it selected, choose Delete Range from the
pop-up menu.

|
% | 8@ | oW X

Secktion |Access Rate |

0oodlc - 00071E (stack) 13%.

OF2014 - OFEQTF (program) ng
Percentage

Add Range...
Edit Range. ..

Addre=ss | Lakel |Area | Data

4 l PI\ Addresz Range ,}\Section .& Tazk Stack ,"

Figure 5.120 Data Coverage window

2. A dialog box prompting for your confirmation will be displayed. Choose to save or not save coverage data. To save, click
the Yes button and specify a file name. If you do not save, click the No button.

ecxdata_hcoverage

Mo Cancel

Figure 5.121 Confirmation of Removing Section dialog box

3. The section name you have selected will be removed.

|
% |53 [ | =t W X

Secktion |Access Rate |

0oodlc - 00071E (stack) 13%.

OF89E80 - OFEAAE [interrupt) 0%

Addre=ss | Lakel |Area | Data i’
4 l PI\ Addresz Range ,}\Section .& Tazk Stack ,"

Figure 5.122 Data Coverage window
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5.12.11 Data Coverage in a Task Stack

The Task Stack sheet shows the access information acquired from a task stack.
Task stacks are automatically registered.

You cannot add, remove or change any task.

If tasks are changed pursuant to alterations of the user program, for example, the window is automatically updated.

|
% |2 M | =% X

Taszsk IAccess Rate I;I
O00EQC - OOQ0EGF [(TaskID=11, Entry= task011) 0%

O00AZ4 000&87 (TaskID=1, Ent tain) oz

001000 - 001063 [TaskID=16, Entry=_task0O16) 0%

000F9C - O0OFFF (TaskID=15, Entry=_task013) oz _I
O0DAEC - O00B4F (TaskID=3, Entry=_ task003) 0% ;I
Address | Label |Area | Data I ;I
oo0a40 RATM |
oo0ag4 RAM

oo0a48 RAM

oo0adc RATM ad 8b Sa al ll
‘I }I'-. Address Range )H. Section )\ITask Stack {r

Figure 5. 123 Data Coverage window (task stack specification)

The Data Coverage window is vertically divided into two by the splitter.
The upper pane shows the automatically registered task stacks and access rates.

Table 5.39 Contents shown in the upper pane of the Data Coverage window

[Task] Task stacks (task ID, task entry label)

[Access Rate] Access rate in percentage and graph

The lower pane shows detailed information of the task stack selected in the upper pane.

Table 5.40 Contents shown in the lower pane of the Data Coverage window

[Address] Address value
[Label] Label name
[Area] Memory area (FlashROM, RAM, SFR)
This column is blank when the area is unused.
[Data] Memory data
The accessed data has its background displayed in purple.

If located outside the coverage memory allocated area, address lines are displayed in gray. Although the existing coverage
information of those addresses is retained, the coverage information will not be updated by program execution.

The acquired coverage information is accumulated in memory until the user clears it.
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5.12.12 Clearing Data Coverage Information
(1) Clearing the data coverage information of the specified range

Selecting Clear Coverage Range from the pop-up menu on the Address Range or Section sheet opens the Clear Coverage
Range dialog box.

2
Start Addrezs: IDDDE24 j
End &ddress: IE":” 287 j Carcel |

Figure 5.124 Clear Coverage Range dialog box

Enter the start and end addresses of the range to be cleared. Clicking the OK button clears the coverage information of the
selected range.

(2) Clearing all data coverage information

Selecting Clear the Entire Coverage from the pop-up menu clears all the data coverage information.

5.12.13 Updating Coverage Information

Selecting Refresh from the pop-up menu updates the content of the Data Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when the program breaks. To view the latest
information, therefore, you need to update manually.

5.12.14 Preventing Update of Coverage Information
Selecting Lock Refresh from the pop-up menu prevents update of the Data Coverage window while the user program
execution is stopped.
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5.12.15 Saving the Data Coverage Information to a File
You can save the data coverage information of the currently selected sheet to a file.
Selecting Save Data from the pop-up menu opens the Save Data dialog box.

ections iI EI
File: Mame:
I LI Browse... | Cancel |

IV Alwaps save to this file when saving the session

Figure 5.125 Save Data dialog box

Enter a file name in which you want the information to be saved.
If a file extension is omitted, “.cdv” will automatically be added as the file extension.
If you specify an existing file name, the file is overwritten.

5.12.16 Loading Data Coverage Information from a File
You can load a data coverage information file.

Selecting Load Data from the pop-up menu opens the Load Coverage Data dialog box.

Load CoverageData x|

| Load Mode | File Mame | Difset |
Over-wite teztll. cdy Cre 0000000
Crverwote  testl2 cdy Cha0000000
Merge teztl 3 cdv Che 0000000

Maove Up

Mave Do

1t

[T Clear coverage BaM before loadng

oK I Cancel

Figure 5.126 Load Coverage Data dialog box
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Clicking on the Add button opens the Add coverage data file dialog box shown below.

[
File Mame:
I 2 | Browse... |
Offzet:
|nxunnnun
Coverage Data Load Mode
’VF D wenarite £ Merge
oK Cancel |

Figure 5.127 Add coverage data file dialog box

Use this dialog box to specify a coverage information file you want to load.

You can also specify a load mode and offset for each file you load.

The only file extension available is ".cdv". An error message will appear if any other file extension is entered.
The files you add will be listed in the Load Coverage Data dialog box.

The files will be loaded in the order in which they are listed.

If necessary, use the Up or Down button to change the order.
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5.13 Viewing Realtime Profile Information

5.13.1 Viewing Realtime Profile Information

The E100 emulator has code coverage, data coverage and realtime profile functions usable exclusively to each other.

To use the realtime profiling function, choose Realtime Profile in the Switching function section on the System page of the
Configuration properties dialog box.

Realtime profiling is the function to measure execution performance within an area allocated to addresses in the profile range,
one function or one task at a time. It will help you find the locations and causes of performance degradation in an application
program.

Measurements are carried out without obstructing user program execution.

The measurement results are updated when the program breaks.

(1) Function profile

Execution performance is measured one function at a time.

The Realtime profile window shows function names, the start addresses of functions, function sizes, counts and the cumulative
execution time, execution rate and average execution time of functions.

The function profile of the E100 emulator does not include the execution time of subroutines in its cumulative display of
function execution time.

CAUTION
The function profile is subject to the following limitations:

(a) About the areas to be measured

The E100 emulator can acquire profile information on all functions in areas up to 8 blocks, each in 128 KB units.
Each block you set can be comprised of a contiguous or noncontiguous address area.
No functions can be set that are outside the range of block addresses. In that case, the functions or tasks are displayed in gray.

(b) Limit to the number of functions

Measurement can be taken of up to 8K — 1 (= 8,191) functions.
If the number of functions measured exceeds 8K — 1 (= 8,191), the extra functions are excluded from the subject of
measurement. In that case, those functions are displayed in gray. (Function names, address and function sizes are displayed in

gray.)

(c) In-line expansion

The functions that are expanded in-line for optimization by the compiler are not displayed in the Realtime Profile window.

(d) Recursive functions

Although the execution time of recursive functions can be measured correctly, they are executed only once.
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(e) Relationship between Go execution start address and break address within a measurement range and the measurable range

i Execution =tart from function g
g
/1(){
k(3
gl
Ry
ki
1 1 1 h

Range that can be measured

Figure 5.128 Measurable range

Measurable range when the program breaks at the location of a black dot [e]: Execution time and execution count of functions h and k
Measurable range when the program breaks at the location of a red dot [e]: Execution time and execution count of functions h and k
Measurable range when the program breaks at the location of a blue dot [e]: Execution time and execution count of functions h and k
For the function g, the execution time and count in its executed portion can be measured.

Thus, the above is the relationship between break addresses and the measurable range.
Even after the program returned to a high-order function, execution counts of the function from which program execution
started cannot be measured.

(f) Function measurement
To measure functions accurately, you need to be in a function to be measured for 100 ns or more after entering the function.
Otherwise, the execution time and count may not be measured properly.

(g9) Debug information option

To get execution time and execution count of functions, you need to specify a source file that includes the functions for
measurement or an option that outputs debug information to the library during compiling. When not specifying the Debug
information option, you cannot measure execution time and execution counts of the function.

(h) Maximum execution time and minimum execution time
With the realtime profile, you cannot measure the maximum and minimum execution time of a function. To measure the
maximum and minimum execution time of a function, use the Performance Analysis window.
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(2) Task profile

Execution performance is measured one task at a time.
The Realtime profile window shows task IDs, counts and the cumulative execution time, execution rate and average execution
time of tasks.

5.13.2 Setting Realtime Profile Measurement Modes

Choose Set Ranges from the pop-up menu that is displayed when you right-click in the present window.

The Realtime Profile Setting dialog box will be displayed. In the Profile Mode list box of this dialog box, you can select
“Function profile” or “Task profile.”

When profile modes are changed, all measurement results are cleared.

5.13.3 Measuring Function Profiles
You can measure execution performance one function at a time.

Realtime Profile 1] |
B E M
B.l Function |Rddress | Size | l:..J Time | Sratiatic |.ﬁ.ven:age |
2 _andit OFE014  E37 F 00:00:00.039.175.860  a4sf] | 00:00:00.019, 537980
! §=ort OFE10Z 188 2 00:00:00.484.026.670 40: | | 00:00:00.242.013.430
2  $echange OFE1lEE 92 I 00:00:00,132.1%0,050 13N | O0:00:00.0668, 090,020
i _main orE2ls 10 1 00:00:00,001.725.730 0% | O0:00:00.001, 735,730
! _tuborial OPE2ZE4 340 2 00:00:00.104.200.640 10:[ | 00:00:00.052, 495,320
2 _aborg 0FE378 1 0 00:00:00,000.000,000 o | 000000, 000, 000,000

Figure 5.129 Realtime Profile window (function profile)

The following shows detailed information in each column.

Table 5.41 Details on each column

Block Block number

Function Function name

Address Start address of function

Size Function size

Count Number of times a function is called
Time Cumulative time of function execution

The timestamp is displayed in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds
Statistic Ratio of function Time to Go-Break execution time

Average Average execution time per measurement performed

If located outside the profile memory allocated area, address lines are displayed in gray.
The acquired profile measurement results are accumulated in memory until the user clears them.
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5.13.4 Setting Function Profile Measurement Ranges

Choose Set Ranges from the pop-up menu that is displayed when you right-click in the present window.
The Realtime Profile Setting dialog box will be displayed. In this dialog box, set a profile measurement range.

[Function mode]

Realtime Profile Setting

Bealtime Profile Mode: [ imeilE

— List
Allozation of Profile kemaon; Add..
Addresz | Block |
Clear
00000 - 1FFFF 1
EQO00 - FFFFF 2 All Clear
Drefault
Save... Load... Help (] 4 Cancel

Figure 5.130 Realtime Profile Setting dialog box

(1) Memory allocation

Before function profiles can be measured, profile memory must be allocated to the addresses at which to be measured. Profile

data can be obtained from only the address range that has had memory allocated.

You can specify any of blocks 1 to 8 (up to 1 Mbyte) each beginning with a 128-Kbyte boundary as profile measurement areas.

Either contiguous or non-contiguous blocks can be assigned.

With initial settings, the profile memory is automatically assigned at addresses in the ROM and RAM areas.

(2) Automatic function detection

When profile memory is assigned at addresses, the E100 emulator automatically detects functions included that address range

and registers those functions in the window.
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5.13.5 Saving Function Profile Measurement Ranges

You can save the current task mode and function profile measurement range (memory allocation state).

Click the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter a file name in which you want function profile measurement ranges to be saved.

If a file extension is omitted, “.rpf” will automatically be added as the file extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.6 Loading Function Profile Measurement Ranges
You can load a function profile measurement range.
Click the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

21|
Look jr: Ia Debug j A 5% ER-

5ayeData000. o
SaveDatalnl rpf
SaveDatal0z .rpf

File name: ISaveDataDDD.rpf Open

Files of type: | RealProfile Files [*ipf) =] Cancel |

A

Figure 5.131 Open dialog box

Enter a file name you want to load.

The only file extension available is “.rpf”. An error message will appear if any other file extension is entered.

When a file load is complete, the list in the Realtime Profile Setting dialog box is updated.

If task profile information is included in the loaded file, modes in the Realtime Profile Setting dialog box are switched to task
mode.
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5.13.7 Measuring Task Profiles
You can measure execution performance one task at a time.

Realtime Profile ] k|
% B | & |
Block | Task ID | count | Time | statistic | average B
1 0 (M3T-MR30/4 or Idle) 1 00:00:00.577.565.000 13 QO:00:00.577.565.020
1 1 | _main) 1 00:00:00.084.891.850 24 | 00:00:00.084.891.850
1 2 (_baski) 3 00:00:00.972.308.460 &[N 00:00:00.025. 587,060
1 3 [_tmaki) £5 00:00:00.541.265.250 1531 Q0:00:00.021.650.610

[

Figure 5.132 Realtime Profile dialog box (task profile):

The following shows detailed information in each column.

Table 5.42 Details on each column

Block Block number

Task ID Task ID, entry address

Count Number of times a task is called

Time Cumulative time of task execution
The timestamp is displayed in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds

Statistic Ratio of task Time to Go-Break execution time

Average Average execution time per measurement performed

Disabled tasks are displayed in gray.
The acquired profile measurement results are accumulated in memory until the user clears them.
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5.13.8 Setting Task Profile Measurement Ranges
Choose Set Range from the pop-up menu that is displayed when you right-click in the present window.
The Realtime Profile Setting dialog box will be displayed. In this dialog box, set a profile measurement range.

[Task mode]

Realtime Profile Setting - x|

Realtine Profile Mode: |1l

~ List

Task List:

Task D | Ertry Address Block E’

0 MAT-ME3I0/E o 1dle 1

= 1 i 1

B 2 _taskl 1

3 _task2 1

B 4 _tagkx 1

5 _teske 1 Enable Al Task |
¥] B tazks 1 ol

q | LIJ Disable &l Task |

Sawe., | Load.. | Help || 1] 4 I Cancel I

Figure 5.133 Realtime Profile Setting dialog box

(1) Automatic task detection

If you have downloaded a load module that has the OS included in it, the E100 emulator automatically detects a task list.

(2) Selecting tasks

Select the check box of a task ID you want to measure. (By default, all check boxes are selected.)
The selected tasks will automatically be assigned block numbers (1-8).

CAUTION
If measurement blocks are lacking, block numbers become blank, so that no more task IDs can be registered. In that case,
deselect the check boxes of unnecessary task IDs.
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5.13.9 Saving Task Profile Measurement Tasks

You can save the current task mode and measurement tasks (task IDs and enabled/disabled states).

Click the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter a file name in which you want task profile measurement tasks to be saved.

If a file extension is omitted, “.rpf” will automatically be added as the file extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.10 Loading Task Profile Measurement Tasks
You can load task profile measurement tasks.
Click the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

21|
Look jr: Ia Debug j A 5% ER-

5ayeData000. o
SaveDatalnl rpf
SaveDatal0z .rpf

File name: ISaveDataDDD.rpf Open

Files of type: | RealProfile Files [*ipf) =] Cancel |

A

Figure 5.134 Open dialog box

Enter a file name you want to load.
The only file extension available is “.rpf”. An error message will appear if any other file extension is entered.
When a file load is complete, the list (task list) in the Realtime Profile Setting dialog box is updated.

If any loaded task 1Ds are nonexistent, although they are displayed once in the list (task list) in the Realtime Profile Setting
dialog box, it is only the existing task IDs that are registered as measurement tasks when you click the OK button.
Reopening the Realtime Profile Setting dialog box, you can check the currently registered measurement tasks.

If function profile information is included in the loaded file, modes in the Realtime Profile Setting dialog box are switched to
function mode.
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5.13.11 Clearing Realtime Profile Measurement Results
Choose Clear from the pop-up menu of the Realtime Profile window, and all measurement results will be cleared.
Unless you choose to Clear, measurement results are accumulated in memory.

5.13.12 Saving Realtime Profile Measurement Results
You can save the current realtime profile measurement results in text format.
Choose Save To File from the pop-up menu of the Realtime Profile window, and the Save As dialog box will be displayed.

Enter a file name in which you want the measurement results to be saved.
If a file extension is omitted, “.txt” will automatically be added as the file extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.13 Setting the Measurement Interval
Choose Properties from the pop-up menu that is displayed when you right-click in the present window.
The Properties dialog box will be displayed.

Properties EI

teasurement interyal

Measurement interval:

Figure 5.135 Properties dialog box

The measurement interval can be selected from the following options:

10 ns, 20 ns, 40 ns, 80 ns, 160 ns, 1.6 ps

CAUTION
When the currently set measurement interval is changed, the measurement results hitherto accumulated are cleared.
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5.13.14 Maximum Measurement Time of the Realtime Profile
(1) Maximum measurement time

The timer used for performance measurement is comprised of a 40-bit counter. The maximum measurement time varies with
the measurement interval selected.

To select a measurement interval, specify it in the Measurement interval drop-down list of the Properties dialog box.

The measurable maximum times are listed below.

Table 5.43 Maximum measurement time

No. Resolution Maximum measurement time

1 10ns Approx. 3 hours, 03 minutes, 15 seconds

2 20ns Approx. 6 hours, 06 minutes, 30 seconds

3 40ns Approx. 12 hours, 13 minutes, 00 seconds
4 80ns Approx. 24 hours, 26 minutes, 00 seconds
5 160ns Approx. 48 hours, 52 minutes, 01 seconds
6 1.6us Approx. 488 hours, 40 minutes, 18 seconds

CAUTION

Note that performance measurement produces an error of + “2 resolution + 100 ns” (when resolution = 20 ns, £140 ns)
whenever entering functions. If the resolution is 20 ns and you enter functions 10 times, £1400 ns error occurs.

(2) Maximum measurement count
Execution counts of the realtime profile are measured using a 16-bit counter. Measurement can be taken of up to a count of
65,535.
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5.14 Detecting Exceptional Events

5.14.1 Detecting Exceptional Events
The E100 emulator permits you to detect various exceptional events that have occurred during user program execution.
Exceptional events include an abnormal behavior of the user program, as well as an overflow of the measurement counter of

any function involved, etc. Detection of a specified exceptional event can be set as a condition of a breakpoint or trace point.

(1) Exceptional events

The E100 emulator detects the exceptional events listed below.

- Violation of access protection: An error is detected when an access other than a specified access attribute was attempted.

- Read from uninitialized memory: An error is detected when uninitialized area (not write accessed) was accessed for read.

- Stack access violation: An error is detected when the value of the stack register is beyond a boundary of the stack area.

- Performance overflow: An error is detected when the time measurement counter for a section has overflowed.

- Realtime profile overflow: An error is detected when the maximum measurable time or maximum measurable number of
passes is exceeded during profile measurement of a function (or a task).

- Trace memory overflow: An error is detected when the trace memory has overflowed.

- Task stack access violation: An error is detected when one task attempts writing to the task stack of another task.

- OS dispatch: An error is detected if a task dispatch has occurred.

5.14.2 Detecting an Access Protect Violation
Violations of access protection such as writing to a ROM area or access to an unused area (for reading, writing, or execution of
an instruction) can be detected as an error.

(1) Access attributes

Following attributes can be specified in word units for any area.

Read/Write: Accessible for both read/write

Read Only: Accessible for read only

Write Only: Accessible for write only

Disable: Access prohibited

Disable (OS): Any access except from OS is prohibited (this attribute is automatically assigned when a program including an
OS is downloaded).

(2) Protected areas

Any area in the entire memory space may be access protected.
At emulator startup, the whole area is by default assigned a Read/Write access attribute.
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(3) Methods for setting protection

There are following two methods of specification:

- Automatic setting by section information in a download module
- Specifying the access attribute of any area individually

(4) Detection method

An access protect violation is detected by the emulator’s internal resources (blocks 1-16).
The blocks are automatically allocated by the emulator’s exclusive algorithm.

CAUTION
Since the emulator’s internal resources are limited, not all blocks can be access protected. In that case, reduce the amount of

used blocks by “removing blocks” before setting protection again.

Access attribute

Read/Write
Write access -> Read Only -> Detected
Read access -> Write Only -> Detected
Read access -> Disable -> Detected
Write access

Figure 5.136 NG patterns of detection methods

(5) Actions taken when an access protect violation is detected

The following actions can be set:

- Display a warning

Selecting the Access Protect Violation check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Make the detection of an access protect violation a condition of a hardware breakpoint
- Make the detection of an access protect violation a condition of a trace point
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5.14.3 Setting an Access Protected Area
Follow the procedure described below to set an access protected area.

(1) From the Hardware Break dialog box
1. Select the Exception check box on the Hardware Break sheet and then click the Detail button.
i Hardware Break * I [m]

Hardware Break, IoR | Exception |

condition and combination setting
v OR condition:

Evertinuse: 0  Detail |
I Other conditions:

IF\ND(AccumuIation) R l
Ewvent in use : 0 ekl |

¥ Exception:

’ ] Dl led:
Exceptional Detail elay(cycle)
events | | J I—D

Taotal: 0 Event

Event used 0 Free 16 Detail...l Registered events...l
Save, ., | Load... | Help | Apply I Close I

.

Figure 5.137 Hardware Break dialog box

2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection check
box.

=10l x|

Hardware Breakl CR Exception I

[ violation of access protection
[ Read from a uninitislized memory | Detail, .

[ Stack access violation Detail. ..

[ Performance overflow
I™ | Realtime profile owerflow

[ Trace memary overflow

I Task stack access violation

™ s dispatch

Eventused 0 Free 16 Detail...l Registered events...l
Save. .. | Load... | Help | apply I Close I

.

Figure 5.138 Hardware Break dialog box
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3. The Violation of access protection dialog box shown below will be displayed.
To have the access attributes automatically set according to the section information in a download module when a program is
downloaded, select the check box labeled “Automatically set address areas at downloading.”

Wiolakion of access protection X|

v Sutomatically set addiesz areas at downloading

Address Areas:
Block Mo. | Label | Start Address - End Address | Access Aftr... | Update
01 [2kE) _ COM_... 00000000 - 00007 25F Read w/rite Add
1 [EkE] 00001260 - 00001 FFF Dizable -
02 [1MB] 00002000 - OO0E FFFF Dizahle Fadify...
02 [1MB] MR_top 000FO000 - 00aF1FFF Read Only
03 [2kB) 000F 2000 - DO0F39E 2 Read Only
03 [EkE) O00F39E4 - D0OF3FFF Dizable Delete
02 [1MB] Q00F4000 - 00OFDFFF Dizable —
04 [8kE) __INT_%.. 00OFEQOO - ODOFE OFF Read Only Delete the block
04 [2kB) OO0FETO0 - DOOFFFDE Dizable Delete al
04 [8kEB) Q00FFFDC - QOOFFFFF Read Only |
Cancel
Help

Figure 5.139 Violation of access protection dialog box

4. Click the Update button, and the access attributes will be updated according to the section information in a download
module.

5. To add an access attribute manually, click the Add button. The Access protection condition dialog box shown below will
appear. Specify any address range and access attribute.

Access proteckion condition 5'

Start Address: IEUDU j @
End Address:  [FFFF = =

attribute write Only

] I Cancel |

Figure 5.140 Access protection condition dialog box
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6. The protected area you have added will be displayed in the Address Areas list of the Violation of access protection dialog
box.

Yiolation of access protection il
v Automatically set address areas at downloading
Address Areas:
Block Mo | Label | Start Addregz - End Address | Access Aftr... | Update
01 [2kE) _ Cow_... 00000000 - 000070 26F Fead \write T
01 [BkB] 00001 260 - D000 FFF Dizable
02 (1B 00002000 - D0D0DFFF Dizable hodify...
02 [1hB] O000EDDD - DOOOFFFF Wdrite Only —_—
02 [1E] 0007 0000 - DODEFFFR Dizable
02 [1+B] MF_top QO0F0000 - DO0F1FFF Fead Only [elete
03 [BkB] 000F 2000 - Q00F39E3 Read Only —————
03 [8kE] O00F39E 4 - D0OF3FFF Disable Delste the Block
02 [1B] O00FA000 - DOOFDFFF Dizable Delete al
04 [2kB] _INT_%... DODFEODOO - DOOFEQFF Read Only
04 [2kB] OOOFET00 - DOOFFFDE Dizablz
04 [2kB] Q00FFFDC - OOOFFFFF Fead Only oK |
Cancel
Help

Figure 5.141 Violation of access protection dialog box

(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception check box and then click
the Detail button.

i Trace conditions * -3 x|

Trace |OR I Exceptionl Option I

- n m“l. dalny | Fill around TP j]

condition and combination setting
¥ OR condition:

Evertinuse: 0  Detail |

I Other conditions:

IAND(AccumuIation) - l

Eventinuss: 0 Detal |

[ W Exception | Total: 0 Event

5 e~ Delay(ovele):
*cepkional P |
events Detai 4 i

r—Record condition:

Trace Mode:

@ al 7 Capture € Donot capture V¥ Step execution is recorded
I j ekl |
Eventinuse : 0
Eventused 0O Freelg Detail.. | Registered events...l
SEVE... | Load... | Help | Apply I Close I
)

Figure 5.142 Trace conditions dialog box
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2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection check
box.
i Trace conditions * ;lglll
Trace | OR

I Violation of access protection ' Detail. ..

™ Read from a uninitialized memory  Detail. ..

Option I

[ stack access violation Detail. ..

[ Performance overflow

[ Realtime profile averflow

[ Task stack access vialation Detail, . |

[~ o= dispatch

Event used 0O Free 16 Detail...l Registered events...l
SEVE... | Load... | Help | Apply I Close I
7

Figure 5.143 Trace conditions dialog box

3. The Violation of access protection dialog box will be displayed.
The rest is the same as you opened it from the Hardware Break dialog box.
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5.14.4 Detecting Initialization-Omitted

Reading from a non-initialized area, i.e. cases of reading from a memory location to which nothing has been written, can be
detected as an error.

In the emulator, the blocks 0-31 (maximum 16 Kbytes) can be specified as a detection area of the initialization-omitted.

(1) Detection method

An initialization-omitted is detected by the RAM monitor function.
Allocate a RAM monitor area to a given address range and enable error detection in that area.

Detection circuit

Both histories of
read access and
write access do
not exist

<Compare>
-> Whether accessed for read before ->  Detected
being write accessed

Figure 5.144 Outline of the initialization omitted

(2) Actions taken when an initialization-omitted is detected

The following actions can be set:
- Display a warning

Selecting the Read from uninitialized memory check box on the Exception Warning page of the Configuration properties
dialog box, you can display a warning in the Status window and in a status bar balloon.

Color display in the RAM Monitor window

- Set the detection of an initialization-omitted as a condition of a hardware breakpoint
- Set the detection of an initialization-omitted as a condition of a trace point
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5.14.5 Detecting Stack Access Violation
Setting the size of the stack too small in software development raises the possibility of a program going out of control or
malfunctioning. The E100 emulator actively detects abnormal access by the stack pointer.

(1) Setting a stack range

By selecting a stack section it is possible to automatically set a stack range, or you can enter any address range you want.

(2) Initial settings at startup

At startup, stack sections are automatically set. However, because address information is nonexistent, those stack sections do
not work until a program is downloaded.

(3) Detection method

The emulator monitors the values of USP and ISP and detects if the value points to a location outside the stack areas.

Detection circuit

| USP value | -> <Compare>
Whether the USP value ->  Detected
| Stack range | -> exceeded the set stack area

Detection circuit

| ISP value | -> <Compare>
Whether the ISP value exceeded | ->  Detected
| Stack range | -> the set stack area

Figure 5.145 Outline of the detection of a stack access violation

The emulator will detect the error if the value of the stack pointer is beyond the stack areas on
1. generation of an interrupt or return from an interrupt handler;

2. calling of a function or return from a function; or

3. the stack pointer pointing to a location outside reserved stack areas.

CAUTION
Detection does not cover cases of corruption of data within a stack area

(4) Actions taken when a stack access violation is detected
The following actions can be set:
- Display a warning

Selecting the Stack Access Violation check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a stack access violation as a condition of a hardware breakpoint
- Set the detection of a stack access violation as a condition of a trace point
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5.14.6 Detecting a Performance Overflow
A time in performance measurement coming to exceed the maximum value can be detected as an error.
Timeout case in a performance measurement is referred to as a performance overflow.

(1) Actions taken when a performance overflow is detected
The following actions can be set:
- Display a warning

A warning is displayed in the Performance window.

The result display line of a program section in which a timeout phenomenon occurred is marked with a string “overflow.”
Selecting the Performance Overflow check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a performance overflow as a condition of a hardware breakpoint
- Set the detection of a performance overflow as a condition of a trace point

5.14.7 Detecting a Realtime Profile Overflow
A time or number of passes in realtime profile measurement coming to exceed the maximum value can be detected as an error.
Timeout and count-out (count expired) cases in a realtime profile are collectively referred to as a realtime profile overflow.

(1) Actions taken when a realtime profile overflow is detected
The following actions can be set:
- Display a warning

A warning is displayed in the Realtime Profile window.

The function or result display line of a task in which a timeout or count-out phenomenon occurred is marked with a string
“overflow”.

Selecting the Realtime Profile Overflow check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a realtime profile overflow as a condition of a hardware breakpoint
- Set the detection of a realtime profile overflow as a condition of a trace point
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5.14.8 Detecting a Trace Memory Overflow

Overflows of the trace memory (4 M cycles) can be detected as errors.
(1) Actions taken when a trace memory overflow is detected

The following actions can be set:

- Display a warning

Selecting the Trace memory overflow check box on the Exception Warning page of the Configuration properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a trace memory overflow as a condition of a hardware breakpoint

5.14.9 Detecting a Task Stack Access Violation
This facility is only available when a load module that includes an OS has been downloaded. The emulator detects an error
when one task attempts writing to the task stack for another task.

(1) Initial settings at startup

At startup, the check box labeled “Automatically set address areas at downloading” is selected (flagged by a check mark).
However, because address information is nonexistent, the function does not work until a program is downloaded.

(2) Actions taken when a task stack access violation is detected

The following actions can be set:

- Display a warning

Selecting the Task stack access violation check box on the Exception Warning page of the Configuration Properties dialog box,
you can display a warning in the Status window and in a status bar balloon.

- Set the detection of a task stack access violation as a condition of a hardware breakpoint
- Set the detection of a task stack access violation as a condition of a trace point
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5.14.10 Setting a Task Stack Area
Follow the procedure described below to set a task stack area.

(1) From the Hardware Break dialog box

1. Select the Exception check box on the Hardware Break sheet and then click the Detail button.

i Hardware Break * ] 4|
Hardware Break IoR | Exception |

condition and combination setting
v OR condition:

Evertinuse: 0  Detal |
I Other conditions:

IAND(AccumuIation) b I
Eventinuse:0  Detal |

Total i O Event

o Delayicycle):
Exceptional ; ]
evenkts De_talll J I 0

Evert used 0 Free 16 Detal.. | Registered events...l
Save... | Load... | Help | Apply I Close I

o

Figure 5.146 Hardware Break dialog box

2. The Exception page shown below will appear. Click the Detail button to the right of the Task stack access violation check
box.

=01 |

Hardware Break I CR

™ wiolation of access protection Detail. ..

[ Read from a uninitislized memory  Detail, .,

" stack access vidlation Detail...

[ Performance overflow
I Realtime profile overflow

™ Trace memary overflow

[~ Task stack access violation ' Detail... ||

™ o5 dispatch

Event used 0 Free 16 Detail.. | Registered events...l
Save... | Load... | Help | Apply I Close I

.

Figure 5.147 Hardware Break dialog box
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3. The Violation of task stack access dialog box shown below will be displayed. To have the task stack ranges automatically
set when a program is downloaded, select the check box labeled “Automatically set address areas at downloading.”

Wiolation of task stack access I |

¥ Automabicaly zet address areaz at downloading

Address aneas (B Bye Block 00000 - CFFF)
TasklD | Label | Start Addrazs - End Address | -
1 Lmain) _STE_TASK1  0ODOCA4A - 00000469
Pltaskl]  _STE_TASKZ  (O000AGS - DO000ASS Update
3 [taska] _STE_TASKS  DO0DDAGA - DODO0&AT fdd,.
4 [hasks) _STE_TASK4  DOOODAAS - COOO0ACT _—
5 [tasks] _STE_TASKS  (0000ACE - 0000sES Iadij.
B _tasky] TSTR_TASKE  OODODAEA . OODOOE0S =
7 [kack) __STE_TASKE?  DOODDEOA - DOOO0EZ3
B [_haska] TSTE_TASKE  DOODDE2A - DOON0EAS Dielese
5 Ltﬂkﬁ] _ST K_T.ﬁs KS CI]IIIIIIIIE-%.-!'. = IZI[IZIIZIIZIEEEI Dt-hlﬁ Hl
W0 kasks)  _STE_TASKI0 COO00EGS . OO000BS9 L Esotd |
1 Ltasks]  _ STE_TASK11  COOOCESA - DOOO0BAS
12 [tasky]  __STE_TASK1Z OOO00SAS - DOODDECT oK
13 Llasks) _STE_TASK1Z  (O000DBCA - DO000BES :
14 [_tasks) _STE_TASK14  Q000Q0SEA - 00QOCDS Cancal
15 tesks]  _ STE_TASKIS COOOOCOA - 00000C29 | T

Figure 5.148 Violation of task stack access dialog box

4. Click the Update button, and the task stack ranges will be automatically set.

5. To add a task stack range manually, click the Add button. The Task stack access condition dialog box shown below will
appear. Specify any task ID and the address range of a task stack.

Task stack access condition x|

Task D [0002
Start Address: |nnnnmaa ~| @
End Addiess: [00000AER =] @

k. | Cancel |

Figure 5.149 Task stack access condition dialog box

6. The task stack ranges you have added will be displayed in the Address Areas list of the Violation of task stack access dialog
box.
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(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception check box and then click
the Detail button.

: Trace conditions * =0
=101 x|

Trace |0R I Exreption I Optian I

Trace Mode:

"
- v do!arw[ delar | Fill around TP j ]

condition and combination setting
—I¥ OR condition:

Eventinuse: 0  Detal |
— Other conditions:
IAND(F\ccumuIatinn) j

Eventinuse: o  Detal |

™ Esception | ) fotal : 0 Event

c Goral Delayicycle):
xeepkional . |
events Detai 4P T

—Record condition:
@ al  Capture Do naot capture ¥ Step execution is recarded

] e

Eventinuse : 0

Eventused 0 Free 16 Detail...l Registered events...l
Save. .. I Load. .. | Help | Apply | Close |

g

Figure 5.150 Trace conditions dialog box
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2. The Exception page shown below will appear. Click the Detail button to the right of the Task stack access violation check
box.

i Trace conditions * ;IEIEI

Trace I R

| Opkion I

[ violation of access protection Detai...
[ Read from a uninitislized memory  Detail...

" stack access violation Detail...

[ Petformance overflow

[ Realtime profile overflow

[ Task stack access violation | Detail. .. ||

[ oS dispatch

Event used 0 Free 16 Detail... | Registered events...l

SEVE... I Laad... | Help | Apply | Close |

p

Figure 5.151 Trace conditions dialog box

3. The Violation of task stack access dialog box will be displayed. The rest is the same as you opened it from the Hardware
Break dialog box.

5.14.11 Detecting an OS dispatch

This facility is only available when a load module that includes an OS has been downloaded. The emulator detects the
generation of task dispatch as an error.

(1) Actions taken when an OS dispatch is detected

The following actions can be set:

- Display a warning

Selecting the OS dispatch check box on the Exception Warning page of the Configuration properties dialog box, you can
display a warning in the Status window and in a status bar balloon.

- Set the detection of an OS dispatch as a condition of a hardware breakpoint
- Set the detection of an OS dispatch as a condition of a trace point
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5.15 Using the Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and immediately after halting
program execution. This function is used to control the user system in synchronization with execution and halting of the user
program.

5.15.1 Opening the Start/Stop Function Setting Dialog Box

The routine executed immediately before starting and immediately after halting the user program execution is specified in the
[Start/Stop function setting] dialog box.

To open the Start/Stop function setting dialog box, choose Setup -> Emulator -> Start/Stop function setting. .. from the menu.

Start/Stop Function setting _ x|

ok, addiess lm ﬂ @

u The specified routine iz executed immediately before
exection of the user's program.

Starting address | j @

r The specified routine 15 executed immadiately giter the
stop of the user's program,

Stating arkdrezs | BNz
ok, | cancel ] Help |

Figure 5.152 Start/Stop function setting dialog box

5.15.2 Specifying the Work Address
Use this command to specify the address of a work area (stack area) for use by a routine to run before the user program
execution is started or after user program execution is stopped.

CAUTION
The specified address must be in the RAM area and not used by the user program.

5.15.3 Specifying the Routine to be executed

It is possible to specify the respective routines immediately before starting and immediately after halting the user program
execution.

When The specified routine is executed immediately before execution of the user’s program check box is selected, the routine
specified in the Starting address combo box, which is below this check box, is executed immediately before starting user
program execution.

When The specified routine is executed immediately after the stop of the user’s program check box is selected, the routine
specified in Starting address combo box, which is below this check box, is executed immediately after halting user program
execution.
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5.15.4 Limitations of the Start/Stop Function

The Start/Stop function is subject to the following limitations.

- While the Start/Stop function is in use, do not use the debug functions listed below.
(a) Memory setting and download into the program area of a specified routine
(b) Breakpoint setting in the program area of a specified routine

- While a specified routine is executed, the 4-byte value pointed to by the interrupt stack is used under control on the emulator
side.

- The general-purpose registers and flags used in a specified routine are subject to the following limitations.

Table 5.44 Limitations to the registers and flags

Register/flag Name Limitations

ISP register When a specified routine has ended, the value of this register must be restored to one that
it had when the specified routine started.

U flag When a specified routine has ended, the value of this flag must always be set to 0.

| flag Interrupts are disabled while a specified routine is executed.

- When a specified routine is executed, the debug functions listed below have no effect.
(a) Trace function
(b) Break-related functions
(c) RAM monitor function
- When a specified routine is executed, non-maskable interrupts are always disabled.
- The table below shows which state the MCU will be in when the user program starts running after a specified routine is
executed.

Table 5.45 MCU Status at start of the user program

MCU Resource Status
MCU general-purpose | These registers are in the state in which they were when the user program last stopped or
registers the MCU registers that were set in the register window by the user. The register contents

changed after a specified routine is executed are not reflected.

Memory in MCU space [ Memory accesses attempted after a specified routine is executed are reflected.

MCU peripheral | Operation of the MCU peripheral functions performed after a specified routine is executed
functions are continued.

5.15.5 Limitations to the Statements written in a Specified Routine

The statements written in a specified routine are subject to the limitations described below.

- If a stack needs to be used in a specified routine, always be sure to use the user stack.

- To terminate the processing of a specified routine, write a return subroutine instruction.

- Make sure that one session of processing performed by a specified routine is terminated within 10 ms. If, for example, the
clock is turned off and kept inactive within a specified routine, then the emulator may become unable to control program
execution.

- The values stored in the registers at the time a specified routine starts running are indeterminate. Be sure that the register
values are initialized within a specified routine.
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5.16  Using the Trigger Output Function
The trigger output function allows output of signals through an external trigger cable. Trigger pin numbers 31 to 16 can be
used for output. Note, however, that operation of a trigger pin depends on its pin number. Table 5.46 lists the trigger pin

numbers and how they operate.

Table 5.46 Trigger Pin Numbers and Operation

No. Operation

31to 24 These pins constantly output a signal; either high or low can be selected.

23 A high-level signal is output when a breakpoint is encountered.

22 A high-level signal is output when a trace point is encountered.

21 A high-level signal is output when specific trace data is extracted or discarded.

20to 16 An event can be specified for each of the signals and a high-level signal is output
when that event occurs.

Output is at the power voltage level of the user system. If the MCU in use has two power supplies, the level on VCC1 will be
applicable.

5.16.1 Using the External Trigger Cable for Output
You can specify input and output through the external trigger cable on the System page of the Configuration properties dialog
box. Select the ‘EXT 0-15 INPUT EXT16-31 OUTPUT’ radio button for ‘External trigger cable’.

Configuration properties

Main % Emulator " Uzer " Generate I 10 MHz
sub O Emulator ) Wi clock divided| by 256
— Trigeer
Extemal trigeer cable CoExTo-m mpUT | & peete BEUT -
i EXTO-15 TTL
Input trigeer level {* EXT 0-31 CMOS . EXT16-31 TMOS

Figure 5.153 Configuration properties dialog box (System page)
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5.16.2 Opening the Trigger Output Conditions Dialog Box
Choose [Event -> Trigger Output Conditions] from the View menu, or click on the ‘Trigger Output Conditions’ toolbar button

[&].

I Trigger Output Conditions

Manual output | Event output I

—Current trigger outpuk
31 30 29 25 27 26 25 24

Dutput cantents | L " L || L " L || L " L " L ” L |

— Qukpuk Erigger setkings
31 30 20 23 27 26 25 24

Cukpuk sekking ) | ) | ) | _ | _ | _ I _ I _ I Ckput I

| add patkern I

Ckbpuk pattern:
Mo.| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 |

Melete |

Event used 2 Free 14 Detail...l Registered events...l
Save... | Load... | Help | Al I Close I

v

Figure 5.154 Trigger Output Conditions dialog box

Note that you cannot open the Trigger Output Conditions dialog box in either of the following cases.
- ‘EXT 0-31 INPUT’ has been selected on the System page of the Configuration properties dialog box.
- An external trigger cable is not connected.
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5.16.3 Manual Setting for Output through Trigger Pins 31 to 24
Make the manual settings for output through trigger pins 31 to 24 on the Manual output page.

M Trigeer Output Conditions

Manual output | Event output |

—Current trigger output
31 30 29 28 27 26 25 24
cHieteerients e e e
—Output krigger sektings
31 30 2% 25 27 26 25 24
Output setting _ D Output |
Duktput patkern:
mo.| 31 | 30 | 29 | 28 | 27 | 26 | =5 | 24 | -
1 - - - - - - - L
z - - - H L
3 - - L H L
4 - H L H L =
5 - L H L H L
& H L H L H L 4|
Delete |
Eventused 0 Free 16 Detail...l Registered events...l

SaVE... | Load... | Help | Ly, I Close I
v

Figure 5.155 Trigger Output Conditions dialog box (Manual output page)

(1) Display of output states: ‘Output contents’

‘Output contents’ indicates the current signal levels on trigger pins 31 to 24.
H: High
L: Low

(2) ‘Output setting’

‘Output setting’ indicates the levels of signals to be output through trigger pins 31 to 24. Clicking on one of these buttons
changes the state of the corresponding pin in the following order.

= Hos — —‘

L: Low
H: High
—: The previous setting is retained.

When the Trigger Output Conditions dialog box is opened, the states of all signals in the ‘Output setting’ section are always
indicated as ‘—’, whether the previous setting was L or H.

(3) Starting output of signals

Click on the ‘Output’ button to validate the settings and start output of signals.
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(4) Saving output patterns

- You can save the settings on trigger pins 31 to 24 and reflect a saved setting as the ‘Output setting’. This simplifies

operations.

- After making settings for an ‘Output setting’, click on the ‘Add pattern’ button. The new setting will be added as the last line
in the ‘Output pattern” list.

- Up to 256 patterns can be added.

- Double-clicking on a line in the ‘Output pattern” list reflects the information on the line as the ‘Output setting’.

- The order of the lines (patterns) can be changed by dragging and dropping.

- To delete a pattern, select the line and click on the ‘Delete’ button.

5.16.4 Setting for Output through Trigger Pins 20 to 16
The Event output page allows manual setting for output through trigger pins 20 to 16.

Wl Trigzer Output Conditions

Manual oukput  Event oukput

—Default setting
Mo.Z3: Breakpoint is encountered.
Mo.22; Tracepoint is encountered.
Mo.21: Capture or Do Mot Capture of trace data.

— Trigger output event

| Mo, | T.l Descriptions | Ca... | Ta.. | Camment
F  [Address] 000000

[Size] WORD [Type... -
T [Trigger]
I [Interrupt] generate

F  [Address] 000000

Event

. I [DElEte I Enatle I Disakle |

Registered events. .. |

Help | Ly, | Close |
v

Figure 5.156 Trigger Output Conditions dialog box (Event output page)

Eventused 5 Free 11 Detail...l

(1) Default setting

‘Default setting’ indicates the trigger output conditions on pins 23 to 21. These pins are always enabled. Signals are output
through these pins when the respective conditions are satisfied. Table 5.47 gives details on how the conditions control output.

Table 5.47 Trigger Output Conditions and Output

No. Condition Output

23 A breakpoint is Continued output of a high-level signal is started.
encountered

22 A trace point is A high-level signal is output only during cycles in which the
encountered trace-point condition is satisfied.

21 Specific trace data is A high-level signal is output only in cycles where trace data is
extracted or deleted being extracted or discarded.
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(2) Trigger output event

You can specify an event for trigger pins 20 to 16. A high-level signal will only be output while the event is occurring.

CAUTION
The actual trigger output follows event detection after some delay. The number of cycles of delay varies with the product. The
delay for trigger output in the ROE521500MCUQO0 is 8 cycles.

5.16.5 Events
For details on the setting of events, see section “5.7 Using Events” (page 106).
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6. Troubleshooting (Action in Case of an Error)

6.1 Flowchart for Remediation of Trouble

Figure 6.1 shows the flowchart for remediation of trouble arising between activation of the power supply to the emulator
system and the emulator debugger starting up. Go through the checks with the user system disconnected. For the latest FAQs,
visit the Renesas Tools Homepage.

https://www.renesas.com/tools

Turn on the power to the emulator |

Not normal

Check the LEDs on the emulator

Normal

iew the Device setting

v

1. Check the connection of power cable.
See “2.5 Connecting the Emulator Power Supply”.

Not normal/Error displayed

dialog box of the
emulator debugger

Normal

View the Configuration

v

1. Check the operating environment of the emulator debugger.
See “5.1 Setting Up the Emulation Environment”.

2. Re-install the emulator debugger.

Not normal/Error displayed

properties dialog box of the
emulator debugger

Normal

View the Connecting

v

See “6.3.(2) Configuration Properties Dialog Box Does Not
Appear in Booting-up of the Emulator Debugger”.

Not normal/Error displayed

dialog box of the
emulator debugger

Normal

v

See “6.3.(3) Errors Occur in the Connecting Dialog Box.

Error displayed

View the Editor window of the
emulator debugger

Normal

The emulator debugger has started up

v

See “6.3.(4) Errors Occur in booting-up of the emulator debugger”.

Figure 6.1 Flowchart for remediation of trouble
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6.2 Error in Self-checking
When an error occurs in self-checking, check the following items.

(1) Re-check the connection between the E100 emulator main unit and the MCU unit.

(2) Download the proper firmware again.

(3) Check the error log from self-checking by the debugger software, and refer to the instructions given therein (see Figure
6.2).

“Error occurred during the self-check test.”
dialog is displayed.

|

Click the OK button.

A,

Check the log in the self-check dialog box.

|

Refer to any instructions in the log.

Figure 6.2 Flowchart for checking of an error in self-checking

Notes on the Self-checking:
Disconnect the MCU unit from a converter board and the user system before you start self-
checking.

If the results of self-checking are not normal (excluding status errors of the target system), the
product may have been damaged. Contact your local distributor.
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6.3 Errors Reported in Booting-up of the Emulator
(1) States of the LEDs on the E100 are incorrect

Table 6.1 Points to check for errors indicated by incorrect states of the LEDs on the E100

Connection to .
Error Point to check
the user system

SAFE LED remains lit. - Check that the USB cable is connected.
See "2.4 Connecting the Host Machine™ (page 30).

SAFE LED does not light up. - Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 29).

Target Status POWER LED Connected Check that power (Vcc) is being correctly supplied to the user
does not light up. system and that the user system is properly grounded (GND).

Target Status RESET LED does Connected (1) Check that the reset pin of the user system is being pulled up.
not go out. (2) When using the emulator without the user system, check to see
if a converter board is disconnected from the emulator.
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(2) Configuration Properties Dialog Box Does Not Appear in Booting-up of the Emulator Debugger

Table 6.2 Points to check for errors in booting-up of the emulator debugger (1)

Error

Point to check

Communication initialize error

A communication error.

Check all emulator debugger settings and the connection of the interface
cable.
See “4. Preparing to Debug ” (page 71).

(3) Error Occurs in the Connecting Dialog Box

Table 6.3 Points to check for errors in booting-up of the emulator debugger (2)

Error

Point to check

MCU unit is not connected.

Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 29).

The system configuration of the E100 emulator
is not corresponding to the content of the
E100.ENV file.

The combination between the emulator software and the MCU unit is not
correct. Refer to the release notes of the emulator software, and confirm
the combination between the emulator software and the MCU unit.

A timeout error. The MCU is in the reset state.
Is system reset issued?

A timeout error. The MCU's internal clock is
halted. Is system reset issued?

A timeout error. No clock signal is supplied to
the MCU. Is system reset issued?

Check the oscillation of the oscillator module mounted on the MCU unit,
and confirm that the oscillator module is properly mounted.

A timeout error. The power supply to the MCU
is off. Is system reset issued?

Check that power is being correctly supplied to the user system and that
the user system is properly grounded.

(4) Errors Occur in booting-up of the emulator debugger

Table 6.4 Points to check for errors in booting-up of the emulator debugger (3)

Error

Point to check

A timeout error.

(1) Check that the NQPACK etc. mounted on the user system is
soldered properly.
(2) Check that the connector is installed properly to the user system.
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6.4 How to Request Support
After checking the items in "'6. Troubleshooting (Action in Case of an Error)", contact us from the following URL.

https://www.renesas.com/contact

For a prompt response, please fill in the following information:
(1) Operating environment

- Operating voltage: [V]
- Operating frequency: [MHZz]
- User-system; Connected/Disconnected

- Clock supply to the MCU: Emulator/User-system
(2) Condition

- The emulator debugger starts up/does not start up

- The error is detected/not detected in the self-checking

- Frequency of errors: always/frequency ( )
(3) Problem
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7. Hardware Specifications

This chapter describes specifications of the MCU unit.

7.1 Target MCU Specifications

Table 7.1 lists the specifications of target MCUs which can be debugged with the MCU unit.

Table 7.1 Specifications of target MCUs for the ROE521500MCUOO

Item Description
Applicable MCU R8C Family R8C/5x Series MCUs
Evaluation MCU R5E2E500NFP

ROM size : 4KB+128KB, RAM size: 20KB

Applicable MCU mode

Single-chip mode

Maximum ROM/RAM capacity

1. Internal flash ROM: 4KB+128KB
07000h--07FFFh, 08000h --27FFFh
2. Internal RAM: 20 KB
00400h --053FFh

Power supply voltage

Vcc: 2.7 to 5.5V

Operating voltage/frequency

Power supply voltage: 2.7 to 5.5V, 32MHz
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7.2 Differences between the Actual MCU and Emulator
Differences between the actual MCU and emulator are shown below. When debugging the MCU using the MCU unit, be
careful about the following precautions.

Note on Differences between the Actual MCU and Emulator:
Operations of the emulator system differ from those of actual MCUs as listed below.

(1) Reset condition
Set the time for starting up (0.2 Vcc to 0.8 Vcc) 1 s or less.

(2) Initial values of internal resource data of an MCU at power-on

(3) Oscillator circuit
In the oscillator circuit where an oscillator is connected between pins Xin and Xourt, oscillation
does not occur because a converter board is used between the evaluation MCU and the user
system. It is the same for pins Xcin and Xcour.

(4) AJD conversion
The characteristics of the A/D converter differ from those of actual MCU because there are a
converter board and other devices between the evaluation MCU and the user system.

Note on RESET# Input:
A low input to pin RESET# from the user system is accepted only when a user program is being
executed (only while the RUN status LED on the E100 upper panel is lit).

Notes on Voltage Detection Circuit:
This product does not support the function of voltage monitor O reset. Evaluate it with an actual
MCU.

This product differs from the actual MCU because there is a pitch converter board, etc. between the
evaluation MCU and user system. Final evaluation of interrupts generated by the voltage detection
circuit should be executed with the actual MCU.

Notes on Maskable Interrupts:

Even if a user program is not being executed (including when run-time debugging is being
performed), the evaluation MCU executes a debug control program. Therefore, timers and other
components do not stop running. If a maskable interrupt is requested when the user program is not
being executed (including when run-time debugging is being performed), the maskable interrupt request
cannot be accepted, because the emulator disables interrupts. The interrupt request is accepted
immediately after the user program execution is started.

Take note that when the user program is not being executed (including when run-time debugging is
being performed), a peripheral 1/O interruption is not accepted.

Note on Non-maskable Interrupts:

When using this product, do not use the non-maskable interrupts listed blow. If one of these non-
maskable interrupts contends with another interrupt, the occurrence of the intended non-maskable
interrupt may delay. Note, however, that this does not apply for the actual MCU.

(1) Watchdog timer

(2) Oscillation stop detection
(3) Voltage monitor 1

(4) Voltage monitor 2

Note on Program Stoppage and Hardware Breaks:
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If an operation to stop the program is performed or a hardware break occurs in the emulator
debugger, be aware that the program does not stop until after the period described below ends.
-Providing that interrupts are enabled, a period from when a request for an interrupt whose priority
level
(selected by a register bit) is higher than the IPL is generated till when the interrupt routine is
entered

Note:If the above interrupt request is for an interrupt nested in another or disabled by clearing the |
flag to "0", it
will take a longer time than otherwise before the interrupt routine is entered. In this case, the timing
with
which the program is halted is delayed that much.
Note, however, that this does not apply to software breaks.

Note on the Processor Mode Register 0 (PMO):
The R8C/5x Group actual MCU and this product differ in the initial value of the processor mode
register 0 (PMO, address 0004h).
This product: 02h
R8C/5x Group actual MCU: 00h
When using this product, be sure that bit 1 of PMO remains "1" as initially set. If bit 1 of PMO is
cleared to "0", the emulator will become uncontrollable.
Also, when using this product, please be sure that only a bit-manipulating instruction is used for a
write to bit 3 (PM03) of processor mode register 0 (PMO, address 0004h).

Note on the Peripheral Clock Select Register 1 (PCLKR1):

In order to rewrite the peripheral clock select register 1 (PCLKR1, address 0000Fh) while using this
product, you need to first set bit 0*1 of the protect register (PRCR, address 00007h) and bit 5*2 of the
protect register (EPRR, address 0025Fh) to “1”. Once the rewrite on PCLKRL1 is complete, set bit O of
PRCR and bit 5 of EPRR back to “0"*2. The actual MCU does not have the protect register EPRR, the
setting of which, however, does not affect the actual operation.

*1:Bit O of the protect register (PRCR, address 00007h) controls whether to enable or disable wri
*2:Bit 5 of the protect register (EPRR, address 0025Fh) controls whether to enable or disable wri
*3:When using this product, note that the PCLKR1 register is rewritable if bit 5 of EPRR is “1” eve

Note on the PLL Clock:
When using this product, be aware that the high-speed on-chip oscillator cannot be used as the
clock source for the PLL frequency synthesizer.

Note on the Low-speed On-chip Oscillator Oscillation Stop Bit (CM14):
When the low-speed on-chip oscillator is selected for the operating clock, the low-speed on-chip oscillator
oscillation stop bit (CM14, bit 4 at address 0009h) in the actual MCU is disabled from being set to "1" (= stop). In
this product, however, this bit can be set to "1" (= stop).

Note on Oscillation Stop Detection at WAIT Time:
When using this product, leave oscillation stop detection turned off during WAIT mode. This is
because this function may not work normally during WAIT mode.

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 219 of 231
Sep.01.21



ROE521500MCUQ0 User’s Manual 7. Hardware Specifications

Note on the timer RB2:
To use the output event of timer RB2 along with the event link controller (ELC) in this product,
follow the procedure described below.

(1) If interrupt handling based on timer RB2 is unnecessary, set bits 2—0 (IVL2-IVLO bits) of
TRB2IC_0 and 1 registers to 000b to disable interrupts.

(2) Set up the DTC-related registers so that DTC transfers based on underflow of timer RB2 are
executed. At this time, be sure the repeat mode is selected and that the source and destination
registers are mapped to a free RAM area, etc. where they can be accessed without affecting the
system.

(3) Set bit 7 (TRBIE) of TRBIR register to "1" to enable the timer RB2 interrupt.

Note on the Pin Assignment Select Register (PMCSEL):
When the 48-pin product is selected, the values for the pin assignment select bit are different between the R8C/5x
Group actual MCU and this product.

R8C/5x Group
This product actual MCU
48-pin product standard pin assignment: PMCSEL=000b PMCSEL=011b
48-pin product communication function priority pin assignment: PMCSEL=001b PMCSEL=100b

Note on Power Supply Voltage of the User System:
To use this product, the power supply voltage range of the user system must be 2.7[V] < Vce < 5.5[V]. A voltage
of 2.7 [V] or lower makes the emulator uncontrollable.

Note on RAM Size:
With this product, 1KB or more (addresses 400h--7FFh) are assigned to the internal RAM. When emulating a
target MCU whose RAM size is 512 bytes (addresses 400h--5FFh), as this product assigned addresses 600h--7FFh
to the RAM, there is a difference from the actual MCU. When emulating a target MCU whose RAM size is 1KB
or more, there is no difference in RAM size between this product and the actual MCU.

Note on Final Evaluation:
Be sure to evaluate your system with an evaluation MCU. Before starting mask production,
evaluate your system and make final confirmation with a CS (Commercial Sample) version MCU.
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7.3 Connection Diagram

7.3.1 Connection Diagram of the ROE521500MCUQ0
Figure 7.1 shows a partial circuit diagram of the connections of the ROE521500MCUQO0. This diagram mainly shows the
circuitry to be connected to the user system. Other circuitry, such as that for the emulator’s control system, has been omitted.

VvDD1 —\
P0_0--PO_7, P1 0--P1 7, 7451053 f P0_0--P0_7, P1 0-P1.7,
P2_0--P2_7, P3_0--P3_7, 33Q P2_0--P2_7, P3_0--P3_7,
P5_0--P5 7, P6 0-P6 7, & <« P50-P57, P60-P6_7,
P7_0--P7_7, P8 0--P8 7, .[>|J P7_0--P7_7, P8 _0--P8_7,
P9 _0--P9_7, PA_0--PA_7, P9_0--P9_7, PA_0--PA_7,
PB_0--PB_7, PC_0--PC_7, PB_0--PB_7, PC_0--PC_7,
PD_0--PD_7, PE_0--PE_S, PD_0--PD_7, PE_0--PE_B,
PF_0--PF_. PF_0--PF 2 -
22Q
P4_2/VREF _T_ ANNN—<P4_2/VREF
c
I VI?_l
7451053
FD' 33Q
P4_3/XCIN L 4 g AN\VN—>< P4_3/XCIN
L * A V_?I_Dl
7451053
r[>- 33Q
P4_4/XCOUT * AMN—><P4_4/XCOUT
VDD1
7451053..
rb'f 33Q
P4 5 * ANN—><P4 5
A7 VDD1
7451053 -3— User
s 33Q System
P4_6/XIN/XCIN -[ ¢ ANN—>< P4_6/XIN/XCIN
* VDD1
7481053..
‘L—[>-3- 33Q
P4_7/XOUT/XCOUT T ANN—< P4_7/XOUT/XCOUT
* /J;
7431.093..
22Q
MODE L 4 —\\N\N———<MODE
VDD
* 1
VDD1
510kQ 510kQ
33Q
RESETH[— % % . A% < RESET#
VCC/AVCC |—— % & <« VCC/AVCC
VCC2 VCC2
VCC3/AVCC VCC3/AVCC
VSS/AVSS < VSS/AVSS
VSS2 VSS2
VSS3/AVSS3 VSS3/AVSS3
RBC/SX EVA CHIP +* : Connected to the inside of the emulator
R5E2E500NFP

Figure 7.1 Connection diagram for the ROE521500MCUQ0 (partial)
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7.4 External Dimensions

7.4.1 External Dimensions of the E100 Emulator
Figure 7.2 shows external dimensions of the E100 emulator.

D: 184mm

H: 132mm

Figure 7.2 External dimensions of the E100 emulator

R20UTO0455EJ0103 Rev.1.03 :{ENESAS Page 222 of 231
Sep.01.21



ROE521500MCUQ0 User’s Manual 7. Hardware Specifications

7.4.2 External Dimensions of the Converter Board ROE53054ECFK60
Figure 7.3 shows external dimensions and a sample foot pattern of the converter board ROE53054ECFKG60 for a 48-pin 0.5mm
pitch LQFP of R8C/5x Series.

A

| . 2400 1 U -
( A A -

RENESAS o i i

-2 dtp1 — e} — > 0.25 —
s | 100E N m— o —
z R - — —
3 1T i i ol 8§
2 % i i o g
- i ~oA
E % 51 —1
g e o 8 C—4 . . 050 ——
. ROE53054ECFK60 03 i i

reva ) _ Y P
P \ /
'_l H H H ........... H H
B Y
S 7.00
-t >
~ »

.>
2.50 2.50 - 10.00 > Unit:mm

Figure 7.3 External dimensions and a sample foot pattern of the ROE53054ECFK60

7.4.3 External Dimensions of the Converter Board ROE53036ACFK40

Figure 7.4 shows external dimensions and a sample foot pattern of the converter board ROE53036 ACFK40 for a 64-pin 0.5mm
pitch LQFP of R8C/5x Series (the same converter board for R8C/36A, 36C, 36E, 36F, 36G, 36H, 36M, 36W, 36X, 36Y and
36Z Groups).

A
Renesas | |:| |:| H |:| |:|
z — i 025 — !
s >
) HE
z ° —/ —/
= 8 —— —
o) .

’ 3 S
S H o <
3 : i — —
° Crp2
. ROE53036A(|;2\</‘_12 y —1 E E 0.50 —1

24.00 Y

>
2.5

- - Unit: mm

Figure 7.4 External dimensions and a sample foot pattern of the ROE53036 ACFK40
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7.5 Notes on Using the MCU Unit
Notes on using the MCU unit are listed below. When you debug an MCU using the MCU unit, be careful about the following
precautions.

Note on the Version of the Emulator Debugger:
Be sure to use this product with the following emulator debugger.
- M16C R8C E100 Emulator Software V.1.03 Release 02 or later

Notes on Downloading Firmware:
Before using this product for the first time, it is necessary to download the dedicated firmware
(emulator’s control software installed in the flash memory in the E100). If you need to download at
debugger startup, a message will appear. Download the firmware following the message.

Do not shut off the power while downloading the firmware. If this happens, the product will not start
up properly. If the power is shut off unexpectedly, re-download the firmware.

Disconnect the MCU unit from the user system before you start downloading the firmware.

Notes on Self-checking:
If self-checking does not result normally (excluding target status errors), the product may be
damaged. Then contact your local distributor.

Disconnect the MCU unit from the user system before you start self-checking.

Note on Quitting the Emulator Debugger:
To restart the emulator debugger, always shut off the emulator power supply and then turn it on
again.

Note on Display of MCU Status:
"Status" you can view in the Connecting dialog box of the emulator debugger shows pin levels of
the user system. Make sure that proper pin levels are selected according to the mode you use.

Note on Clock Supply to the MCU:
A clock supplied to the evaluation MCU is selected by the Emulator tab in the Init dialog box of the
emulator debugger.
(1) When "Emulator" is selected:
A clock generated by the oscillator circuit board on the MCU unit is supplied. It is continually
supplied regardless of the status of the user system clock and that of the user program execution.
(2) When "User" is selected:
A clock generated by the oscillator in the user system is supplied. It depends on the status of the
oscillation (on/off) of the user system.
(3) When "Generate" is selected:
A clock generated by the dedicated circuit in the E100 is supplied. It is continually supplied
regardless of the status of the user system clock and that of the user program execution.

Note on Stopping the Flash Memory:
When debugging in the state that the flash memory is stopped, do not operate windows until the
program stops at the breakpoint by setting the breakpoint at the line of the program which will be
executed after the state is cancelled.

Note on the Low-current-consumption Read Mode:
Do not stop the user program during the low-current-consumption read mode. If the user program
is halted during the low-current-consumption read mode, values in the flash ROM area cannot be read
correctly until the MCU is reset thereafter.

Note on Stop and Wait Modes:
Do not single step an instruction shifting to stop or wait mode. It may cause communication errors.
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Note on the Watchdog Function:
If the reset circuit of the user system has a watchdog timer, disable it when using the emulator.

Note on Protect Register:
The protect is not canceled when bit 2 of protect register PRCR (PRC2), which enables writing into
the port PO direction register, is changed with the below procedure.
(1) Step execution of an instruction setting PRC2 to "1"
(2) Setting a break point between an instruction setting PRC2 to "1" and a point where the port PO
direction register is set
(3) Setting PRC2 to "1" by the Memory window or Command Line window

Note on Breaks:
The following break functions are available in the emulator debugger.
(1) Software break

This is a debugging function which generates a BRK interruption by changing an instruction at a
specified address to a BRK instruction (00h) to break a program immediately before the system
executes an instruction at a specified address. The instruction at the preset address will not be
executed.

(2) Hardware break
This is a debugging function which breaks a program by setting the detection of an execution of
an instruction at a specified address as a break event. The program will break after the
instruction at the specified address is executed.

(3) Exceptional event
This is a debugging function which stops a program by an abnormal operation of the user
program or overflow of each function’s measurement counter, etc.

Note on Program Stoppage and Hardware Breaks:
If an operation to stop the program is performed or a hardware break occurs in the emulator
debugger, be aware that the program does not stop until after the period described below ends.
- Providing that interrupts are enabled, a period from when a request for an interrupt whose
priority level (selected by a register bit) is higher than the IPL is generated till when the interrupt
routine is entered

Note: If the above interrupt request is for an interrupt nested in another or disabled by clearing
the | flag to "0", it will take a longer time than otherwise before the interrupt routine is
entered. In this case, the timing with which the program is halted is delayed that much.

Note, however, that this does not apply to software breaks.

Notes on Software Breaks:
The BRK instruction can be used for the emulator only. You cannot use it in a user program. As
BRK instruction interrupt vector is used by the emulator system, the read data is different from expected
value.

Notes on Power Supply to the User System:
Vcc pin is connected to the user system to observe the voltage. Therefore, the power is not
supplied to the user system from the emulator. Design your system so that the user system is powered
separately.

The voltage of the user system should be as follows.
27V<Vcc=sh5V

Notes on Debugging in CPU Rewrite Mode:
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If you check "Debug the program using the CPU Rewrite Mode." in the System tab of the
Configuration properties dialog box of the emulator debugger, you cannot use the following functions.
- Setting software breakpoints in an internal ROM area

In CPU rewrite mode and erase suspend mode, do not stop the program. And do not single step an
instruction shifting to CPU rewrite mode or erase suspend mode.
The emulator will be uncontrollable in CPU rewrite mode and erase suspend mode.

While executing the program that rewrites the CPU, do not perform the following operations; new
setting or change of the settings of the RAM monitor area, or erase of any data. Otherwise, the CPU
rewrite operation may not be properly executed.

To reference data after executing CPU rewrite, stop the program at other than a rewrite control
program area and use the Memory window etc.

When erasing blocks or programming using DTC in CPU rewrite mode, do not refer to the memory
of the blocks in the internal ROM area (program ROM and data flash) to be erased or written from the
following windows.

If you refer to the memory contents of the internal ROM area to be erased or written during
program execution, CPU rewrite may not be properly executed.

Although the program is stopped while DTC is activated, CPU rewrite by DTC is continued.
Therefore, make sure to operate windows after CPU rewrite is complete.

(1) Checking memory contents from the Memory window
(2) “Access Data Clear” or “Error Detection Data Clear” from the RAM Monitor window.
(3) Enabling automatic update from the Watch window.
(4) Checking memory contents from the Command line window.

Note on Accessing Addresses 00000h and 00001h:

With the R8C Family MCUs, when a maskable interrupt is generated, the interrupt data (interrupt
number and interrupt request level) stored in addresses 00000h and 00001h are read out. Also, the
interrupt request bit is cleared when address 00000h or 00001h is read out. Consequently, when the
address 00000h or 00001h readout instruction is executed or when address 00000h or 00001h is read
out in the cause of a program runaway, a malfunction occurs in that the interrupt is not executed despite
the interrupt request, because the request bit of the highest priority interrupt factor enabled is cleared.
For this malfunction, when the reading out to address 00000h or 00001h is generated excluding the
interrupt, an expansion monitor window will appear. At that time, check the user program. There is a
possibility of wrong access.
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8. Maintenance and Warranty

This chapter covers basic maintenance, warranty information, provisions for repair and the procedures for requesting a repair.

8.1 User Registration
When you purchase our product, be sure register as a user. For user registration, refer to “User Registration” (page 15) of this
user's manual.

8.2 Maintenance

(1) If dust or dirt collects on this product, wipe it off with a dry soft cloth. Do not use thinner or other solvents because these
chemicals can cause the surface coating to separate.

(2) When you do not use this product for a long period, disconnect it from the power supply, host machine and user system.

8.3 Warranty

(1) This product comes with a one-year warranty after purchase.
Should the product break down or be damaged while you’re using it under normal condition based on its user’s manual, it
will be repaired or replaced free of cost.

(2) However, if the following failure or damage occurs to the product under warranty, the product will be repaired or replaced
at cost.

a) Failure or damage attributable to the misuse or abuse of the product or its use under other abnormal conditions.

b) Failure or damage attributable to improper handling of the product after purchase, such as dropping of the product
when it is transported or moved.

¢) Failure or damage to the product caused by other pieces of equipment connected to it.

d) Failure or damage attributable to fire, earthquakes, thunderbolts, floods, or other natural disasters or abnormal
voltages, etc.

e) Failure or damage attributable to modifications, repairs, adjustments, or other acts made to the product by other
than Renesas Electronics Corporation.

(3) Consumables (e.g., sockets and adapters) are not covered by the aforementioned repair.

In the above cases, contact your local distributor. If your product is being leased, consult the leasing company or the
owner.
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8.4 Repair Provisions
X(1) Repairs not covered by warranty
#¢  Problems arising in products for which more than one year has elapsed since purchase are not covered by warranty.
X(2) Replacement not covered by warranty
% If your product's fault falls into any of the following categories, the fault will be corrected by replacing the entire product
instead of repairing it, or you will be advised to purchase a new product, depending on the severity of the fault.
- Faulty or broken mechanical portions
2%~ Flaws, separation, or rust in coated or plated portions
- Flaws or cracks in plastic portions
2%~ Faults or breakage caused by improper use or unauthorized repair or modification
- Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply
2%~ Cracks in the printed circuit board or burnt-down patterns
- A wide range of faults that make replacement less expensive than repair
2X- Faults that are not locatable or identifiable
X(3) Expiration of the repair period
$  When a period of one year has elapsed after production of a given model ceased, repairing products of that model may
become impossible.
X(4) Carriage fees for sending your product to be repaired
#  Carriage fees for sending your product to us for repair are at your own expense.

8.5 How to Make Request for Repair
If your product is found faulty, fill in a Repair Request Sheet downloadable from the following URL. And email the sheet and

send the product to your local distributor.

https://www.renesas.com/repair

A CAUTION

Note on Transporting the Product:
0 When sending your product for repair, use the packing box and cushion material supplied with this

product when delivered to you and specify handling caution for it to be handled as precision equipment.
If packing of your product is not complete, it may be damaged during transportation. When you pack
your product in a bag, make sure to use conductive polyvinyl supplied with this product (usually a blue
bag). When you use other bags, they may cause a trouble on your product because of static electricity.
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